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1.1 INTRODUCTION 
------------------------------------------------------------------------------------------------------------ 
Computer has been the premier invention of this century. Now a days Computer plays an 
important role in almost every part of our lives, and their importance is so great that 
without them we would not be able to live the way we do. Look around you and you 
would find computers scattered all over the places, starting with the machine of computer 
to washing machine to refrigerator to car to mobile and to life saving devices with the 
doctors; everywhere a small computer working for your convenience and they seem 
performing almost any task in the world. Computers have had a tremendous impact on 
the way information is processed with in the organization. Although information have 
been processed manually throughout the history but with modern management where 
decision-making is so fast and the era of corporate governance is not possible without the 
help of information system managed by computers. 
 
The word “computer” comes from word compute, which means to calculate. “A 
computer is a programmable machine (or more precisely, a programmable sequential 
state machine) that operates on data and is used for wide range of activities”. 

Computer is an electronic device or combination of electronic devices, which solves 
problem after accepting the data and supply the result to the user. Computer is a 
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tool, which can be used to read and write stories, draw and look at images, and send and 
receive e-mail. They can store large information and perform various scientific and 
mathematical tasks. 

Basically Computer system are a combination of the five elements i.e. Hardware, 
Software, People, Procedure and Data / information. The computer organization often 
compared with the human brain. Just think of a human brain how it works, first of all it 
can store the data with its five senses (Just like input devices in computer), it can process 
the gathered information and could reach to some conclusion drawing from the raw data 
(Just like the processing of computer system) and then it can deliver the output or result 
with speech or with expression (Just like the output device).  

 

Fig. 1.1: A Basic Personal Computer System 
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1.1.1 Evolution of Computers 
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1.1.2 A Brief History of Computers 
"History reveals a clear pattern in the evolution of computers. Processing power increases 
rapidly after the introduction of the new technology. The rate of growth eventually slows 
down as the technology is exploited to its full potential. While in the background other 
technologies are nurturing and one ultimately supersedes the other to become the 
dominant technology and this cycle is repeated. 
 
Under the right conditions the shift to the new technology can lead to possible increase in 
processor speed of hundred to thousand times. In order to have a better idea of the 
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evolution of computers it is worthwhile to discuss some of the well- known early 
computers. These are as follows:  
 
1. The Mark I Computer (1937-44): Also known as Automatic Sequence Controlled 
calculator, this was the first fully automatic calculating machine designed by Howard A. 
Aiken of Harvard University in collaboration with IBM (International Business 
Machines) Corporation. It was an already developed for punched card machines. 
 
Although this machine proved to be extremely reliable, it was very complex in design 
and huge in size. It used over 3000 electrically actuated switches to control its operations 
and was approximately 50feet long and 8 feet high.  It was capable of performing five 
basic arithmetic operations: addition, subtraction, multiplication, division, and table 
reference on numbers as big as 23 decimal digits. It took approximately 0.3 second to add 
two numbers and 4.5 seconds for multiplication of two numbers. Obviously, the machine 
was very slow as compared to today’s computers. 
 
2. The Atanasoff- Berry Computer (1939-42): Dr. John Atanasoff developed an 
electronic machine to solve certain mathematical equations. The machine was called the 
Atanasoff Berry Computer or ABC after its inventor’s name and his assistant, Clifford 
Berry. It used 45 vacuum tubes for internal logic and capacitors for storage. 
 
3. The ENIAC (1943-46): The Electronic Numerical Integrator and Calculator (ENIAC) 
was the first all electronic computer. It was constructed at the Moore School of 
Engineering of the University of Pennsylvania, U.S.A by a design team led by Professors 
J. Presper Eckert and John Mauchly. 
The team developed ENIAC because of military needs. It was used for many years to 
solve ballistic related problems. It took up wall space in a 20 x 40 square feet room and 
used 18,000vacuum tubes. It could add two numbers in 200 microseconds and multiply 
them in 2000 microseconds. 
 
4. The EDVAC (1946-52): A major drawback of ENIAC was that its programs were 
wired on boards that made it difficult to change the programs. Dr. John Von Neumann 
later introduced the” stored program” concept that helped in overcoming this problem. 
The basic idea behind this concept is that a sequence of instructions and data can be 
stored in the memory of a computer for automatically directing the flow of operations. 
This feature considerably influenced the development of modern digital computers 
because of the ease with which different programs can be loaded and executed on the 
same computer. Due to this feature, we often refer to modern digital computers as stored 
program digital computers. The Electronic Discrete Variable Automatic Computer 
(EDVAC) used the stored program concepts in its design. Von Neumann also has a share 
of the credit for introducing the idea of storing both instructions and data in binary form( 
a system that uses only two digits – 0 and 1 to represent all characters), instead of 
decimal numbers or human readable words. 
 
5. The EDSAC (1947-49): Almost simultaneously with EDVAC of U.S.A.; the 
Britishers developed the Electronic Delay Storage Automatic Calculator (EDSAC). The 
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machine executed its first program in May 1949. In this machine, addition operations 
took 1500 microseconds and multiplication operations took 4000 microseconds. A group 
of scientists headed by Professor Maurice Wilkes at the Cambridge University 
Mathematical Laboratory developed this machine. 
 
6. The UNIVAC I (1951): The Universal Automatic Computer (UNIVAC) was the first 
digital computer that was not “one of a kind”. Many UNIVAC machines were produced, 
the first of which was installed in the Census Bureau in 1951 and was used continuously 
for 10years. The first business use of a computer, a UNIVAC I, was by General Electric 
Corporation in 1954. 
 
In 1952, the International Business machines (IBM) Corporation introduced the IBM-701 
commercial computer. In rapid succession, improved models of the UNIVAC I and other 
700- series machines were introduced. In 1953, IBM produced the IBM-650, and sold 
over 1000 of these computers. UNIVAC marked the arrival of commercially available 
digital computers for business and scientific applications. 
 
1.1.3 Characteristics  
The ever-increasing use of computer is due to its special characteristics. Computer is not 
just a calculating machine; they also have the capability of doing complex activities and 
operation. Main characteristics of the computer are given bellow: 
 

1. Speed: Computer is very fast and accurate device. Since electronic pulses travel 
at incredible speed and they are electronic device its internal speed is virtually 
instantaneous. A microcomputer can process millions of instruction per seconds 
over and over again without any mistake. 

 
2. Accuracy: Computers physical circuits rarely make errors, if the data and 

instruction are correctly fed. Most errors which occur in computers are either 
hardware error or human error 

 
3. Storage: Computers have a large amount of memory to hold a very large amount 

of data, we can store large amount of data information in the secondary storage 
device. 

4. Programmability: A computer is programmable; i. e. what computer does 
depend on the lines of instruction (Program) it is using.   

 
5. Diligence: Computer is free from problems like lack of concentration, and 

confusions etc. Computer is never confused like humans and it can perform 
instruction again and again without failing or getting bored.  

 
6. Versatility: We can perform many different types of tasks on computer, one 

moment it might be busy in calculating the statistical date for annual performance 
evaluation of a business organization and next moment it might be working on 
inventory control. 
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7. Power of remembrance: Unlike humans, computer can store things for unlimited 
period of time. It has great remembering power. 

 
1.1.4 Classification 
Computers can be classified many different ways -- by size, by function, and/or by 
processing capacity. We will study the classification of computers by size. The size of a 
computer often determines its function and processing capacity. The size of computers 
varies widely from tiny to huge and is usually dictated by computing requirements. For 
example, it is clear that the IRS will have different requirements than those of a college 
student. 
There are two basic kinds of computers: analog and digital. 
 
A. Analog computers 
Analog computers are analog devices. That is, they have continuous states rather than 
discrete numbered states. An analog computer can represent fractional or irrational values 
exactly, with no round off. Analog computers are almost never used outside of 
experimental settings. They handle or process information, which is of physical nature.  

  
 
 
 
 

 
 
 
 
 
 
 
 

Fig. 1.2 Analog Computers 
 
B. Digital Computer  
Digital computer is a programmable-clocked sequential state machine. A digital 
computer uses discrete states. A binary digital computer uses two discrete states, such as 
positive/negative, high/low, on/off, used to represent the binary digits zero and one. They 
process data, which is essentially in a binary state. 
 
Now these days, we rarely came across of analog computers in routine life. Digital 
computer does not get evolve in sparks time. It took more than five decades to emerge it 
as the most usable devise today. Let’s take the glimpse of its siblings. 
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                                                       Fig.1.3 Digital Computer 
 
1)  Micro Computers: A microcomputer’s CPU is a microprocessor. The microcomputer 
originated in late 1970’s. The first microcomputers were built around 8-bit 
microprocessor chips. What do we mean by an 8-bit chip? It means that the chip can 
retrieve instructions/data from storage, manipulate, and process an 8-bit data at a time or 
we can say that the chip has a built- in 8-bit data transfer path. 8088 was a 8/16 bit chip 
i.e. an 8-bit path is used to move data between chip and primary storage (external path), 
but processing is done within the chip using a 16-bit path (internal path) at a time 8086 is 
a 16/16 bit chip i.e. the internal and external paths both are 16 bit wide. Both these chips 
can support a primary storage capacity of up to 1 Mega byte (MB).  
 

  
 
 
 
 
 
                                                                 
 
 
 
 
 
 

      Fig. 1.4 Micro Computer 
 
2)   Minicomputers:  The term minicomputer originated in 1960s when it was realized 
that many computing tasks do not require an expensive contemporary mainframe 
computers but can be solved by a small, inexpensive computer. Initial minicomputers 
were 8 bit and 12 bit machines but by 1970’s almost all minicomputers were 16 bit 
machines. The 16 bit minicomputers have the advantage of large instruction set and 
address field; and efficient storage and handling of text, in comparison to lower bit 
machines. Thus, 16-bit minicomputer was more powerful machine, which could be used 
in variety of applications and could support business applications along with the scientific 
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applications. With the advancement in technology the speed, memory size and other 
characteristics developed and the minicomputer was then used for various stand alone or 
dedicated applications. The minicomputer was then used as a multi-user system, which 
can be used by various users at the same time. Gradually the architectural requirement of 
minicomputers grew and a 32-bit minicomputer, which was called super mini, was 
introduced. The super mini had more peripheral devices, larger memory and could 
support more users working simultaneously on the computer in comparison to previous 
minicomputers. 
 
 
       

 
 

 
 
 
 

                                                     Fig. 1.5 Mini Computer 
 
3)  Workstation is a powerful stand-alone computer of the sort used in computer aided 
design and other applications requiring a high-end, expensive machine with considerable 
calculating or graphics capability. Machines using Intel Processor P2 at 400 MHz is an 
example of workstation. Now these day’s computers having P-4 or AMD Athlon type 
microprocessor also come in the classification of workstation. 
 
4)   Mainframe Computers are very powerful, large-scale general-purpose computers. 
Their word length may be 48,60 or 64 bits, memory capacity being in some megabytes 
and storage capacity in some terabytes etc. A mainframe is simply a very large computer. 
And totally different from what you have on your desk. Don't say: what seems to be a 
mainframe today is on your desktop tomorrow. Apart from the CPU's (processors) that is 
far from true. Mainframe is an industry term for a large computer. The name comes from 
the way the machine is build up: all units (processing, communication etc.) were hung 
into a frame. Thus the main computer is build into a frame, therefore: Mainframe and 
because of the sheer development costs, mainframes are typically manufactured by large 
companies such as IBM, Amdahl, and Hitachi. Their main purpose is to run commercial 
applications of Fortune 1000 businesses and other large-scale computing purposes. Think 
here of banking and insurance businesses where enormous amounts of data are processed, 
typically (at least) millions of records, each day. They are used where large amount of 
data are to be processed or very complex calculations are to be made and these tasks are 
beyond the capacities of mini computers. They are used in research organizations, large 
industries, airlines reservation where a large database has to be maintained. Examples are 
IBM 4300 series, IBM Enterprise system/9000 series. 
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Fig. 1.6 Mainframe Computer 
 

5) Super Computers processing capabilities lies in the range of GIPS2, word length 
64-128 or may be in 256 or so. Memory capacity in some gigabytes or in 
terabytes and storage capacity in pixabytes. It contains a number of CPU’s, which 
operate in parallel to make it faster, giving them their speed through parallel 
processing. They are used for weather forecasting, weapons research and 
development, rocketing, aerodynamics, atomic, nuclear and plasma physics.  
Supercomputers have limited use and limited market because of their very high 
price.  

 

 
 

Fig.1.7: Super Computer 
 
They are being used at some research centers and government being used at some 
research centers and government tasks. Examples of users of these computers are 
governmental agencies, such as the IRS, the National Weather Service, and the 
National Defense Agency. Also, they are used in the making of movies, space 
exploration, and the design of many other machines. Supercomputers are used for 
tasks that require mammoth data manipulation.  
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1.1.5 Generations  
‘Generation’ in computer talk is a step of changing technology. It provides the framework 
for the growth of computer industry. There are five generations of computer with the first 
generation computers being those, which became commercially available in the early 
1950s.  

 
First Generation Computers (1951- 1958) 
The first generation of computer was marked by the use of vacuum tubes for the 
electronic components and by the use of either electrostatic tubes (i.e., cathode ray tubes) 
or mercury delay lines for storage. Examples of such first generation machines are 
EDSAC (operational in 1949), SEAC (1950, the first stored program computer 
operational in the US), EDV AC (1951) and IAS (1952). This generation lasted until the 
end of the 1950s and computers in this era had their basis in wired circuitry and 
thermionic valves. 
Their outstanding features were: 

 
• Vacuum Tubes Circuit 
• Drum Primary Storage 
• Batch processing 
• Few thousand instructions per second is the processing speed 
• Machine language was the language used 
• It produce large amount of heat  
• Very expensive 
• Poor reliability 
• ENIAC, EDVAC, EDSAC, UNIVAC are some of the first generation computers 
• Quite large and, because they generated a lot of heat, required special housing 
• The medium of internal storage was magnetic drum. 

 
Second Generation Computers (1959-1964) 
The second-generation machines were initially marked by either magnetic drum or 
magnetic core storage and, later, by the use of the transistor in place of vacuum tubes. 
The second generation, which covered the first half of the 1960s, saw the introduction of 
printed circuits and the replacement of vacuum by transistors. Typical computers were 
the ICT (ICL) 1300 and the IBM 140J. 
 The outstanding features of this generation were: 
 

• Transistors and diodes were used 
• Magnetic primary storage 
• Tape secondary storage 
• One million instructions per second is the processing speed 
• Assembly and Fortran were the language used 
• Very expensive 
• Better reliability 
• Faster then the faster generation 
• Reduced generated heat 
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• Required less power to operate 
• Increase storage capacity  

 
Third Generation Computers (1965- 1975) 
The arrival of the third generation in the mid-1960s proved to be an important milestone 
in the evolution of computers. The advances over the previous generation were very 
significant and, although relatively expensive, allowed an increasing number of 
organizations to reap the undoubted benefits which computerization could bring. Because 
of the 'high costs involved and the need to get maximum utilization from the machine, the 
computer service bureau business was spawned. This in itself was important in that it 
allowed companies to avail themselves of the new technology and to take advantage of 
the continuing developments. Many of the computers acquired by companies during this 
period are still in use. 
The following are the outstanding features of this generation: 

 
• Magnetic Disk Secondary Storage 
• On-Line Real Time Processing 
• Used operating System 
• Multiprogramming Operating System 
• Development of the micro computer  
• Integrated Circuits 
• Faster than the previous generation of the computer  
• Better storage device (tape) 
• Improved input and output device  
• Transistor replaced by Integrated Circuits 
• IBM- 370, NCR 395 were the third generation computers 

 
Fourth Generation Computers (1975- present) 

The fourth generation of computers arrived in the mid-1970s. The distinguishing 
marks were the introduction of standard architecture, which was provided for greater 
mobility of systems, the introduction of micro-technology and significant software 
developments. The IBM-4300 and ICL-2900 ranges coincided with the start of this 
era. Micro-technology gave rise to the availability of microcomputers, word 
processors and intelligent terminals. 
The outstanding features of this generation are: 
 
• Further reductions in the size of the hardware 
• Better price performance 
• Large scale and very large scale Integrated Circuits (LSI/VLSI) 
• Semiconductor primary storage 
• Online real time processing 
• User friendly software  
• Widespread use of CRT terminals   
• Development of t electronic spreadsheet 
• High-level languages 
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• Microprocessor used 
• Increase cost of software 
• Data base management system 
• Distributes processing 
• Graphics manipulation 
• Pentium/AMD based are the fourth generation computers 

 
Fifth Generation Computer  
It is very difficult to define the fifth generation of the computer. The most famous 
example of this generation computer is fictional HAL9000 from Arutur C. Clarke’s novel  
HAL performed all of the functions currently envisioned for real time fifth generation 
computer   
 

• Organic chips 
• Decreasing cost of software 
• Decreasing cost of hardware 
• Artificial Intelligence 
• Multi point input-output 
• Large storage facility 
• Auto decision 
• High speed 
• Under development in USA, Japan and UK 

------------------------------------------------------------------------------------------------------------ 
1.2 COMPUTER ARCHITECTURE 
-------------------------------------------------------------------------------------------- 
We have seen that computer affects our life in a big way by increasing the efficiency and 
enhanced ability. Now we will have to look for the anatomy of computer. What it is made 
up of? The architecture of a simple and basic computer system. The parts of computer as 
we know did not appear all at once in one machine by one person. It is a continuously 
evolving process starting as early as 17th century when people began to work on 
machines that would automate task and to your surprise the first such machine was 
developed in 17th century by mathematician and philosopher Blaise Pascal but it was not 
an electronic device. It was purely a mechanical machine, which used meshed gears to 
add and multiply the numbers. But after him there was a long gap when an idea emerged 
from Charles Babbage to process information although he could never successfully 
develop such mechanical machine but his idea was of million dollar worth. That’s why he 
is known as a first father of computer. Modern electronic computer started taking shape 
in 1940 with the invention of Mark – I Computer since then there have been a lot of 
research and new inventions in the technology of computer.  
 
1.2.1 Components of Computer System (I/O Devices) 
A computer system has the following main components: 
 

 Input Unit/Devices 
 Output Unit/Devices 

http://www.studynama.com/?utm_source=pdf&utm_medium=downloaded_file&utm_campaign=studynama_referral


 19

 Central Processing Unit 
 Memory Unit/Storage Devices 

 
All these components are basically the integral parts of general-purpose computers. These 
may be the Desktop systems or Workstations. The diagram of a generalized architecture 
of a computer system is shown here 
 
 

 

Fig. 1.8: Architecture of a Computer System 
 
 
Input/ Output Unit 
We know that the computer is a machine that processes the input data according to a 
given set of instructions and gives the output.  Before a computer does processing, it must 
be given data and instructions.  After processing, the output must be displayed or printed 
by the computer.  The unit is used for getting the data and instructions into the computer 
and displaying or printing output is known as an Input/Output Unit (I/O Unit). 
 
There are many peripheral devices, which are used as input/output units for the computer.  
The most common form of input device is known as a terminal.  A terminal has an 
electronic typewriter like device, called keyboard along with a display screen, called 
Visual Display Unit (VDU) or monitor.  Keyboard is the main input device while the 
monitor can be considered both as an input as well as an output device.   
 
A) Input Devices 
Input unit performs following functions: 
a) It accepts (or reads) instructions and data from outside world. 
 

http://www.studynama.com/?utm_source=pdf&utm_medium=downloaded_file&utm_campaign=studynama_referral


 20

b) It converts these instructions and data in computer acceptable form. 
c) It supplies the converted instructions and data to computer system for further 
processing. 
 
Input Devices are used to input data, information and instructions into the RAM.  We 
may classify these devices into the following two broad categories: 
 

• Basic Input Devices 
• Special Input Devices 

 
Basic Input Devices 
The input devices, which have now days become essential to operate a PC, may be called 
as Basic Input Devices.  These devices are always required for basic input operations.  
These devices include Keyboard and Mouse.  

Special Input Devices 
The input devices, which are not essential to operate a PC, are called as Special Input 
Devices. These devices are used for various special purposes and are generally not 
required for basic input operations.  These devices include Trackball, Light Pen, Touch 
Screen, Joystick, Digitizer, Scanner, OMR, OCR, Bar Code Reader, MICR and Voice 
Input Devices. 
 
B) Output Devices 
An Output unit performs following functions: 
 
a) It accepts the results produced by a computer, which are in coded form and hence, we 
cannot easily understand them. 
b) It converts these coded results to human acceptable (readable) form. 
c) It supplies the converted results to outside world. 
  
Output devices are hardware components, which are used to display or print the 
processed information.  We are discussing below the structure, working and uses of the 
common output devices: 
 
Monitor 
Visual Display Unit (VDU) commonly called, as monitor is the main 
output device of a computer. It consists of a Cathode Ray Tube (CRT), 
which displays characters as an output.  It forms images from tiny dots, 
called pixels that are arranged in a rectangular form.  The sharpness of the  
image (screen resolution) depends upon the number of pixels. 
 
Printer 
Printer is the most important output device, which is used to print information on paper. 
Printers are essential for getting output of any computer-based application. 
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    PRINTER      

 

 

 

 

 

Impact                                                 Non Impact 

Example: Dot Matrix, Daisy Wheel   Example: Inkjet, Laser,  
        Thermal, LED  

Table 1.9 Classifications of Printers 

 
Central Processing Unit 
Central Processing Unit (CPU) is the main component or "brain" of a computer, which 
performs all the processing of input data.  Its function is to fetch, examine and then 
execute the instructions stored in the main memory of a computer.  In microcomputers, 
the CPU is built on a single chip or integrated Circuit (IC) and is called as a 
Microprocessor.  The CPU consists of the following distinct parts: 
 

• Arithmetic Logic Unit (ALU) 
• Control Unit (CU) 
• Registers 
• Buses 
• Clock 

 
Memory Unit 
 Memory Unit is that component of a computer system, which is used to store the data, 
instructions and information before, during and after the processing by ALU.  It is 
actually a work area (physically a collection of integrated circuits) within the computer, 
where the CPU stores the data and instructions.  It is also known as a 
Main/Primary/internal Memory. 
 
1.2.2 Computer Memory 
Memory in a computer system is required for storage and subsequent retrieval of the 
instruction and data. A computer system uses variety of devices for storing the instruction 
and data, which are required for its operations. Normally we classify the information to 
be stored on computer in two basic categories: Data and the instructions. 
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“The storage device along with the algorithm or information on how to control and 
manage these storage devices constitutes the memory system of computer”. A memory 
system is a very simple system yet it exhibits a wide range of technology and types. But 
unfortunately, faster memory technology is more costly. In addition fast memories 
require power supply till the information needs to be stored. These things are not very 
convenient, but on the other hand the memories with smaller cost have very high access 
time, this is the time taken by CPU to access a location in the memory in high, which will 
result in slower operation of the CPU. Thus, the cost versus access time anomaly has lead 
to a hierarchy of memory where we supplement fast memories with larger, cheaper, 
slower memories. This memory unit may have different physical and operational 
characteristics, therefore, making the memory system very diverse in type, cost, 
organization, technology and performance. This memory hierarchy will be fruitful if the 
frequency of access to slower memories is significantly less than the faster memories. 
 
 
 
 
 
 
 
 
 
 
 
 
Thus, a memory system can be considered to consist of three groups of memories. These 
are: 

1) Internal Processor Memories: These consist of the small set of high speed 
registers which are internal to a processor and are used as temporary locations 
where actual processing is done. 

 
2) Primary memory or main memory: It is a large memory, which is fast but not 

as fast as internal processor register. Processor directly accesses this memory. It 
is mainly based on integrated circuit. 

 
3)  Secondary or Auxiliary Memory: Auxiliary memory is in fact much larger in 

size than main memory but is, slower than main memory. It normally stores 
system programs, and data files.  These cannot be accessed directly by 
processor. 

  
Memory 
Memory- is also known as the primary storage or main memory/ internal memory. It is a 
apart of microcomputer that hold data for processing, instruction for processing the data 
(the program) and information (processed data) .It is of the following three types: 

 

Magnetic Tape 

Magnetic Disk

Main Memory (RAM) 

Cache
Fast, Small, 
Experience 

   Slow, 
 Large, Cheap 
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1. Read Only Memory (ROM) 
2. Random Access Memory (RAM) 
3. Complementary Metal Oxide Semiconductor Memory (CMOS) 

1.  Read Only Memory  
Read Only Memory is an essential component of the memory unit.  We know that the 
computer, being a machine, itself has no intelligence or memory and requires 
instructions, which are given by a person.  Whenever the computer is switched on, it 
searches for the required instructions.  The memory, which has these essential 
instructions, is known as Read Only Memory (ROM).  This memory is permanent and is 
not erased when the system is switched off. As appears with its name, it is read only 
memory i.e. it can be read only and not be written by user/ programmer. The memory 
capacity of ROM varies from 64 KB to 256 KB (I Kilobyte = 1024 bytes) depending on 
the model of computer. 
 
Types of ROM 
There are many types of ROM available for microcomputers like Mask ROM, PROM, 
EPROM, EEPROM and EAPROM. 
 
Mask ROM: Mask ROM is the basic ROM chip.  In this type of ROM, the information 
is stored at the time of its manufacturing.  So, it cannot be altered or erased later on. 
 
PROM: PROM stands for Programmable Read Only Memory.  In this type of ROM, the 
information is stored by programmers after its manufacturing.  It also cannot be altered or 
erased later on. 
 
EPROM: EPROM stands for Erasable Programmable Read Only Memory.  It is similar 
to PROM, but its information can be erased later on by ultra violet light and it can be 
reprogrammed. 
 
EEPROM: EEPROM stands for Electrically Erasable Programmable Read Only 
Memory.  It is similar to EPROM, but its information can be erased by using a high 
voltage current. 
 
EAPROM: EAPROM stands for Electrically Alterable Read Only Memory.  As 
compared to EPROM and EEPROM, the information stored in EAPROM can be altered 
later. 
 

2. Random Access Memory 
 Random Access Memory (RAM) is another important component of the Memory Unit.  
It is used to store data and instructions during the execution of programs.  Contrary to 
ROM, RAM is temporary and is erased when the computer is switched off.  RAM is a 
read/ write type of memory, and thus can be read and written by the user/ programmer.  
As it is possible to randomly use any location of this memory, therefore, this memory is 
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known as random access memory.  The memory capacity of RAM varies from 640 KB to 
several megabytes (1 Megabyte = 1024 KB) with different models of PC. 
Types of RAM 
There are two types of RAM used in PCs - Dynamic and Static RAM. 
 
Dynamic RAM (DRAM): The information stored in Dynamic RAM has to be refreshed 
after every few milliseconds, otherwise it is erased.  DRAM has higher storage capacity 
and is cheaper than Static RAM. 
 
Static RAM (SRAM): The information stored in Static RAM need not be refreshed, but 
it remains stable as long as power supply is provided.  SRAM is costlier but has higher 
speed than DRAM. 
 
3. Complementary Metal Oxide Semiconductor Memory 
Complementary Metal Oxide Semiconductor (CMOS) memory is used to store the 
system configuration, date, time and other important data.  When the computer is 
switched on, BIOS matches the information of CMOS with the peripheral devices and 
displays error in case of mismatching. 
 
------------------------------------------------------------------------------------------------------------ 
1.3 DATA REPRESENTATION 
------------------------------------------------------------------------------------------------------------ 
We know that data is usually combination of numbers, characters and special 
characters. This data has to be worked upon by the computer as well as it has to be 
transported from place to place, i.e. data has to flow from place to place within the 
computer hardware. As the computer is a electronic device and it works with electronic 
pulses, this data or information should be in the form which is machine readable and 
understandable, for this reason, data has to be represented in the form of electronic 
pulses. 
 
The data has to be converted into electronic pulses and each pulse should be identified 
with a code. For these reasons, the data is converted into numeric format first, by using 
world wide standard called ASCII i.e. American standard code for Information 
Interchange, where each and every character, special character and keystrokes have 
numerical equivalent. We will have a detail discussion on ASCII codes in the codes 
section. Thus using this equivalent, the data can be interchanged into numeric format. 
For the numeric conversion we use number systems, each number system has a radix or 
base, which indicates the number of digits in that number system. Lets have a quick 
look at number systems. 
1.3.1 Number System 
 
Most modern computer systems do not represent numeric values using the decimal 
system. Instead, they typically use a binary or two’s complement numbering system. To 
understand the limitations of computer arithmetic, you must understand how computers 
represent numbers. 
In any number system there is an ordered set of symbols known as digit with rules 
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defined for performing arithmetic operations like addition, multiplication etc. A 
collection of these digits makes a number which in general has two parts  
 
 

1. Integer part 
2. Fractional part 

 
These two parts are separated by a point (.). 
 
  (N)b = dn-1dn-2dn-3———————d1d0.d1d - 2d -3————————-d - m 
 
 
Where 
N = A number 
b = radix or base of the number system 
n = number of digits in integer portion 
m = number of digits in fractional portion 
d n -1 = most significant digit (msd) 
d -m = least significant digit (lsd) 
 
Let’s understand it: 
You are quite familiar with the decimal number system that is the number system we 
are using in our daily life. Here base is 10 as it has 10 digits (0…9) 
Suppose you are having a number 
N = 1 2 3. ……….8 9 

d1 d0.d-1d-2 
where d represents the digits 
 
The base is 10 
n is 3 
m is 2  
 
Now I think you got the basic criteria to distinguish the one number system from another. 
Now based on this lets come to the types of number system 
 
Types of Number Systems 
Basically there are 4 types of number system. They are as follows 

 
• Binary number system; 
• Decimal number system; 
• Octal number system; 
• Hexadecimal number system. 

 

http://www.studynama.com/?utm_source=pdf&utm_medium=downloaded_file&utm_campaign=studynama_referral


 26

 
Now lets see the characteristics of these number systems: 
 

Number system Base or radix (b) Symbols or digits used 
(d) 

Example 

 
Binary System 

 

2 0, 1  
1011.11 

 
Octal System 8  

0,1,2,3,4,5,6,7 
 

3567.25 

 
Decimal System 

 

10  
0,1,2,3,4,5,6,7,8,9 

 

3947.89 

 
Hexadecimal System 16  

0,1,2,3,4,5,6,7,8,9,
        A, B, C, D, E, F 

 

3FA9.9A 

 
Table 1.1 

 
------------------------------------------------------------------------------------------------------------- 
1.4 REVIEW QUESTIONS 
--------------------------------------------------------------------------------------------- 
1. What are supercomputers and where they are used? 
2. What is the different between analog and digital computer? You have to explain in   

your own words? 
3.  What is the difference between second and the fourth generation of the computer? 
4. Do the comparative studies of the various generations of the computer based on power 

and space occupied by them 
5. What are the characteristics of computer? 
6. Draw a block diagram to illustrate the basic organization of a computer       system and 

explain the functions of various units. 
7. Which component of a computer is generally called 'brain' of computer and Why?       
Describe the functions of the distinct parts of this component. 
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--------------------------------------------------------------------------------------------------------- 
COMPUTER SOFTWARE  
------------------------------------------------------------------------------------------ 

Structure 
2.1 What is Software?  
 2.1.1 Relation between Hardware and Software 
 
2.2 Types of Software 
 2.2.1 System Software 
 2.2.2 Application Software 
 
2.3 Software Development Life Cycle  
 
2.4 Introduction to Algorithm 
 
2.5 Flowcharts 
 2.5.1 Problem Solving, Step by Step 
 2.5.2 How to Draw Flowcharts 
 2.5.3 Basic Flowcharting Shapes 
 2.5.4 Advantages of Flowcharts 
 
2.6 Review Questions 
 
--------------------------------------------------------------------------------------------------------- 
2.1 WHAT IS SOFTWARE? 
--------------------------------------------------------------------------------------------------------- 
A Computer cannot do anything on its own. It must be instructed to do a job desired by us. 
Hence, it is necessary to specify a sequence of instructions a computer must perform to 
solve a problem. Such a sequence of instructions written in a language understood by a 
computer is called a computer program. A program controls a computer’s processing 
activity, and the computer performs precisely what the program wants it to do. When a 
computer is using a program to perform a task, we say, it is running or executing that 
program. 
  
The term software refers to a set of computer programs, procedures, and associated 
documents (flowcharts, manuals, etc.) describing the program, and how they are to be used. 
 
A software package is a group of programs that solve a specific type of job. For example, a 
word processing package may contain programs for text editing, text formatting, drawing 
graphics, spelling checking, etc. Hence, a multipurpose computer system, like a personal 
computer in your home, has several software packages, one each for every type of job it 
can perform. 
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2.1.1 Relation between Hardware and Software 
For a computer to produce useful output its hardware and software must work together. 
Nothing useful can be done with the hardware on its own, and software cannot be utilized 
without supporting hardware. 
 
To take an analogy, a cassette player and its cassettes purchased from the market are 
hardware. However, the songs recorded on the cassettes are its software. To listen to a 
song, that song has to be recorded on one of the cassettes first, which is then mounted on 
the cassette player and played. Similarly, to get a job done by a computer, the 
corresponding software has to be loaded in the hardware first and then executed. 
 
Following important points regarding the relationship between hardware and software are 
brought out by this analogy: 
 
1. Both hardware and software are necessary for a computer to do useful job. Both are 

complementary to each other. 
2. Same hardware can be loaded with different software to make a computer perform 

different types of jobs just as different songs can be played using the same cassette 
player.  

3. Except for upgrades (like increasing main memory and hard disk capacities, or adding 
speakers, modems, etc.); hardware is normally a one- time expense, whereas software 
is a continuing expense. Like we buy new cassettes for newly released songs or for 
songs whose cassettes, we do not have, we buy, new software to be run on the same 
hardware as and when need arises, or funds become available. 

 
--------------------------------------------------------------------------------------------------------- 
2.2 TYPES OF SOFTWARE 
--------------------------------------------------------------------------------------------------------- 
Software is broadly classified into following two types: 

• System Software 
• Application Software 

 
2.2.1 System Software 
Software that is required to control the working of hardware and aid in effective execution 
of a general user's applications are called System Software.  This software performs a 
variety of functions like file editing, storage management, resource accounting, 1/0 
management, database management, etc.  Some of the examples of system software are 
DOS (Disk Operating System), Windows, BASIC, COBOL and PC TOOLS.  This 
software is developed by System Programmers. 
 

Types of System Software 
System software can be further categorized into following three types: 

• System Management Software (Operating Systems, DBMSS, Operating 
Environments) 
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• System Development Software (Language Translators, Application Generators, 
CASE Tools) 

• System Software Utilities 
 
Assemblers: Assemblers translate the assembly language code (source program) into 
machine language code (object program).  After assembling, a linker program is used to 
convert the object program into an executable program.  The Microsoft assembler program 
(MASM) and Borland Turbo assembler program (TASM) are two popular assemblers.  
Assemblers are used mainly in development of system software. 
 

Interpreters: Instructions of a high-level language are coded in many statements.  At the 
time of their execution, they are converted statement by statement into machine code, by 
using system software, called Interpreters.  For example, programs written in BASIC 
language are executed by using BASICA or GWBASIC interpreters.  Programs written in 
some fourth generation languages, like dBase III plus are also executed using dBase 
interpreter. 
 
There are certain disadvantages of interpreters.  As instructions are translated and executed 
simultaneously using interpreters, they are very slow for executing large programs.  Hence, 
interpreters are not suitable for most of applications development. 
 
Compilers: As contrast to interpreters, compilers provide faster execution speed.  
Compilers do not translate and execute the instructions at the same time.  They translate the 
entire program (source code) into machine code (object code).  Using linker, the object 
code is converted into executable code.  Compilers are widely used in translating codes of 
high-level languages (e.g. COBOL, FORTRAN, PASCAL, Turbo/ Quick BASIC, Turbo/ 
Microsoft C etc.) and fourth generation languages (dBase IV, FoxPro etc.). As compared to 
interpreters or assemblers, compilers are preferred in development of application software. 
 
2.2.2 Application Software 
Software that is required for general and special purpose applications like database 
management; word processing, accounting etc. are called Application Software.  Some of 
the examples of application software are dBase, Word Star, Tally etc.  Application software 
is developed using system software by Application Programmers.  Application software 
can be further classified into following two types: 
 

• General Purpose Application Software (Database Management Packages, Word 
Processors, Spreadsheets etc.) 

• Special Purpose Application Software (Accounting, Inventory, Production 
Management etc.) 
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Fig 2.1 Types of Software 

 

--------------------------------------------------------------------------------------------------------- 
2.3 SOFTWARE DEVELOPMENT LIFE CYCLE  
--------------------------------------------------------------------------------------------------------- 
Software Development Life Cycle or SDLC is a model of a detailed plan on how to create, 
develop, implement and eventually fold the software. It’s a complete plan outlining how 
the software will be born, raised and eventually be retired from its function. All software 
needs to be developed by someone. Developing software and putting it to use is a complex 
process involving following steps: 

1. Analyzing the problem at hand, and planning the program (s ) to solve the  problem; 

2. Coding the program (s); 

3. Testing, debugging, and documenting the program (s); 

4. Implementing the program (s); 

5. Evaluating and maintaining the program (s). 
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Fig 2.2 Software Development Life Cycle 

 
 
Importance of Software Development Life Cycle 
Because software can be very difficult and complex. We need the SDLC as a framework to 
guide the development to make it more systematic and efficient.  
 
We will be able to tell how long it will take to complete the project, to test and deploy. Not 
only that, you'll have an easier time debugging and finding flaws in the software program 
or make enhancement to it. 
--------------------------------------------------------------------------------------------------------- 
2.4 INTRODUCTION TO ALGORITHM 
--------------------------------------------------------------------------------------------------------- 
Planning a program involves defining its logic (the correct sequence of instructions needed 
to solve the problem at hand). The term Algorithm refers to the logic of a program. It is a 
step – by – step description of how to arrive at a solution. To a given problem. It is defined 
as a sequence of instructions that when executed in the specified sequence, the desired 
results are obtained. In order to qualify as an algorithm, a sequence of instructions must 
possess the following characteristics: 

1. Each instruction should be precise and unambiguous. 

2. Each instruction should be executed in a finite time. 

3. One or more instructions should not be repeated infinitely. This ensures that the 
algorithm will ultimately terminate. 

4. After executing the instructions (when the algorithm terminates), the desired results 
are obtained. 
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Therefore, in simple terms, we can say that an algorithm is a procedure to accomplish a 
specific task. It is the idea behind any computer program. To be interesting, an algorithm 
has to solve a general, well-specified problem. An algorithmic problem is specified by 
describing the complete set of instances it must work on and what properties the output 
must have as a result of running on one of these instances. This distinction between a 
problem and an instance of a problem is fundamental. To gain insight into algorithms, let 
us consider a simple example. 
 
Example: There are 50 students in a class who appeared in their final examination. Their 
mark sheets have been given to you. Write an algorithm to calculate and print the total 
number of students who passed in first division. 
 
Algorithm: 
 
Step 1: Initialize TOTAL FIRST DIVISION and TOTAL MARKSHEETS CHECKED to 
zero. 
 
Step 2: Take the mark sheet of the next student. 
 
Step 3: Check the division column of the mark sheet to see if it is FIRST. If no, go to step 
5. 
 
Step 4: Add 1 to TOTAL FIRST DIVISION. 
 
Step 5: Add 1 to TOTAL MARKSHEETS CHECKED. 
 
Step 6: Is TOTAL MARKSHEETS CHECKED = 50? If no, go to step 2. 
 
Step 7: Print TOTAL \FIRST DIVISION. 
 
Step 8: Stop. 
 
It must be clear to you from this example that even for every simple problems, the 
development of algorithms is not as simple as it might initially appear and requires some 
thinking. It may also be noted from the given example that in order to solve a given 
problem, each and every instruction must be strictly carried out in a particular sequence. It 
is this fact, which a beginner to problem solving by computers finds difficult to appreciate. 
 
--------------------------------------------------------------------------------------------------------- 
2.5 FLOWCHARTS 
--------------------------------------------------------------------------------------------------------- 
A Flowchart is a pictorial representation of an algorithm. Programmers often use it as a 
program – planning tool for visually organizing a sequence of steps necessary to solve a 
problem using a computer. It uses boxes of different shapes to denote different types of 
instructions. The actual instructions are written within these boxes using clear and concise 
statements. Solid lines having arrow marks connect these boxes to indicate the flow of 
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operation, that is, the exact sequence in which to execute the instructions. The Process of 
drawing a flowchart for an algorithm is known as flowcharting. 
 
2.5.1 Problem Solving: Step by Step 
Before we begin to learn the kinds of steps that a computer has to perform to solve a 
problem, let us think about problem solving, in general. 
 
Think of what you might do if I asked you to write a set of instructions for brushing your 
teeth. What are the steps you might write down? Would you write this down? 
 
(1) Put toothpaste on toothbrush. 
 
(2) Brush teeth with toothbrush. 
 
(3) Put toothbrush away. 
 
If you write only these three instructions, it means that the person must somehow know 
where the toothbrush and toothpaste are located, how to get the toothpaste out of the tube, 
what it means toothbrush, and how to put the toothbrush away. You cannot assume that the 
person knows these things. You have not taken care of any possible problems that might 
arise. You would have to be much more detailed in you writing. Let try it again 
(1) Go to the bath-room.  
 
(2)  Open door. 
 
(3) Take out toothpaste. 
 
(4) If toothbrush is not there, look for toothbrush. 
 
(5) If toothbrush is not found, go to step 18. 
 
(6) Remove toothpaste. 
 
(7) If toothpaste is not there, look for toothpaste. 
 
(8) If toothpaste cannot be found, go to step 12. 
 
(9) Take cap of toothpaste. 
 
(10) Squeeze toothpaste onto toothbrush. 
 
(11) If toothpaste does not come out of the tube, check tube. 
 
(12) Put toothbrush into mouth and rub on teeth. 
(13) Spit out. 
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(14) Fill glass with water. 
 
(15) Rinse mouth with water. 
 
(16)  Wash face. 
 
(17) Replace toothbrush. 
 
(18) Put toothpaste away if you had toothpaste. 
 
(19) Wash face. 
 
(20) Clean sink. 
 
(21) Rinse glass. 
 
(22) Put glass back. 
 
It took twenty-two instructions to replace the three instructions and I have left out one 
instruction did you spot it?!Did not put the cap back on the toothpaste! 
 
Sometimes, if you Java out a step like that, the computer will just stop. It may say 
something to you or it may not. It may continue to do things, but they may not be the things 
you want you do. It may give you an answer, but the answer may not be the correct one. 
The computer did not make a mistake. It did all the steps you asked it to do. If the computer 
does not do what you want it to do, it may be because you did not tell it the right steps. It 
may be because you left out a choice that made a change in the program. 
 
Did you notice that I included what you had to do if anything went wrong? If there were no 
toothbrush or toothpaste or if the toothpaste did not come out of the tube, you were 
instructed to do something. You must plan 'for all the things that could happen when the 
computer is running its program. What if a number gets to be too big or someone gives the 
wrong answer to a question? You must have something for the computer to do in every 
base. 
 
You are making a plan for the computer to follow, just as the architect makes a plan for the 
carpenters to follow. Before we begin to make plans for a computer to follow, let’s try to 
plan some things for people to do and then have you follow the plans. Some actions you 
might write instructions for are typing a shoelace of a necktie, putting on makeup, or riding 
bicycle. If you don’t put in enough steps, you may find someone in a very strange position. 
 
2.5.2 How to Draw Flowcharts 
A flowchart illustrates the steps in a process. By visualizing the process, a flowchart can 
quickly help identify bottlenecks or inefficiencies where the process can be streamlined or 
improved. 
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Example: Two Flowcharts for a Common Process 
 
Suppose your research revealed that you always want fries and a drink with your burger. 
You decide to streamline your process by ordering the combo meal, which automatically 
includes fries and a drink. The two flowcharts show at a glance that you omit two decisions 
and two order steps by using the streamlined order process. 
 
 

 
 
 
2.5.3 Basic Flowcharting Shapes 
Flowcharts use special shapes to represent different types of actions or steps in a process. 
Lines and arrows show the sequence of the steps, and the relationships among them. 
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The terminator symbol marks the starting or ending point of the system. It usually 
contains the word "Start" or "End."  

 

A box can represent a single step ("add two cups of flour"), or and entire sub-
process ("make bread") within a larger process.  

 

A printed document or report.  

 

A decision or branching point. Lines representing different decisions emerge 
from different points of the diamond. The box where the computer can make 
decisions like finding out which numbers is bigger or smaller or equal than 
another number, depending on the information it receives. These are diamond – 
shaped boxes. The computer can decide with the help of decision taken by the 
diamond box, which route is to be followed further.   
 

 

Represents material or information entering or leaving the system, such as 
customer order (input) or a product (output).  

 

Indicates that the flow continues on another page, where a matching symbol 
(containing the same letter) has been placed.  

 
Lines indicate the sequence of steps and the direction of flow.  
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Basic Flowchart 
A basic Flowchart identifies the starting and ending points of a process, the sequence of 
actions in the process, and the decision or branching points along the way. 
 

 
 
 
2.5.4 Advantages of Flowcharts 
The following benefits may be obtained from flow charts: 
 

1. Better Communication 
 
2. Effective analysis 

 
3. Effective synthesis 

 
4. Proper program Documentation 

 
5. Effective coding 

 
6. Systematic debugging 

 
7. Systematic testing 
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--------------------------------------------------------------------------------------------------------- 
2.6 REVIEW QUESTIONS 
------------------------------------------------------------------------------------------ 

1. Differentiate between system and application software.  Give 4 examples of each  
2. What are the various flowcharting symbols? 
3. Draw a flow chart of getting the maximum of three numbers input. 
4. What is algorithm? What are the characteristics necessary for a sequence of 

instructions to qualify as an algorithm?  
5. Define the terms hardware and software. 
6.  Describe the functions of the various basic flowcharting symbols. 
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--------------------------------------------------------------------------------------------------------- 
OPERATING SYSTEMS  
--------------------------------------------------------------------------------------------------------- 

Structure 
3.1 Introduction 
 3.1.1 Layers of Operating System  
 3.1.2 Functions of Operating Systems 
 3.1.3 Characteristics of an Operating System 
 3.1.4 Measuring System Performance 
 
3.2 Evolution of Operating Systems 
 3.2.1 Serial Processing 
 3.2.2 Batch Processing 
 3.2.3 Multiprogramming  
 
3.3 Types of Operating System  
 3.1 Batch Processing Operating Systems.  
 3.3.2 Time Sharing Operating Systems 
 3.3.3 Real Time Operating Systems 
 
3.4 Operating System Techniques 
 3.4.1 Multiprogramming 
 3.4.2 Multiprocessing 
 3.4.3 Multitasking 
 3.5.4 Multithreading  
 
3.5 Some Popular Operating Systems 
 3.5.1 Disk Operating System 
 3.5.2 UNIX 
 3.5.3 Linux 
 3.5.4 Microsoft Windows  
 3.5.5 Microsoft Windows NT 
 
3.6 Review Questions 
--------------------------------------------------------------------------------------------------------- 
3.1 INTRODUCTION 
--------------------------------------------------------------------------------------------------------- 
What is human body without life giving Oxygen, the same is the case of a computer, its 
existence is immaterial, without an operating system, such is the importance of the 
Operating System. Operating System falls under the category of System software. The goal 
of this unit is to introduce the concept related to operating system and what is the function 
of operating system. 
 
The Operating System is not the command interpreter alone, as people perceive. The 
Operating System is the program that must be running all the time, and cannot be replaced 
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without it being a different O/S. Let us look into this most important component of the 
Computer System, the Operating System. 
 
Definition 1: 
“An operating system can be defined as the set of instructions or programs, which make the 
computer work” 
 
Definition 2: 
“An Operating System or OS is a software program that enables the computer hardware to 
communicate and operate with the computer software” 
 
Definition 3: 
“An operating system is software, which controls the computer and its peripherals 
and makes the computer ready to use by a process called booting” 
 
Without an Operating System a computer would be useless. 
 
An Operating System (OS) is an integrated set of programs that is used to manage the 
various resources and overall operations of a computer system. It is designed to support the 
activities of a computer installation. Its prime objective is to improve the performance and 
efficiency of a computer and increase facility, the ease with which a system can be used. 
As we have seen that an operating system is software, which makes the computer ready to 
use by a process called booting.  Before, discussing more on the operating systems, let us 
first see what exactly do you mean by booting:  

 
When we switch on the computer, the instructions stored in ROM are automatically 
executed.  These instructions help the computer to load the operating system from external 
storage device (disk) to internal storage (RAM).  This process of loading of operating 
system from disk to RAM is called booting. 

 
 

    Fig 3.1 Component of Computer System 
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3.1.1 Layers of Operating System 
Each group of computers may have its own and unique operating system although not 
necessarily only one. Operating system programs are commonly stored in hard disk. When 
we switch on the computer the booting program know as BIOS (Basic I/O System) which 
is stored in the ROM (Read only memory) fetches the OS from hard disk to primary 
storage (RAM). An OS tells the computer how to conduct him self. The architecture of 
Operating System is designed with many layers in the core of it is Hardware/Kernel, above 
it is loaded an OS which in turn controls everything inside a computer and make an 
interface with the application program loaded in to the computer. It interconnects the 
application program to CPU through Compiler or Interpreter. 
            
      
      
      
      
      
      
      
      
      

  
 
 
 
 
 

Fig 3.2 Layers of Operating System 
 
 
3.1.2 Functions of Operating Systems 
Operating systems in general take care of all the housekeeping tasks. They do read and 
write files, maintain disk directories, allocate memory to application programs, and usually 
handle mechanical chores such as reading the keyboard when you press keys and updating 
the screen when something needs to be displayed. These tasks require a surprising amount 
of software and every computer requires software to do these jobs.  
 
Due to the fact that there is close-knit cooperation between operating systems and 
applications programs, each and every application program must be designed such that it is 
able to work with a particular operating system. All operating systems essentially do the 
same things but they do it in different ways, some features may be additional which add to 
the functionality. This makes the point clear that an application program may work with all 
operating systems, with slight modifications. An operating system performs, basically the 
following functions: 
 

1. Communication with the computer user or operator by means of terminals or 
Consoles, and through the use of monitor commands and responses. It acts as 
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system start up device also. The operating system is automatically loaded into 
hardware's main memory (RAM) when computer is turned on. Then the OS either 
waits for you to give it a command of it brings a pre selected program into a read to 
operate condition. This sequence is known as boot strapping or simply booting.  

 
2. Assigning Priorities: Usually, the OS has several levels of priorities. For instance, a 

report generating program may continue to run until the system receives a 
command or query from the terminal, (a priority in computer lingo). Then the 
system responds to the request from the terminal before continuing with the report 
program.  

 
3. The scheduling and loading of programs, or subprograms is necessary in order to 

provide a continuous job processing sequence or to province appropriate responses 
to events- job to job - processing and job as counting. 

 
4. Control over hardware resources e.g. control over the selection and operation of all 

peripheral devices used to input, or storage. The operating system also directs the 
movement and processing of information required by your applications programs. It 
transfers data to and from storage and input output devices like terminals or 
printers. 

 
5. Managing the data and program files: The operating system directs the information 

storage and retrieval functions using one or more filing methods. These may include 
sequential (magnetic tape), random (as on disk, units) or data base storage 
structures.’ the latter method uses special identifiers for each file to locate 
information more rapidly and to avoid- redundant information storage. 

 
6. Provide utility functions that provide the user with tools for some operations like: 

• Loading programs 
• Transferring files from one floppy to another, backing up and copying. 
• Formatting a disk to accept data Program. 
• Sending information to I/O devices like printer, or a modem. 
• Displaying the directory of contents of a disk.  
 

7. Handling errors when they occur and using corrective routines where possible. 
 
8. Protecting hardware, software and data from improper use. 

 
9. Furnishing a complete Account of what has happened during operation. Some 

details of this log may be stored for accounting purposes. 
The more sophisticated a computer's operating system, the better the computer system can 
manage itself, the less human intervention is required, and the more data computer can 
process. This is one reason why today's mainframe operating systems are large, complex 
programs involving thousands of instructions and costing thousands of dollars. 
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3.1.3 Characteristics of an Operating System 
Let us try to identify the main characteristics of an operating system: 
 

• Concurrency: being able to handle events as they occur and executing multiple 
tasks in parallel; 

• Sharing the resourced for a number of reasons: 
1. Cost 
2. Using the work of others 
3. Sharing data: use the same data in several different programs possibly 

used by several different users. 
• Removing redundancy; 
• Long-term storage of information (privacy, integrity, security); 
• Non determinacy: an operating system must be able to handle events occurring 

in an unpredictable order. 
 

3.1.4 Measuring System Performance 
Efficiency of an operating system and overall performance of a computer system are 
measured usually in terms of the following parameters: 
 

1. Throughput: Throughput is the amount of work that a system is able to do per unit 
time. It is measured as the number of jobs (processes) completed by the system per 
unit time. For example, if a system is able to complete n processes in t seconds, its 
throughput is n/t processes per second during that interval. Throughput is measured 
normally in processes per hour. Note that the throughput of a system does not 
depend on its jobs processing efficiency only, but also on the number of jobs 
processed. For long process, throughput of a system may be one process/hour; 
whereas for short processes, it may be 100 processes /hour for the same system. 

2. Turnaround time: From the point of view of an individual user, an important 
criterion is how long it takes a system to complete a job submitted by him/her. 
Turnaround time is the interval between the time of submission of a job to the 
system for processing to the time of completion of the job. Although, higher 
throughput is desirable from the pointy of view of overall system performance, 
individual users are more interested in better turnaround time for their jobs. 

3. Response time: Turnaround time is not a suitable measure for interactive systems 
because in such a system a process can produce some output early during its 
execution and can continue executing while previous results are being output to the 
user. Hence, another measure used in case of interactive systems is response time. It 
is the interval between the time of submission of a job to the system for processing 
to the time of the system producing the first response for the job. In any computer 
system, it is desirable to maximize throughput and minimize turnaround time and 
response time. 
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--------------------------------------------------------------------------------------------------------- 
3.2 EVOLUTION OF OPERATING SYSTEMS 
-------------------------------------------------------------------------------------------------------- 
An operating system may process its task serially (sequentially) or concurrently (several 
tasks simultaneously). It means that the resources of the computer system may be dedicated 
to a single program until its completion or they may be allocated among several programs 
in different stages of execution. The feature of operating system to execute multiple 
programs in interleaved fashion or different time cycles is called as multiprogramming 
systems. In this topic, we will try to trace the evolution of operating system. In particular, 
we will describe serial processing, batch processing and multiprogramming. 
 
3.2.1 Serial Processing 
Programming in 1's and 0's (machine language) was quite common for early computer 
systems. Instruction and data used to be fed into the computer by means of console 
switches or perhaps through a hexadecimal keyboard. Programs used to be started by 
loading the program computer register with the address of the first instruction of a program 
and its result (program) used to be examined by the contents of various registers and 
memory locations of the machine. Therefore, programming in this style caused a low 
utilization of both users and machine. 
 
Advent of Input Output devices, such as punched cards paper tape and language translators 
(Compiler/Assemblers) brought a significant step in computer system utilization. Program 
started being coded into programming language are first changed into object code (binary 
code) by translator and then automatically gets loaded into memory by a program called 
loader. After transferring a control to the loaded program, the execution of a program 
begins and its result gets displayed or printed. Once in memory, the program may be re-run 
with a different set of input data. The process of development and preparation of a program 
in such environment is slow and cumbersome due to serial processing and numerous 
manual processing. In a typical sequence first the editor is called to create a source code of 
user program written in programming language, translator is called to convert a source 
code into binary code and then finally loader is called to load executable program into main 
memory for execution. If syntax errors are detected, the whole process must be restarted 
from the beginning. The next development was the replacement of card decks with 
standard input/output and some useful library programs, which were further linked with 
user program through system software called linker. While there was a definite 
improvement over machine language approach, the serial mode of operation is obviously 
not very efficient. This results in low utilization of resources. 
 
3.2.2 Batch Processing 
Utilization of computer resources and improvement in programmer's productivity was still 
a major prohibition. During the time that tapes were being mounted or programmer was 
operating the console, the CPU was sitting idle. The next logical step in the evolution of 
operating system was to automate the sequencing of operations involved in program 
execution and in the mechanical aspects of program development. Jobs with similar 
requirements were batched together and run through the computer as a group. For example, 
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suppose the operator received one FORTRAN program, one COBOL program and another 
FORTRAN program. If he runs them in that order, he would have to set up for FORTRAN 
program environment (loading the FORTRAN compiler tapes) then set up COBOL 
program and finally FORTRAN program again. If he runs the two FORTRAN programs as 
a batch, however he could set up only once for FORTRAN thus saving operator's time. 
 
Batching similar jobs brought utilization of system resources quite a bit. But there were still 
problems. For example, when a job is stopped, the operator would have to notice that fact 
by observing the console, determine why the program stopped and then load the card reader 
or paper tape reader with the next job and restart the computer. During this transition from 
one job to the next, the CPU sat idle.  
 
To overcome this idle time, a small program called a resident monitor was created which is 
always resident in the memory. It automatically sequenced one job to another job. Resident 
monitor acts according to the directives given by a programmer through control cards 
which contain information like marking of job's beginnings and endings, commands for 
loading and executing programs, etc. These commands belong to job control language. 
These job control language commands are included with user program and data. Here is an 
example of job control language commands. 
 
$COB - Execute the COBOL compiler 
$JOB - First card of a job 
$END - Last card of a job 
$LOAD - Load program into memory 
$RUN - Execute the user program 

 
 

Figure 3.3 shows a sample card deck set up for a simple batch system. 
 
With sequencing of program execution mostly automated by batch operating system, the 
speed discrepancy between fast CPU and comparatively slows input/output devices such as 
' card readers, printers emerged as a major performance bottleneck. Even a slow CPU 
works in the microsecond range, with millions of instructions per second. But, fast card 
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reader, on the other hand, might read 1200 cards per minute. Thus, the difference in speed 
between the CPU and its input/output devices may be three orders of magnitude or more. 
The relative slowness of input/output devices can mean that CPU is often waiting for 
input/output. As an example, an Assembler or Compiler may be able to process 300 or 
more cards per second. A fast card reader, on the other hand, may be able to read only 1200 
cards per minute. This means that assembling or compiling a 1200 card program would 
require only 4 seconds of CPU time but 60 seconds to read. Thus, the CPU is idle for 56 
out of 60 seconds or 93.3 per cent of the time. The resulting CPU utilization is only 6.7 per 
cent. The process is similar for output operations. The problem is that while an input/output 
is occurring, the CPU is idle, waiting for the input/output to complete; while the CPU is 
executing, input/output devices are idle. 
 
Over the years, of course, improvements in technology resulted in faster input/output 
devices. But CPU speed increased even faster. Therefore, the need was to increase the 
throughput and resource utilization by overlapping input/output and processing operations. 
DMA (Direct Memory Access) chip which directly transfers the entire block of data from 
its own buffer to main memory without intervention by CPU was a major development. 
While CPU is executing, DMA can transfer data between high speed input/output devices 
and main memory. CPU requires to be interrupted per block only by DMA. Apart from 
DMA, there are two other approaches to improving system performance by overlapping 
input, output and processing. These are buffering and spooling.  
 
Buffering is a method of overlapping input, output and processing of a single job. The idea 
is quite simple. After data has been read and the CPU is about to start operating on it, the 
input device is instructed to begin the next input immediately. The CPU and input device 
are then both busy. With luck, by the time that the CPU is ready for the next data item the 
input device will have finished reading it. The CPU can then begin processing the newly 
read data, while the input device starts to read the following data. Similarly, this can be 
done for output. In this case, the CPU creates data that is put into a buffer until an output 
device can accept it. For output, the CPU can proceed at full speed until, eventually all 
system buffers are full. Then the CPU must wait for the output device. This happens with 
input/output bound jobs where the amount of input/output relation to computation is very 
high. Since the CPU is faster than the input/output device, the speed of execution is 
controlled by the input/output device, not by the speed of the CPU.  
 
More sophisticated form of input/output buffering called SPOOLING (simultaneous 
peripheral operation on line) essentially use the disk as a very large buffer (figure 3.4) for 
reading and for storing output files reading and for storing output files.  
 
 
Buffering overlaps input, output and processing of a single job whereas Spooling allows 
CPU to overlap the input of one job with the computation and output of other jobs. 
Therefore this approach is better than buffering. Even in a simple system, the spooler may 
be reading the input of one job while printing the output of a different job. 
 

http://www.studynama.com/?utm_source=pdf&utm_medium=downloaded_file&utm_campaign=studynama_referral


 47

 
 

Fig 3.4 Spooling 
 

3.2.3 Multiprogramming  
Buffering and spooling improve system performance by overlapping the input, output and 
computation of a single job, but both of them have their limitations. A single user cannot 
always keep CPU or I/O devices busy at all times. Multiprogramming offers a more 
efficient approach to increase system performance. In order to increase the resource 
utilization, systems supporting multiprogramming approach allow more than one job 
(program) to utilize CPU time at any moment. More number of programs competing for 
system resources, better will be resource utilization. The idea is implemented as follows. 
The main memory of a system contains more than one program (Figure 3.5). 

  
Figure 3.5: Memory layout in multiprogramming environment 

 
The operating system picks one of the programs and start executing. During execution 
process program1 may need some I/O operation to complete. In a sequential execution 
environment (Figure 3.6a), the CPU would sit idle. In a multiprogramming system, (Figure 
3.6b) operating system will simply switch over to the next program (Program2). 
 
When that program needs to wait for some I/O operation, it switches over to Program 3 and 
so on. If there is no other new program left in the main memory, the CPU will pass its 
control back to the previous programs.  
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Multiprogramming has traditionally been employed to increase the resource utilization of a 
computer system and to support multiple simultaneously interactive users (terminals). 
Compared to operating system which supports only sequential execution, 
multiprogramming system requires some form of CPU and memory management strategies  
 

 
 

Figure 3.6: Multiprogramming 
 

--------------------------------------------------------------------------------------------------------- 
3.3 TYPES OF OPERATING SYSTEM  
--------------------------------------------------------------------------------------------------------- 
As computers have progressed and developed so have the types of operating systems.  
Many types of operating systems are available for computers, which can be divided into the 
following two broad categories - 

 
(a) Single-user operating systems. 
(b) Multi-user operating systems. 
 
(a) Single-user operating systems: These operating systems are used for mainly 
computers having only one terminal (stand-alone PCs).  MS DOS (Microsoft Disk 
Operating System) and PC DOS (Personal Computer Disk Operating System) are the two 
important single user operating systems.  Both systems are almost identical and are simply 
called DOS.  OS/2 and Windows NT are other popular single-user multi-tasking operating 
systems for microcomputers. 
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(i) Microsoft DOS - MS DOS, developed by 'Microsoft Inc.' in 1981, is the 
most widely used operating system of IBM-compatible microcomputers.  
The latest version identification number of a release of software) of MS 
DOS is 7.  

(ii) PC DOS - PC DOS is essentially the same operating system as MS DOS, 
but developed and supplied by IBM for its personal computers. 

 
(b) Multi-user operating systems: These operating systems are used for those computers 
(micro to mainframe), which have many terminals (multi-user systems).  The popular 
operating systems used for multi-user systems are UNIX, NETWARE, MVS, OS/400, 
VMS and Linux. 
 
Multi-user operating systems are used on networks of computers and allow many different 
users to access the same data and application programs on the same network. It also allows 
users to communicate with each other. 

Modern computer operating systems may also be classified into three other groups, which 
are distinguished by the nature of interaction that takes place between the computer user 
and his or her program during its processing. The three groups are called batch, time-
shared and real time operating systems. 

3.3.1 Batch Processing Operating Systems.  
If there was a lot of work to be done, then these works are pooled and the collections of 
these instructions would be given to the computer to work on overnight. Since the 
computer was working on batches of instructions, this type of operating system was called 
a Batch Processing Operating System. 

Batch processing operating systems are good at churning through large numbers of 
repetitive jobs on large computers. Jobs like: printing of invitations for AGM, 
consolidation of marks and presenting result, working out the pay of each employee in 
large firm; or processing all the questionnaire forms in a large survey. 

In a batch processing operating system environment users submit jobs to a central place 
where these jobs are collected into a batch, and subsequently placed on an input queue at 
the computer where they will be run. In this case, the user has no interaction with the job 
during its processing, and the computer’s response time is the turnaround time-the time 
from submission of the job until execution is complete, and the results are ready for return 
to the person who submitted the job. 

3.3.2 Time Sharing Operating Systems 
Time-sharing is a mechanism to provide simultaneous interactive use of a computer system 
by many users in such a away that each one feels that he/she is the sole user of the system. 
It uses multiprogramming with a special CPU scheduling algorithm to achieve this. 
 
A time-sharing system has many (even hundreds of) user terminals connected to the same 
computer simultaneously. Using these terminals, multiple users can work on the system 
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simultaneously. Multiprogramming feature allows multiple user programs to reside 
simultaneously in main memory, and special CPU scheduling algorithm allocates a short 
period of CPU time one-by-one to each user process (from the first one to the last one, and 
then again beginning from the first one). The short period during which a user process gets 
to use CPU is known as time slice, time slot, or quantum, and is typically of the order of 
10 to 100 milliseconds. Hence, when CPU is allocated to a user process, it uses the CPU 
until the allotted time slice expires (system's clock sends an interrupt signal to CPU after 
every time slice), or it needs to perform some I/O operation, or it completes its execution 
during this period. Notice that CPU is taken away from a running process when the allotted 
time slice expires. Figure 3.7 shows the process state diagram of a time-sharing system  
 

 
 

 
Figure 3.7 Process state diagrams for a time-sharing system. 

In this environment a computer provides computing services to several or many users 
concurrently on-line. Here, the various users are sharing the central processor, the memory, 
and other resources of the computer system in a manner facilitated, controlled, and 
monitored by the operating system. The user, in this environment, has nearly full 
interaction with the program during its execution, and the computer’s response time may be 
expected to be no more than a few second. 

Advantages of Time-sharing Systems: Although time-sharing systems are complex to 
design, they provide the following advantages to their users: 
 
1. Reduces CPU idle time. A user's thinking and typing speed is much slower than a 
computer's processing speed. Hence, during interactive usage of a system, while a user is 
engaged in thinking or typing his / her input, a time-sharing system services many other 
users. Hence, time-sharing systems help in reducing CPU idle time and, in turn, provide 
increased system throughput. 
 
2. Provides advantages of quick response time. The special CPU scheduling algorithm 
used in time sharing systems ensures quick response time to all users. This feature helps in 
improving programmers' efficiency by making interactive programming and debugging 
much simpler and quicker. Multiple programmers can work simultaneously for writing, 
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testing, and debugging their programs, or for trying out various approaches to a problem 
solving. 
 
3. Offers good computing facility to small users. Small users can gain direct access to 
more sophisticated hardware and software than they could otherwise justify or afford. In 
time-sharing systems, they merely pay a fee for resources used and are relieved of 
hardware, software, and personnel problems associated with acquiring and maintaining 
their own installation. 
 
Multitasking Operating Systems: Multi-tasking operating systems are now very 
common. They enable the computer to run more than one piece of software at the same 
time. It is quite common to sit at your computer and have a word-processor open and 
running, as well as an Internet browser, and an audio CD player all at the same time. 

The operating system allows you to switch between the applications and even transfer data 
between them (for example, it helps you to copy a picture from an internet site shown on 
your browser application and paste it into your DTP application). 

Multitasking Operating systems allow multiple software processes to be run at the same 
time. Operating systems that would fall into this category are: 

• System 7.x 
• System 8.x 
• UNIX 
• Windows 2000 
• Windows 95 
• Windows 98 
• Windows NT 4.0 

Multitasking operating systems allow a user to do more than one thing at the same time. 
 
Multi-user Operating Systems: Multi-user operating systems are used on networks of 
computers and allow many different users to access the same data and application programs 
on the same network. It also allows users to communicate with each other. 
There are many different types of Network Operating System, each one suited to a 
different. 
 
Multi - User - Allows multiple users to utilize the computer and run programs at the same 
time. Operating systems that would fall into this category are: 

• System 7.x 
• System 8.x 
• UNIX 
• Windows 2000 
• Windows 3.1x 
• Windows 95 
• Windows 98 
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• Windows NT 
 
3.3.3 Real Time Operating Systems 
A Real-Time Operating System (RTOS) is a multitasking operating system intended for 
real-time applications. Such applications include embedded systems (programmable 
thermostats, household appliance controllers), industrial robots, spacecraft, industrial 
control (see SCADA), and scientific research equipment. It is another form of operating 
system which is used in environments where a large number of events mostly external to 
computer systems, must be accepted and processed in a short time or within certain 
deadlines. Examples of such applications are flight control, real time simulations etc. Real 
time systems are also frequently used in military application. 

 Real Time Operating Systems are designed to service those applications where response 
time is of the essence in order to prevent error, misrepresentation or even disaster. 
Examples of real time operating systems are those, which handle airlines reservations, 
machine tool control, and monitoring of a nuclear power station. The systems, in this case, 
are designed to be interrupted by external signal that require the immediate attention of the 
computer system. 

A primary objective of real-time system is to provide quick response times. User 
convenience and resource utilization are of secondary concern to real-time system. In the 
real-time system each process is assigned a certain level of priority according to the relative 
importance of the event processes. The processor is normally allocated to the highest 
priority process among those which are ready to execute. Higher priority process usually 
pre-empte execution of lower priority processes. This form of scheduling called, priority 
based pre- emptive scheduling, is used by a majority of real-time systems. 

In fact, many computer operating systems are hybrids, providing for more than one of these 
types of computing service simultaneously. It is especially common to have a background 
batch system running in conjunction with one of the other two on the same computer. A 
number of other definitions are important to gaining an understanding of operating 
systems: 

A multiprogramming operating system is a system that allows more than one active user 
program (or part of user program) to be stored in main memory simultaneously. Thus, it is 
evident that a time-sharing system is a multiprogramming system, but note that a 
multiprogramming system is not necessarily a time-sharing system. A batch or real time 
operating system could, and indeed usually does, have more than one active user program 
simultaneously in main storage. Another important, and all too similar, term is 
‘multiprocessing’. 
A multiprocessing system is a computer hardware configuration that includes more than 
one independent processing unit. The term multiprocessing is generally used to refer to 
large computer hardware complexes found in major scientific or commercial applications. 
This Operating system allows multiple processors to be utilized. Operating systems that 
would fall into this category are: 
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• UNIX 
• Windows 2000 
• Windows NT 4.0 

 
A networked computing system is a collection of physical interconnected computers. The 
operating system of each of the interconnected computers must contain, in addition to its 
own stand-alone functionality, provisions for handing communication and transfer of 
program and data among the other computers with which it is connected. 
 
A distributed computing system consists of a number of computers that are connected 
and managed so that they automatically share the job-processing load among the 
constituent computers, or separate the job load as appropriate particularly configured 
processors. Such a system requires an operating system, which, in addition to the typical 
stand-alone functionality, provides coordination of the operations and information flow 
among the component computers. 
 
The networked and distributed computing environments and their respective operating 
systems are designed with more complex functional capabilities. In a network operating 
system the users are aware of the existence of multiple computers, and can log in to remote 
machines and copy files from one machine to another. Each machine runs its own local 
operating system and has its own user (or users). 
 
A distributed operating system, in contrast, is one that appears to its users as a traditional 
unprocessed system, even though it is actually composed of multiple processors. In a true 
distributed system, users should not be aware of where their programs are being run or 
where their files are located; that should all be handled automatically and efficiently by the 
operating system. 
 
Network operating systems are not fundamentally different from single processor operating 
systems. They obviously need a network interface controller and some low-level software 
to drive it, as well as programs to achieve remote login and remote files access, but these 
additions do not change the essential structure of the operating systems. 
--------------------------------------------------------------------------------------------------------- 
3.4 OPERATING SYSTEM TECHNIQUES 
--------------------------------------------------------------------------------------------------------- 
There are several techniques used in Multi-user operating systems for enabling many users 
to concurrently share the single or multiple CPU (e.g. Multiprogramming and 
Multiprocessing).  Some techniques are used in single-user operating system to handle 
multiple tasks (Multitasking).  We will now discuss these common techniques used in 
different operating systems. 

3.4.1 Multiprogramming 
 
It is a process by which single CPU works on two or more programs simultaneously.  
Using this technique, the operating system keeps the CPU busy.  Multiprogramming allows 
the processor to handle either multiple batch jobs at a time (Batch Multiprogramming) or 
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multiple interactive jobs shared among multiple users (Time Sharing Multiprogramming).  
Time-sharing is a technique that allows a CPU to simultaneously support the activities of 
several users by allocating fixed time slots (in milliseconds).  Examples of operating 
systems that support multiprogramming are OS/2, UNIX and Macintosh System 7. 
 
3.4.2 Multiprocessing  
It refers to the use of two or more CPUs to perform a coordinated task simultaneously. 
Figure 3.8 shows the architecture of a computer with its CPU, memory, and I/O processors. 

 
 
Fig 3.8 Architecture of a computer system with its CPU, memory, and I/O processors. 
 
The idea of using I/O processors to improve system performance was carried a step further 
by designing systems with multiple CPUs. Such systems are called multiprocessing 
systems because they use multiple processors (CPUs) and can execute multiple processes 
concurrently. Multiple CPUs of these systems are used to process either instructions from 
different and independent programs or different instructions from the same program 
simultaneously. Figure 3.9 shows basic organization of a typical multiprocessing system. 
 

 
 

Figure 3.9 Basic organization of a typical multiprocessing system 
 
For example, MVS, VMS and Windows NT support multiprocessing. 
 
3.4.3 Multitasking 
It refers to the ability of an operating system to execute two or more tasks concurrently.  In 
multitasking environment, the user opens new applications without closing the previous 
ones and the information can be easily moved among a number of applications.  
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Technically speaking, multitasking is same as multiprogramming. Many authors do not 
distinguish between multiprogramming and multitasking because both refer to the same 
concept. However, some authors prefer to use the term multiprogramming for multi-user 
systems (systems that are used simultaneously by many users such as mainframe and server 
class systems), and multitasking for single-user systems (systems that are used by only one 
user at a time such as a personal computer or a notebook computer). Note that even in a 
single-user system, it is not necessary that the system processes only one job at a time. In 
fact, a user of a single-user system often has multiple tasks being processed by the system. 
For example, while editing a file in foreground, a sorting job can be given in background. 
Similarly, while compilation of a program is in progress in background, user may be 
reading his/her electronic mails in foreground. In this manner, a user may work 
concurrently on many tasks. In such a situation, status of each of the tasks is viewed on 
computer's screen normally by partitioning the screen into multiple windows. Progress of 
different tasks is viewed on different windows in a multitasking system. 
 
Hence, for those who like to differentiate between multiprogramming and multitasking, 
multiprogramming is interleaved execution of multiple jobs (of same or different users) in 
a multi-user system, while multitasking is interleaved execution of multiple jobs (often 
referred to as tasks of same user) in a single-user system. Typically, computer systems used 
for such purposes are uni-processor systems (having only one CPU). Typically, computer 
systems used for such purposes are uni-processor systems (having only one CPU).  For 
example, Windows NT and OS/2 operating systems use this technique. 
 
3.5.4 Multithreading  
Threads are a popular way to improve application performance. In traditional operating 
systems, the basic unit of CPU utilization is a process. Each process has its own program 
counter, its own register states, its own stack, its own address space (memory area allocated 
to it). On the other hand, in operating systems, with threads facility, the basic unit of CPU 
utilization is a thread. In these operating systems, a process consists of an address space 
and one or more threads of control [see Figure 3.10(b)]. Each thread of a process has its 
own program counter, its own register states, and its own stack. However, all the threads of 
a process share the same address space. Hence, they also share the same global variables. 
In addition, all threads of a process also share the same set of operating system resources, 
such as open files, signals, accounting information, etc. Due to sharing of address space, 
there is no protection between the threads of a process. However, this is not a problem 
because process (and hence all its threads) is always owned by a single user. Therefore, 
protection between multiple threads of a process is not necessary. Protection between 
multiple processes is needed because different processes may belong to different users.  
 
Threads share a CPU in the same way as processes do. At a particular instance of time, a 
thread can be in anyone of several states - running, blocked, ready, or terminated. Due to 
these similarities, threads are often viewed as mini processes. In fact, in operating systems 
with threads facility, a process having a single thread corresponds to a process of a 
traditional operating system [see Figure 3.10(a)]. Threads are often referred to as 
lightweight processes and traditional processes are referred to as heavyweight processes. 
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Fig 3.10 (a) Single-threaded and (b) Multithreaded processes.  
 
 
Operating systems that allow different parts of software program to run concurrently. 
Operating systems that would fall into this category are: 

• UNIX 
• Windows2000 
• Windows95 
• Windows98 
• Windows NT 4.0 

--------------------------------------------------------------------------------------------------------- 
3.5 SOME POPULAR OPERATING SYSTEMS 
--------------------------------------------------------------------------------------------------------- 
3.5.1 Disk Operating System 
What is DOS and what do DOS mean? DOS is an acronym for Disk Operating System. 
Though this doesn't say exactly what DOS does it tells you what it is. An operating system 
is a program that is run on a computer that allows the user to communicate with it in a way 
the user understands. Imagine if you had to talk to the computer on its level! No one would 
want to work with computers if that were the case. 
 
DOS allows you to perform tasks on the computer by telling the computer what to do in 
terms of English like commands such as COPY and MOVE are infinitely better than 
10001110101110111! Designed for microcomputers (your PC is a microcomputer), DOS 
makes it easier for you to work with the information on your disks whether they are floppy 
disks or hard disks. But before we look deeper into how to use DOS we need to have a little 
background on how DOS looks at information on the computer. 
 
Rebooting the Computer: Sometimes it may happen that your system crashes down 
because of any reason. In This process is called Warm Boot or Reset. This will again get 
things going. But it is advisable to use it as a last alternative when all other efforts of 
resuming work fail. At times, Warm Boot also fails to restart the computer. This means the 
instructions that are given by the keyboard are no longer valid and are not interpreted by 
the system. In this case, switch off the power supply such a situation, hit < Ctrl + Alt + Del 
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> Keys together. This will restart your computer and wait for a few minutes. Then turn on 
the power supply and start working. Sometimes, due to unknown reasons the system is 
unable to boot from the hard disk, in such a situation, you are required to boot the system 
from the bootable floppy (floppy that contains DOS).  
 
Concept of Files and Directories:  File is a collection of related information. Any kind of 
text, data or program that is entered is stored in a file. Now, it is very essential to organize 
your files in an ordered manner. This makes file search easier. Otherwise, it can really be a 
difficult and time consuming job to search for a particular file out of the whole lot of files 
stored on the disk. An example of library can make the explanation of the concept clearer. 
As you must have already observed, the books in a library are put in big cabinets. Each 
cabinet is divided into many shelves and sub shelves. Each shelve or sub-shelve contains 
books on a particular subject. So, the required book on a particular subject can be found out 
very easily without wasting much time and effort.  
 
On similar grounds, all the files that are related to each other are clubbed at one place. This 
is known as a Directory Structure or simply a Directory. A directory structure resembles 
an inverted tree. The main directory becomes the Root directory. The directories and files 
become the branches of this directory tree. Any number of files and directories can be 
added to it, thus, making the tree grow big downwards. Let us take an example. Suppose 
we wish to store two kinds of files on our disk: ACCOUNT and EXPENSE. Further, we 
wish to keep two more kinds of files (say CASHSALE and CREDSALE) under 
ACCOUNT sub-directory. DOS can very much help you in organizing your files through 
directory structure. 
 

1. On the top of the directory structure, there is a Root directory. This directory is 
always present and is shown by \(backslash) for referencing. Any file or directory 
that is created is always under the Root directory. 

2. EXPENSE is the sub-directory of the Root directory.  
3. ACCOUNT is the parent directory of the directories CASHSALE and CREDSALE. 

It can also be said that the CASHSALE and CREDSALE are the sub-directories of 
the ACCOUNT directory. Thus, a directory under a directory is called a sub-
directory / (Root). 

• ACCOUNT EXPENSE 
• CASHSALE CREDSALE WEST.TXT 
• EAST.TXT 

It can be clearly seen that the files relating to a particular subject can be put under a 
directory. For example, all the files relating to expenses can be put under EXPENSE 
subdirectory whereas all the files relating to cash sales can be stored under the subdirectory 
CASHSALE. 
 
Referencing Files 
It’s time to learn as to how to locate a file. The directory structure has two sub-directories 
under the Root directory. The sub-directory EXPENSE has two files under it. DOS allows 
you to go from one directory to another by following a certain path. In the beginning, the 
user is always resident in the Root directory. While traveling from one directory to another 
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certain rules have to be followed. A user cannot go directly from ACCOUNT subdirectory 
to EXPENSE sub-directory. To go from one sub-directory to another, you have to first go 
to its parent directory or the Root directory. Thus, for going from ACCOUNT sub-directory 
to EXPENSE sub-directory, you first have to go to Root directory. Similarly for going from 
the file EAST.TXT to WEST.TXT, you have gone to the EXPENSE sub-directory first. 
Thus, in other words, while moving from one directory to another, you have to its parent 
directory first. Now, in order to reach out to the file WEST.TXT the following path has to 
be followed: 
 
C:\>Expense\West.txt 
1 2 3 4 5 
Here, 
1. Is the drive name where the file is resident in; 
2. Is the path which DOS takes to reach for a file; 
3. Is the directory under the Root; 
4. Is the primary name of the file that is to be accessed; 
5. Is the extension name of the same file. 
 
The \ (backslash) has to be used for tracing out the path. First backslash takes you to the 
Root directory. The subsequent backslashes separate the directories, sub-directories and the 
filename that are given in the whole path. File Naming Conventions There are certain rules 
that have to be followed while giving names to your files. A filename has two parts: 
 
1. Primary Name  
2. Extension (Secondary Name) 
 
A dot (.) separates a primary name from an extension. Let see the two parts of the file 
named DRAGON.TXT. A primary name cannot have more than eight characters and 
similarly an extension can contain only up to three characters. Filename having only the 
primary name and no extension is absolutely valid because it is absolutely optional to give 
an extension to a filename. An extension is generally given by language or software used 
by the file. For example, if you entering BASIC and PASCAL programs, their filenames 
would have extension BAS and PAS respectively. A filename can contain the following 
characters:  
 
1. An Alphabet (A-Z) or (a-z) 
2. A number (0-9) 
3. Special characters such as etc. 
Except *, ?, full stop (.) and space 
 
It is a good practice to give meaningful names to your files. However, no two files can have 
exactly the same name on disk. Thus, a name given to a file on a disk has to be unique. A 
look at a few valid and invalid filenames: 
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The rules for naming a directory are the same as that of naming files. 
 
Dos Commands: 
DOS offers a variety of commands to perform various functions. With the help of DOS 
commands, you can display the list of files and directories that are present on the disk, 
create new files and directories; remove unwanted files and directories and much more. 
DOS commands can be entered either in uppercase or lowercase letters. The format of a 
DOS command is called syntax. All DOS commands begin with command name. When 
DOS carries out the instructions given by you, is called the execution of DOS command. 
All DOS commands can be classified into two categories: Internal Commands and External 
Commands. 
 
Internal Commands 
The commands which are a part of the main files of DOS COMMAND.COM and two 
hidden files) are known as Internal Commands. They are loaded in the RAM as soon as the 
computer is switched on. The important internal commands are DIR, COPY, DEL, REN, 
MD, CD, RD, TYPE, COPY CON, DATE, TIME, CLS, ECHO, PROMPT and PATH.  
 
External Commands 
External commands are those commands, which are stored disks as separate program files. 
These files have the same primary name as the command name. The extension of these 
files is either COM or EXE. So, at the time of execution of these commands, the 
corresponding program file should be present in the DOS sub-directory of the hard disk and 
DOS sub-directory should also be in the path search. The commonly used external 
commands are- FORMAT, DISKCOPY, CHKDSK, XCOPY and LABEL. 
Let us discuss some of the important DOS commands in detail. 

• CD or CHDIR 
 
To change the directory path. 
Syntax 
CHDIR [drive:][path] 
or 
CD [drive:][path] 
Switches Used 
cd\ - Goes to the highest level the root of the drive. 
cd.. - Goes back one directory. For example if you are within  
C:\WINDOWS\COMMAND> directory this would take to C:\WINDOWS> 

http://www.studynama.com/?utm_source=pdf&utm_medium=downloaded_file&utm_campaign=studynama_referral


 60

 
CD windows - If present would take you into the Windows directory. Windows can be 
substituted with any other name. Example Suppose you are under the EXPENSE sub-
directory and you want to access the files or directories in the ACCOUNT subdirectory. 
This would involve the changing of directory from EXPENSE to ACCOUNT. This will 
make the ACCOUNT directory active. The task of changing directories can be 
accomplished with the help of CD command. Look at the following example: 
C:\>CD ACCOUNT <Enter> 
 
The above command will take you to the sub-directory ACCOUNT as shown by following 
prompt:  
 
C:\ACCOUNT> 
  
If you want to go to the sub-directory CASHSALE from the sub-directory EXPENSE, 
issue the following command: 
 
C:\>CD ACCOUNT\CASHSALE <Enter> 
 
After the above command, the following prompt C:\ACCOUNT\CASHSALE> 
  
The command for going to the root directory from prompt is: 
 
C:\ACCOUNT\CASHSALE>CD\ <Enter> 
But, the command for going to the parent or previous (whether it is root or subdirectory) is:  
C:\ACCOUNT\CASHSALE>CD.. <Enter> 
If you are in the sub-directory CASHSALE, the command will take you to ACCOUNT 
sub-directory below: 
C:\ACCOUNT> 
Suppose you are under the EXPENSE sub-directory want to access the files or directories 
in the ACCOUNT subdirectory. This would involve the changing of directory. 
 
EXPENSE to ACCOUNT. This will make the directory active. The task of changing 
directories accomplished with the help of CD command. Look following example: 
C:\>CD ACCOUNT <Enter> 
where CD stands for Change Directory 
The above command will take you to the sub-directory ACCOUNT as shown by following 
prompt: 
 
C:\ACCOUNT>- 
If you want to go to the sub-directory CASHSALE from the sub-directory EXPENSE, 
issue the following command: 
 
C:\>CD ACCOUNT\CASHSALE <Enter> 
 
After the above command, the following prompt  
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C:\ACCOUNT\CASHSALE>_ 
The command for going to the root directory from prompt is: 
 
C:\ACCOUNT\CASHSALE>CD\ <Enter> 
But, the command for going to the parent or previous 
(whether it is root or subdirectory) is: C:\ACCOUN-RCASHSALE>CD.. <Enter> 
If you are in the sub-directory CASHSALE, the command will take you to ACCOUNT 
sub-directory below: 
C:\ACCOUNT>- 
The command for displaying the name of the currently directory is: 
C:\>CD <Enter>  

• DIR 
Displays a list of files and subdirectories in a directory. 
 
Syntax 
DIR [drive:][path][filename] [/P] [/W] [/A[[:]attributes]] [/ 
O[[:]sort order]] [/S] [/B] [/L] [/V] 
 

 
Example 
dir = Lists all files and directories in the directory that you are currently in. 
 
dir /ad = List only the directories in the current directory. 
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dir /s = Lists the files in the directory that you are in and all sub directories after that 
directory, if you are at root “C:\>” and type this command this will list to you every file and 
directory that is on the computer. 
 
dir /p = If the directory has a lot of files and you cannot read all the files you can use this 
command and it will display all files one page at a time. 
 
dir /w = If you don’t need the info on the date / time and other information on the files you 
can use this command to list just the files and directories going horizontal taking as little as 
space needed. 
 
dir /s /w /p = This would list all the files and directories in the current directory and the sub 
directories after that in wide format one page at a time. 
 

•  COPY CON 
This command is used to create a file. 
 
Syntax 
Copy con <filename> 
Once you have entered the above command this will create the file by the name specified. 
Once you have typed all the lines you wish to be in the file press and hold CTRL + Z. This 
should enter ^Z, once on the screen press the enter and one file should be copied. 
 
Example 
C:\>copy con file1.txt 

• M D 
This command is used t make a directory. 
 
Syntax 
MD <directoryname> 
 
Example 
C:\>md dir1 
This will create a directory named dir1 under root. 

• COPY 
Copies one or more files to another location. 
 
Syntax 
COPY Source Destination 
Example 
copy *.* a: = This would copy all files in the directory currently in to the floppy disk in 
drive a: 
copy file1.txt c:\dir1\file2.txt = This would copy file1.txt to a directory dir1 under root 
with a different name file2.txt.  
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copy myfile1.txt+myfile2.txt = This command would copy the contents in myfile2.txt and 
combine it with the contents in  
myfile1.txt 

• DEL 
Deletes one or more files. 
 
Syntax 
DEL [drive:][path]filename 
Examples 
del test.tmp = Deletes the test.tmp in the directory that you currently are in, if the file 
exists. 
del c:\windows\test.tmp = Delete the c:\windows\test.tmp in the windows directory if it 
exists. 
del c:\windows\temp\*.* = (* is for wild character(s)) *.* indicates that you would like to 
delete all files in the c:\windows\temp directory. 
del c:\windows\temp\?est.tmp = (? is a single wild character for one letter) This command 
would delete any file ending with est.tmp such as pest.tmp or zest.tmp 

• EDIT 
Edit allows a user to view, create and or modify their computer files. The disadvantage of 
copy con is that you cannot modify a file. So we use edit. 
 
Syntax 
EDIT <filename> 
Example 
Using edit you can also create files, for example if you wanted to create a file called 
myfile.txt you would type:  
edit myfile.txt <press enter> 
This would bring up a blank edit screen, as long as the file is saved upon exit this will 
create the file myfile.txt.  

• MOVE 
Allows you to move files or directories from one folder to another or from one drive to 
another. 
 
Syntax 
MOVE source destination 
Example 
C:\>move file.txt c:\dir1\file1.txt 
This would move a file named file1.txt to directory dir1 with the same name. 

• REN OR RENAME 
Used to rename files and directories from the original name to a new name. 
 
Syntax 
Ren oldfilename newfilename 
Example 
C:\>ren file1.txt file2.txt 
This will change the name of file1.txt to file2.txt. 
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• CLS 
cls is a command that allows a user to clear the complete contents of the screen and leave 
only a prompt. 
 
Syntax 
cls 

• Format 
Format is used to erase all of the information off of a computer diskette or fixed drive. 
 
Syntax 
Format <drive> 
Example 
C:\>Format a: 
This will erase all the contents of the floppy disk inside floppy drive. 
 
3.5.2 UNIX 
UNIX was developed by some of the members of the Multics team at the bell labs starting 
in the late 1960’s by many of the same people who help created the C programming 
language. The UNIX today however is the not just the work of a couple of programmers. 
Many other organizations, institutes and various other individuals contributed significant 
additions to the system we now know to day. 
 
UNIX is primarily a command line oriented operating system you can get additional 
applications such as X-Window which allows you to have a graphic oriented operating 
system similar to Windows 3.x / Windows 95 / Windows 98. However while this is 
available UNIX is still primarily used from the command line. Because the UNIX 
operating system is an open operating system you will discover that there are various 
shells. A shell is a large add-on / modification of the UNIX operating system, to determine 
the shell you can type echo $shell at the UNIX prompt. When typing this you will receive a 
response such as / bin/csh which in this case indicates that the UNIX you are logged into is 
a C shell. Another popular shell is the Borne shell which is / bin/ sh and Korn shell that the 
UNIX you are logged into is a C shell. Another popular shell is the Borne shell which is / 
bin/sh and Korn shell. 
  
3.5.3 Linux 
Linux is an open- source operating system enhanced and backed by thousands of 
programmers worldwide. It is a multi tasking, multiprocessing operating system designed 
originally for use on personal computers. The name “Linux” is derived from its inventor 
Linus Torvalds. Torvalds was a student at the University of Helsinki, Finland in early 
1990s when he wrote the first version of an UNIX- like kernel as a toy project. He later 
posted the code on the Internet and asked programmers across the world to help him build 
it into a working system. The result was Linux. Torvalds holds the copyright but permits 
free distribution of source code. That is, he oversees development of kernel and owns its 
trademark. When someone submits a change or a feature, Torvalds and his core team of 
kernel developers review the merit of adding it to kernel source code. 
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3.5.4 Microsoft Windows  
 
It is a series of software operating systems and graphical user interfaces produced by 
Microsoft. It was developed by Microsoft to overcome the limitations of its own MS-DOS 
operating system. Microsoft first introduced an operating environment named Windows in 
November 1985 as an add-on to MS-DOS in response to the growing interest in graphical 
user interfaces (GUIs). Microsoft Windows came to dominate the world's personal 
computer market, overtaking Mac OS, which had been introduced previously. The most 
recent client version of Windows is Windows Vista; the most recent server version is 
Windows Server 2008. Vista's successor, Windows 7 (currently a release candidate), It is a 
family of operating systems for personal computers. Windows dominates the personal 
computer world, running, by some estimates, on 90% of all personal computers. The 
remaining 10% are mostly Macintosh computers. Like the Macintosh operating 
environment, Windows provides a graphical user interface (GUI), virtual memory 
management, multitasking, and support for many peripheral devices. Main Features of 
Microsoft Windows are as follows: 
 
Its native interface is a GUI. Hence, for a new user it is easier to learn and use a computer 
system. 
 
A Microsoft window was designed to be not just an operating system but also a complete 
operating environment. That is, all its programs conform to a standard way of working. For 
example, a Microsoft Windows word processor works similarly the way a Microsoft 
windows spreadsheet (or any other type of Windows program) works. This means that 
experience gained by learning one Windows program is useful while using any other 
Microsoft Windows program. 
 
It is single- user, multitasking operating system. That is, a user may run more than one 
program at a time. For example, while editing a file in foreground, a sorting job can be run 
in background. Monitor’s screen can be portioned into multiple windows and progress of 
different programs can be viewed on different windows. 
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Fig 3.11 Microsoft Windows 

 

3.5.5 Microsoft Windows NT 

 Windows NT is a family of operating systems produced by Microsoft, the first version of 
which was released in July 1993. It is an operating system developed by Microsoft for 
high-performance processors and networked systems. In 1993, when it was first released, 
Microsoft Windows NT was Microsoft's platform of choice for high-end systems. The 
current version, 4.0, is intended for use as a network server (NT Server) or a workstation 
(NT Workstation). Windows NT did not replace Windows 95. While Windows NT 
contains the Windows 95 interface, it is entirely 32-bit. 
 
Technical features of Windows NT 

• Interface  
o Contains the Windows 95 interface and features like the Start button, 

Taskbar, Explorer, Network Neighborhood, and Briefcase  
• Networking  

o NetWare client and login script support  
o Enhanced meta-file (EMF) spooling for improved network printing speed  
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o Support for 15 network protocols  
o Peer-to-peer and FTP server capabilities  
o Client software for both telnet and FTP services  

• Messaging Capabilities  
o Windows Messaging Subsystem  
o Microsoft Exchange and Microsoft Schedule+ included  
o WINCHAT, NET MESSAGE, or Net DDET  

• Remote Management  
o Remote management utilities such as Event Viewer, Performance Monitor, 

Service Controller, and Registry Editor  
o Dial-out capability to remote servers  
o Remote dial-in capability  

• Remote Access Services (RAS)  
o Internet access to Windows NT Server and DNS names for resource 

connections  
o Dial-out capability to remote servers, including Internet services  
o Remote dial-in ability to any workstation  
o Full network functionality over remote links using NetBEUI, IPX/SPX, and 

TCP/IP protocols  
o Dial-in capability to remote NetWare servers using RAS  
o Multi-link capability for channel aggregation of multiple modem 

connections  
• Security  

o Per-file and per-directory security with the NT file system (NTFS)  
o Local desktop security; user ID and password required for access  
o Account lockout capabilities to prevent unlimited login attempts  
o Network security with single network login using challenge/response 

protocol  
• Application Support  

o Native support for all applications based on Windows 95, Win32, 16-bit 
Windows, 16-bit MS-DOS, 16-bit OS/2, and POSIX 1003.1  

o Separate memory spaces for 16-bit applications (multiple virtual MS-DOS 
machines)  

o Preemptive multitasking for 16-bit and 32-bit applications  
o 486 emulator allows 386-enhanced 16-bit applications to run on RISC 

machines  
o OLE support between all 16-bit and 32-bit Windows based applications  
o Asynchronous I/O queue for improved responsiveness  
o Structured exception handling for easy troubleshooting  

• Graphics and Multimedia  
o Significant performance gains for graphic intensive applications  
o OpenGL APIs for high-performance three-dimensional color graphics  
o 16-bit and 32-bit API support for the Video for Windows 1.1 feature set  

• Utilities  
o File compression with NTFS  
o User Manager for configuration and security  
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o Disk Administrator for graphical disk configuration  
o Diagnostics utility that details basic system information  
o Performance Monitor for local and remote troubleshooting  
o Tape backup  
o Event Viewer and logging utility for local and remote troubleshooting  
o Long filename support on FAT and NTFS  
o Configuration details managed in registry database  

• Hardware Support  
o Multiple hardware configuration; you can specify a hardware profile at start 

time, including services, devices, and video resolutions  
o Intel, Alpha AXP, MIPS, and PowerPC platforms  
o Symmetric multiprocessing (SMP) support  
 

--------------------------------------------------------------------------------------------------------- 
3.6 REVIEW QUESTIONS 
--------------------------------------------------------------------------------------------------------- 

1. Discuss about the role of System Software? 
2. Comment on the role of Operating System as a System Software. 
3. What components are involved in determining the performance of computer 

system? 
4. What factors affect the performance of computer system? 
5. Explain the role of classifying criteria for the Operating Systems. 
6. Explain the working of Single User Operating Systems. 
7. Explain the working of Multi User Operating Systems. 
8. Explain the Concept of Multi Tasking 
9. List some of the Technical features of Microsoft Windows NT. 

 
 

http://www.studynama.com/?utm_source=pdf&utm_medium=downloaded_file&utm_campaign=studynama_referral


 69

 
-----------------------------------------------------------------------------------------
BUSINESS DATA PROCESSING  
-------------------------------------------------------------------------------------------------------- 

Structure 
 4.1 Data Processing 
 4.1.1 Types of Data Processing 
 
4.2 File Management System  
 4.2.1 File Types 
            4.2.2 File Organizations 
 4.2.3 File Utilities 
 
4.3 Database Management System 
 4.3.1 Data Base  
 4.3.2 Purpose of Database System  

 4.3.3 Database Management Systems (DBMS) 
 4.3.4 Database Models 
           4.3.4.1 Hierarchical Database 
           4.3.4.2 Network Model 
           4.3.4.3 Relational Model 
           4.3.4.4 Object-Oriented Model 
            4.3.5 Main Components of a DBMS  
                       4.3.5.1 Data Definition Language (DDL) 
            4.3.5.2 Data Manipulation Language (DML) 
 4.3.6 Creating and Using a Database 
            4.3.6.1 Creating a Database 
            4.3.6.2 Viewing, Modifying, Deleting and Adding Records 
            4.3.6.3 Searching For Desired Information 
 
4.4 Review Questions 
--------------------------------------------------------------------------------------------------------- 
4.1 DATA PROCESSING 
---------------------------------------------------------------------------------------------------------
Computer data processing is any computing process that converts data into information 
or knowledge. The processing is usually assumed to be automated and running on a 
computer. Because data’s are most useful when well-presented and actually informative, 
data-processing systems are often referred to as information systems to emphasize their 
practicality. Nevertheless, the terms are roughly synonymous, performing similar 
conversions; data-processing systems typically manipulate raw data into information, and 
likewise information systems typically take raw data as input to produce information as 
output. Data can be seen as a raw material, which is later converted to information. e.g. For 
a company that wants to produce Bornvita, such company will need to make use of cocoa, 
which means that cocoa is the raw material for the production of Bornvita, likewise data is 
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the raw material for information. Data has to pass through a specific process before it could 
be changed to information, and it is called a process. 

 
 

Fig 4.1 Data Processing Chart 
 
Data is a collection of facts - unorganized, but able to be organized into useful information. 
A collection of sales orders, employee time sheets, and class attendance cards are a few 
examples. Data can be manipulated to produce output, such as bills, employee salary slips, 
and student attendance reports. This output, called information, is an organized fact that 
helps people to make decisions. Hence, information is data arranged in an order and form 
that is useful to people who receive it. 
 
Processing, in general terms, is a series of actions or operations that converts some input 
into useful output. In data processing, input is data, and useful output is information. 
Hence, data processing is a series of actions or operations that converts data into 
information. It consists of three sub-activities - capturing input data, manipulating it, and 
producing output information. A data processing system includes resources such as 
people, procedures, and devices used to process input data for producing desirable output. 

4.1.1 Types of Data Processing 
Basically there are two types of data processing 
 
1. Batch Processing: With batch processing, changes and queries to file are stored for a 
period of time, and then a processing run is made periodically to update the file and to 
produce responses to the queries. Batch runs can be made on a scheduled basis, such as 
daily, weekly, or-monthly, or they can be made on an as required basis. 
 
Examples of batch processing include generation of mark-sheets of students. Mark-sheets 
and results of school examinations are given to students only at the end of an academic 
year. So, a programmer can develop a program for this and the results can he printed at the 
required time. 

 
2. Online or immediate processing: In immediate processing, transactions are processed 
to update the file immediately or shortly after a real-world event occurs. Information 
processing applications that use immediate processing are often called real time 
application. A real time application can immediately capture data about ongoing events or 
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processes and provide the information necessary to manage them. An airline-reservation 
system is an example of a real time application. 
 
Real time systems must have real time files that are updated immediately after the event 
occurs. Consequently, at any point in time, the data in real time files should accurately 
reflect the status of the real world variables they represent. For example, when a customer 
reserves a seat on an airline flight, the reservations agent keys in that fact and the inventory 
of non reserved seats on the flight is immediately changed to reflect one less available seat. 
Immediate processing requires direct-access files, since immediate processing with 
sequential files would be impractical because of the time required to search for individual 
records. Batch processing; on the other hand, can occur with either sequential or direct 
access files. 
 
Examples of immediate processing or interactive processing include air traffic and banking. 
In air traffic, as the flying speed increases control decisions have to be taken. Hence, data is 
raw material of information, and just as a manufacturing process transforms raw materials 
into more quickly. Therefore, interactive processing is the only suitable system for air 
traffic control. In banking, where a customer is at the counter and the time to update his 
bank account will naturally take more time if done by human, so a computer can give full 
updated details of the customer's account within seconds. For this, a customer' is given the 
wanted information mostly by interactive processing. 
 
--------------------------------------------------------------------------------------------------------- 
4.2 FILE MANAGEMENT SYSTEM  
--------------------------------------------------------------------------------------------------------- 
In file-oriented approach of organizing data, a set of programs is provided to facilitate users 
to organize, create, delete, update, and manipulate their files. All these programs together 
form a File Management System (FMS). Features found commonly in file management 
systems are described below. 
 
4.2.1 File Types 
Data files are categorized according to the way an application uses them. A file 
management system typically supports following types of files: 
 

1. Transaction File: A transaction file stores input data until it can be processed. For 
example, in a payroll application for generating monthly pay slips of employees, current 
month's transaction file contains this month's data of each employee, such as details of 
hours worked, normal and overtime hours, and if piecework is involved, quantity of 
goods made. 

2. Master File: A master file contains all current data relevant to an application. For 
example, in payroll application mentioned above, master file contains permanent details 
of each employee (name, address, employee-code, pay-rate, income-tax-rate, etc.), and 
also current gross-pay-to-date total and tax-paid-to-date total. When payroll program is 
processed, it consolidates both master and current month's transaction files to generate 
this month's pay-slips, and updates master file to make it ready for following month's 
processing. 
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3. Output File: Some applications use multiple programs for data processing. In such 
applications, output produced by one program is fed often as input to another program. 
Hence, output produced by former program is stored in a file known as output file, 
which is used later by the latter' program. 

4. Report File: A report file holds a copy of a report generated by a data processing 
application in computer-accessible form. A report file can be printed to obtain hard 
copy of the report whenever desired. It is advantageous to keep report files instead of 
paper documents because files are easier to store and carry. 

5. Backup File: A backup file is a copy of a file created as a safety precaution against 
loss of data due to corruption or inadvertent deletion of original file. Regular creation 
of backup files is extremely important. 

 
4.2.2 File Organizations 
File organization deals with physical organization of records of a file for convenience of 
their storage and retrieval. System designers choose to organize, access, and process 
records of various files in different ways, depending on application type and users' needs. 
Three file organizations used commonly in business data processing applications are 
sequential, direct/random, and indexed sequential. 
 
Selection of a particular file organization depends on application type. The best file 
organization for an application is one that meets the application's data access and 
processing requirements in the most effective and economical manner. Hence, an 
application designer must evaluate the strengths and weaknesses of each file organization, 
before making a choice of file organization type for the application 
 
File organization requires use of some key field in every record in a file. The key field 
value must be unique for each record of the file because duplications would cause serious 
problems. In payroll example, employee-code field may be used as the key field. 
 
4.2.3 File Utilities 
File utilities are routines to perform generalized operations on data files. Normally, they are 
quite general in nature in the sense that they can deal with different data formats and 
different types of storage medium. Operations performed by some commonly used file 
utilities are described below. 
 
Sorting: A file sorting utility is used to arrange records of a file in some defined sequence. 
Values of certain specified fields (known as keys) in each record determine this sequence. 
The simplest case of sorting is ordering of records in a file on a single key. For example, 
records of employee file in Figure 4.2 are sequenced by ascending order of employee-code. 
A more complex sorting would be ordering of records in a file on two or more keys. For 
example, records of employee file in Figure 4.3 are sequenced by ascending order of 
employee-code within department-code. This means that all records for the lowest 
department-code are listed first for each employee belonging to that department in 
ascending sequence of employee-code, then all records for next department-code, and so 
on. Out of these two keys used in this sorting example, department-code is called primary 
key, and employee-code is called secondary key, because order of sorting is employee-code 
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within department-code. 
 
A sorting utility enables users to specify their sequencing requirements for a file by means 
of input parameters. Input parameters such as size and number of keys, and type of 
ordering (ascending, descending) vary from one sorting utility to another. These parameters 
decide the extent and sophistication of sorting utilities. 
 
Sorting utility reads un-sequenced records of an input file, and by means of various 
copying techniques, ultimately produces an output file containing records of the input file 
ordered in desired sequence. 
 
Employee Code Department Code Other fields (Name, 

Address, Qualification, 
Basic Salary, etc) 

101 2 ----- 
123 3 ----- 
124 1 ----- 
176 2 ----- 
178 1 ----- 
202 3 ----- 
213 1 ----- 

 
Fig 4.2 Sorting on one key in ascending employee- code sequence 

 
 Employee Code Department Code Other fields (Name, 

Address, Qualification, 
Basic Salary, etc) 

124 1 ----- 
178 1 ----- 
213 1 ----- 
101 2 ----- 
176 2 ----- 
123 3 ----- 
202 3 ----- 

 
Fig 4.3 Sorting on two keys: Ascending employee - code (secondary key) within 

ascending department - code (primary key) 
 
Searching: A file searching utility is used to find a particular record in a file. Searching is 
carried out by matching the values of certain specified fields (known as keys) in each 
record with desired values. For example, in employee file of Figure 4.2, a user can specify 
value 202 for employee-code field to search corresponding employee's record. 
 
Efficiency of a search algorithm depends on file organization. For example, to search a 
particular records sequential file, records in the file are scanned sequentially, beginning 
with the first record, and specified key field value is compared one-by-one with the key 
field value of each record. Search process terminates when a record with matching key is 
found. On the other hand, direct or index sequential file organizations enable immediate 
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access to desired record with the help of either a hashing algorithm (in case of direct file 
organization) or an index file (in case of index sequential file organization). Users need to 
specify a file and key field value as input parameters to a search utility, which searches 
through the file and produces the desired record (s}. Normally, the time required for 
searching a particular record from a direct or index sequential file is much less, than the 
time required to search it from a sequential file. 
 
Merging: A file merging utility is used to combine records of two or more ordered (sorted) 
files into a single ordered file. Records of each of the input files must be sorted in same 
order, although their record layout need not be identical. A merging utility places records 
from each of the input files in their correct relative order, producing an output fill having 
all records in same order as input files. Figure 4.4 illustrates merging of two input files A 
and B to produce an output file C. 
 
Input file          Output file         Input file 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
      File A                                                                                                  File B 
 
                            
 
 
 
                                                             File C    

Fig 4.4 Merging of files A and B to produce file C 
 
Copying: A file copying utility is used to produce a copy of a file either from one unit of a 
storage device to another similar unit (such as from one tape reel or floppy disk to another), 
or from one storage medium to another (such as from tape to hard disk, or from CD-ROM 
to hard disk). 
 
File copying utilities are used often to take back-up copies of files. For example, a file may 
be copied from a hard disk to a tape or floppy for back-up purpose. File copying utilities 
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are also known as peripheral interchange programs (PIP) since they are used often to 
copy a file from one peripheral device to another. 
 
Printing: A file printing utility is used to print a file on a printer to produce hard copy of 
its contents. Printing utilities often provide facility to print file contents in different 
formats. They often provide some selection and editing facilities to enable printing of parts 
of files (such as specified number of records and only certain fields of records). Special 
printing facilities are often provided to print files that contain program instructions rather 
than data. 
 
Maintenance: A file maintenance utility is used to copy data from one or more files to a 
new file selectively, or to update a file's contents selectively. For example, a file 
maintenance utility may provide features to combine data from more than one file into a 
single file, delete records in a file identified by record key values or record count, and 
select specific fields of records to be copied from an existing file to a new file. 
 
--------------------------------------------------------------------------------------------------------- 
4.3 DATABASE MANAGEMENT SYSTEM 
--------------------------------------------------------------------------------------------------------- 
 
4.3.1 Data Base  
A database can be defined in various ways, for example 
 

• A database is a collection of structured data. The structure of the data is 
independent of any particular application. 

 
• A database is a file of data; structured  in such a way  that it may serve a  

number of applications  without its structure being  dictated by any one of those 
applications, the concept being that programs are written round the database 
rather than files being structured to meet the needs of  a particular programs 

 
The centre of any information system is its database, which is a collection of the data 
resources of an organization designed to meet the requirements of the company for 
processing and retrieving information by decision makers. One important use of database is 
to target more precisely marketing efforts. In the USA the later trend in management 
information systems is the executive information system which is used by senior managers. 
 
A database can be termed as a repository of data. A collection of actual data which 
constitutes the information regarding an organization is stored in a database. For example, 
there are 1000 students in a college & we have to store their personal details, marks details 
etc., these details will be recorded in a database. 
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A collection of programs that enables you to store, modify, and extract information from a 
database is known as Data Base Management System (DBMS).The primary goal of a 
DBMS is to provide a way to store & retrieve  database information that is both convenient 
& efficient.  
 
Database systems are designed to manage large bodies of information. Management of data 
involves both defining structures for storage of information & providing way for 
manipulation of data. In addition, the database system must ensure safety of data. 
 
Good data management is an essential prerequisite to corporate success. 
 
Data                         Information 
 
Information                                       Knowledge 
 
Knowledge                                        Judgment 
 
Judgment                                           Decision 
 
Decision                                            Success 
 
Provided that data is: 
 

• Complete; 
• Accurate; 
• Timely; and 
• Easily available 

 

4.3.2 Purpose of Database system  
A file system is one in which we keep the information in operating system files. Before the 
evolution of DBMS, organizations used to store information in file systems. A typical file 
processing system is supported by a conventional operating system. The system stores 
permanent records in various files & it need application program to extract records, or to 
add or delete records.  

Actual data 
Storage 
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We will compare both systems with the help of an example. 
 
There is a saving bank enterprise that keeps information about all customers & saving 
accounts. Following manipulations has to be done with the system 
 

• A program to debit or credit an account 
• A program to add a new account. 
• A program to find balance of an account. 
• A program to generate monthly statements. 

 
As the need arises new applications can be added at a particular point of time as checking 
accounts can be added in a saving account. Using file system for storing data has got 
following disadvantages:- 
 
1. Data Redundancy & Inconsistency:- 
Different programmer’s works on a single project, so various files are created by different 
programmers at some interval of time. So various files are created in different formats & 
different programs are written in different programming language.  
 
Same information is repeated. For ex name & address may appear in saving account file as 
well as in checking account. This redundancy results in higher storage space & access cost. 
It also leads to data inconsistency which means that if we change some record in one place 
the change will not be reflected in all the places. For ex. a changed customer address may 
be reflected in saving record but not any where else. 
 
2. Difficulty in accessing data:- 
Accessing data from a list is also a difficulty in file system. Suppose we want to see the 
records of all customers who has a balance less than $10,000, we can either check the list & 
find the names manually or write an application program .If we write an application 
program & at some later time, we need to see the records of customer who have a balance 
of less than $20,000, then again a new program has to be written. 
 
It means that file processing system do not allow data to be accessed in a convenient 
manner. 
 
3. Data Isolation:- 
As the data is stored in various files, & various files may be stored in different format, 
writing application program to retrieve the data is difficult. 
 
4. Integrity Problems 
Sometimes, we need that data stored should satisfy certain constraints as in a bank a 
minimum deposit should be of $100. Developers enforce these constraints by writing 
appropriate programs but if later on some new constraint has to be added then it is difficult 
to change the programs to enforce them. 
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5. Atomicity Problems 
Any mechanical or electrical device is subject to failure, and so is the computer system. In 
this case we have to ensure that data should be restored to a consistent state. For example 
an amount of $50 has to be transferred from Account A to Account B. Let the amount has 
been debited from account A but have not been credited to Account B and in the mean 
time, some failure occurred. So, it will lead to an inconsistent state. 
 
So, we have to adopt a mechanism which ensures that either full transaction should be 
executed or no transaction should be executed i.e. the fund transfer should be atomic. 
 
 
6. Concurrent access Problems 
Many systems allow multiple users to update the data simultaneously. It can also lead the 
data in an inconsistent state. Suppose a bank account contains a balance of $ 500 & two 
customers want to withdraw $100 & $50 simultaneously. Both the transaction reads the old 
balance & withdraw from that old balance which will result in $450 & &400 which is 
incorrect. 
 
7. Security Problems 
All the user of database should not be able to access all the data. For example a payroll 
Personnel needs to access only that part of data which has information about various 
employees & are not needed to access information about customer accounts. 
 

Table 4.1 Comparison of File Management Systems with Database Systems 
 

File Management Database Management 
Examples:-C++, VB or COBOL 
program Examples:-  Postgres, Oracle 

Small systems Large systems 
Often PC based Mini-Mainframe 
Relatively cheap Relatively Expensive 
Few 'files' Many 'files' 
Files are files Files not necessarily files 
Simple structure Complex structure 
Little preliminary design Vast preliminary design 
Integrity left to application programmer Rigorous inbuilt integrity checking 
No security Rigorous security 

Simple, primitive backup/recovery Complex & sophisticated 
backup/recovery 

Often single user Multiple users 
 
Files tend to contain duplication. Therefore they are susceptible to a loss of INTEGRITY 
if all files are not updated at the same time. Programs are bound to a file. If a files 
structure is modified then all programs that access it need to be modified. Thus alterations 
to file structures are difficult and expensive. 
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Data base systems originated in the late 1950s and early 1960s largely by research and 
development of .IBM Corporation. Most developments were responses to needs of 
business, military, government and educational institutions which are complex 
organizations with complex data and information needs.  
 
4.3.3 Database Management Systems (DBMS) 
This is the interface between the users (application programmers) and the database (the 
data). A database is a collection of data that represents important objects in a user's 
business. A database management system (DBMS) is a program that allows users to define, 
manipulate, and process the data in a database in order to produce meaningful information. 
 
DBMS is collection of programs that enables you to store, modify, and extract important 
information from a database. There are many different types of DBMS, ranging from small 
systems that run on personal computers to huge systems that run on mainframes. 
 

 
 

Fig 4.5 Data Base Management System 
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Following are the examples of DBMS: 
 

• Computerized library systems 
• Automated teller machines 
• Flight reservation systems 
• Computerized parts inventory systems 

 
A database contains a no. of files & certain programs to access & modify these files. But 
the actual data is not shown to the user; the system hides actual details of how data is stored 
& maintained. 
 
4.3.4 Database Models 
We saw that multiple related files are integrated together to form a database. A database 
model defines the manner in which various files of a database are linked together. Four 
commonly used database models are hierarchical, network, relational, and object-oriented. 
Also known as database structures or database structuring techniques, they are briefly 
described below.  
 
4.3.4.1 Hierarchical Databases 
The hierarchical data model organizes data in a tree structure. There is a hierarchy of 
parent and child data segments. This structure implies that a record can have repeating 
information, generally in the child data segments. Data are in a series of records, which 
have a set of field values attached to it. It collects all the instances of a specific record 
together as a record type. These record types are the equivalent of tables in the relational 
model, and with the individual records being the equivalent of rows. To create links 
between these record types, the hierarchical model uses Parent Child Relationships. These 
are a 1: N mapping between record types. This is done by using trees, like set theory used 
in the relational model, "borrowed" from mathematics. For example, an organization might 
store information about an employee, such as name, employee number, department, salary. 
The organization might also store information about an employee's children, such as name 
and date of birth. The employee and children data forms a hierarchy, where the employee 
data represents the parent segment and the children data represents the child segment. If an 
employee has three children, then there would be three child segments associated with one 
employee segment. In a hierarchical database the parent-child relationship is one to many. 
This restricts a child segment to having only one parent segment. Hierarchical DBMSs 
were popular from the late 1960s, with the introduction of IBM's Information Management 
System (IMS) DBMS, through the 1970s.  

For example, in Figure 4.6 employees are categorized by their department, and within a 
department, they are categorized by their job function, such as managers, engineers, 
technicians, and support staff. If personnel department faces shortage of support staff on a 
day, producing a list of all support staff, to take a decision to use some support staff from 
other departments for this department, would not be directly possible.  Instead, support 
staff assigned to each department would have to be determined department-by-
department. 
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Fig.4.6. An example of a hierarchical database. 
 
 
4.3.4.2 Network Model 
In the network model of a database it is possible for a record to have multiple parents, 
making the system more flexible compared to the strict single-parent model of the 
hierarchical database. The model is made to accommodate many to many relationships, 
which allows for a more realistic representation of the relationships between entities. Even 
though the network database model enjoyed popularity for a short while, it never really 
lifted of the ground in terms of staging a revolution. It is now rarely used because of the 
availability of more competitive models that boast the higher flexibility demanded in 
today’s ever advancing age. In 1971, the Conference on Data Systems Languages 
(CODASYL) formally defined the network model. The basic data modeling construct in 
the network model is the set construct. A set consists of an owner record type, a set name, 
and a member record type. A member record type can have that role in more than one set; 
hence the multi parent concept is supported. An owner record type can also be a member or 
owner in another set. The data model is a simple network, and link and intersection record 
types (called junction records by IDMS) may exist, as well as sets between them. Thus, the 
complete network of relationships is represented by several pair wise sets; in each set some 
(one) record type is owner (at the tail of the network arrow) and one or more record types 
are members (at the head of the relationship arrow). Usually, a set defines a 1: M 
relationship, although 1:1 is permitted. The CODASYL network model is based on 
mathematical set theory.  

Figure 4.8 shows an example of a network database maintaining relationships among 
courses offered and students enrolled for each course in a college. Notice that parent and 
child elements can have many-to-many relationships. That is, each student may be enrolled 
for several courses, and each course may have a number students enrolled for it. With this 
database structure used for this example, both course-wise-student report ( a report showing 
all students enrolled for each course) and student-wise-course report (a report showing all 
courses taken by each student) can be produced easily. For example, it is easy to tell from 
the figure that in this semester, the students enrolled for Mathematics course are Seeta, 
Geeta, Ram, and Sohan; and Geeta has taken three courses Hindi, Mathematics, and 
Computer Science. 
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.   

(a) 

 

(b) 

Fig 4.7 Hierarchical Model 
 
The example also shows a child element that has no parent element (student named Raju - 
he might be a research student who has not taken any course in this semester). 
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A child element can have more than one parent element    
                This child element has no parent element 
 

Fig 4.8 An example of a network database 

 

Fig 4.9 Network Model 

4.3.4.3 Relational Model 
A database based on the relational model developed by E.F. Codd. A Relational database 
allows the definition of data structures, storage and retrieval operations and integrity 
constraints. In such a database the data and relations between them are organized in tables. 
A table is a collection of records and each record in a table contains the same fields.  

Relational databases (RDBMS) are entirely unique when compared to the aforementioned 
models as the design of the records is organized around a set of tables (with unique 
identifiers) to represent both the data and their relationships. The fields to be used for 
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matching are often indexed in order to speed up the process and the data can be retrieved 
and manipulated in a number of ways without the need to reorganize the original database 
tables. Working under the assumption that file systems (which often use the hierarchical or 
network models) are not considered databases, the relational database model is the most 
commonly used system today. While the concepts behind hierarchical and network 
database models are older than that of the relational model, the latter was in fact the first 
one to be formally defined.  

Properties of Relational Tables: 
 Values Are Atomic  
 Each Row is Unique  
 Column Values Are of the Same Kind  
 The Sequence of Columns is Insignificant  
 The Sequence of Rows is Insignificant  
 Each Column Has a Unique Name  

 

 
 

Fig 4.10 Relational Model 

4.3.4.4 Object-Oriented Model 
After the relational DBMS soared to popularity, the most recent development in DMBS 
technology came in the form of the object-oriented database model, which offers more 
flexibility than the hierarchical, network and relational models put together. Under this 
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model, data exists in the form of objects, which include both the data and the data’s 
behavior. Certain modern information systems contain such convoluted combinations of 
information that traditional data models (including the RDBMS) remain too restrictive to 
adequately model this complex data. The object-oriented model also exhibits better 
cohesion and coupling than prior models, resulting in a database which is not only more 
flexible and more manageable but also the most able when it comes to modeling real-life 
processes. A major benefit of this approach is the unification of the application and 
database development into a seamless data model and language environment. As a result, 
applications require less code, use more natural data modeling, and code bases are easier to 
maintain. Object developers can write complete database applications with a modest 
amount of additional effort. 

However, due to the immaturity of this model, certain problems are bound to arise, some 
major ones being the lack of an SQL equivalent as well as lack of standardization. 
Furthermore, the most common use of the object oriented model is to have an object point 
to the child or parent OID (object I.D.) to be retrieved; leaving many programmers with the 
impression that the object oriented model is simply a reincarnation of the network model at 
best. That is, however, an attempt at the over-simplification of an innovative technology.  

In contrast to a relational DBMS where a complex data structure must be flattened out to fit 
into tables or joined together from those tables to form the in-memory structure, object 
DBMSs have no performance overhead to store or retrieve a web or hierarchy of 
interrelated objects. This one-to-one mapping of object programming language objects to 
database objects has two benefits over other storage approaches: it provides higher 
performance management of objects, and it enables better management of the complex 
interrelationships between objects. This makes object DBMSs better suited to support 
applications such as financial portfolio risk analysis systems, telecommunications service 
applications, World Wide Web document structures, design and manufacturing systems, 
and hospital patient record systems, which have complex relationships between data.  

These applications include computer aided design (CAD), computer-aided engineering 
(CAE), computer-aided manufacturing (CAM), computer-aided software engineering 
(CASE), expert systems, and multimedia systems. Some key features required for effective 
modeling of these applications, that are absent in conventional database models, are: 
 
1. Ability to model complex nested entities, such as design and engineering objects, and 
multimedia documents. Conventional database models do not provide mechanisms, such as 
configuration management, to represent and manage such entities. 
 
2. Support for general data types found in object-oriented programming languages. 
Database management systems based on conventional database models support only a 
limited set of atomic data types, such as integer, string, etc. They do not even allow storage 
and retrieval of long unstructured data, such as images, audio, and textual documents.  
 
3. Support for proper match between object-oriented programming languages and database 
languages. A database application is normally implemented by using some conventional 
programming language (such as COBOL, PASCAL, C, or C++), and some database 
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languages (data definition language, data manipulation language, query language) that are 
part of database management system. With popularity of object-oriented paradigm, use of 
object-oriented programming languages for implementing applications has become a 
common practice. However, database languages used in database management systems for 
conventional database models do not use object-oriented concepts for implementing 
applications. This mismatch between object-oriented programming languages and database 
languages used in database management systems for conventional database models makes 
database implementation of many applications inconvenient. 
 
Object-oriented database model was introduced to overcome these shortcomings of 
conventional database models. An object-oriented database is a collection of objects 
whose behavior, state, and relationships are defined in accordance with object-oriented 
concepts (such as object, class, class hierarchy, etc.). An object-oriented database 
management system allows definition and manipulation of an object-oriented database. 
 
Figure 4.11 shows an example of an object-oriented database structure. Class Vehicle is 
root of a class composition hierarchy including classes Vehiclespecs, Company, and 
Employee. Class Vehicle is also root of a class hierarchy involving classes Two Wheeler 
and Four Wheeler. Class Company is, in turn, root of a class hierarchy with subclasses 
Domestic Company and Foreign Company. It is also root of a class-composition hierarchy 
involving class Employee. 
            

 
Fig 4.11 An example of an object-oriented database structure 
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Class/subclass link                Attribute/domain link 
--------------------------------------------------------------------------------------------------------- 
TW               Two Wheeler 
FW    Four Wheeler 
DC    Domestic Company      
FC    Foreign Company 
Com    Company 
Emp    Employee       
--------------------------------------------------------------------------------------------------------- 
  
4.3.5 Main Components of a DBMS 
A DBMS allows users to organize, process, and retrieve selected data from a database, 
without any need to know about underlying database structure (organization and location of 
data). Four major components of a DBMS are: 
 
1. Data Definition Language (DDL) 
2. Data Manipulation Language (DML)  
3. Query Language 
4. Report Generator 
 
These are described below. 
 
4.3.5.1 Data Definition Language (DDL) 
Data definition language (DDL) is used to define the structure of a database. Database 
structure definition (also known as database schema) typically includes the following: 
 

1. Definition of all data elements to be included in the database. 
2. Organization of data elements (fields) into records (or tuples), tables, etc. 
3. Definition of field name, field length, and field type for each data element. Field 

name is used to refer to a data element while accessing it. Field length is used to 
define maximum size of a data element (such as employee-name field may have a 
maximum size of 30 characters). Common field types are: 

• Numeric: Can contain numbers formed with digits 0 to 9, a decimal point, and a + 
or – sign 
• Alphanumeric: Can contain a combination of alphabetic characters, special 
symbols, and digits 
• Logical: Can contain one of two possible values - Yes/No or True/False 
• Date/time: Can contain a single date, time, or date-time value 
• Memo: Can contain any type of data that user might like to type Binary: Can 
contain binary data 
 

4. Definition of controls for fields that can have selective values only. For example, in 
an employee database, sex field can have controls to accept values M or F only. 
Similarly, age field can have controls to accept values 18 or more and less than 70 
only. Such controls ensure correctness of entered data to some extent. 

5. Definition of access controls to various tables, records, and fields for different 
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categories of users to  protect sensitive data items from unauthorized users. 
6. Definition of logical relationships among various data elements of database. 

 
In short, virtually everything about a database structure is included in its schema. It is 
possible to generate a complete description of a database from its schema. Systems analysts 
use this description for defining new applications on the database 
Database systems are installed and coordinated normally by individuals called database 
administrators. They are responsible for following aspects of database administration 

1. Establish and control data definitions and standards. 
2. Determine relationships among data elements. 
3. Design database security system to guard against unauthorized use of data in the 

database. 
4.  Train and assist applications programmers in use of database. 

 
A data dictionary is developed and used in a database to document and maintain data 
definitions. It is created/updated automatically by DDL module of DBMS as database 
schema is defined / changed. 
 
4.3.5.2 Data Manipulation Language (DML) 
Once structure of a database (database schema) has been defined, it is ready for entry and 
manipulation of data. Data manipulation language (DML) includes commands to enable 
users to enter and manipulate data. With these commands, users can add new records to 
database, navigate through existing records, view contents of various fields of a record, 
modify contents of one or more fields of a record, delete an existing record, and sort 
records in desired sequence. 
In some DBMS, data definition language and data manipulation language are combined 
together, while in others, they are supported as separate DBMS components. 
 
Query Language 
Although it is possible to navigate through a database one record at a time to extract 
desired information from the database, this approach can be very inefficient and frustrating 
when there are thousands of records and several files in the database. Hence, all database 
management systems provide a query language enabling users to define their requirements 
as queries for extracting desired information from a database. For example, for an 
inventory database, a user may be interested in such information as "list item description 
and vendor name for all items whose current inventory level is less than 20 units", or "list 
stock number and item description for all items with a profit margin greater than 25%". A 
query language enables proper formulation of queries for extraction of such information 
from a database. 
 
Earlier, each database management system had its own query language. In this approach, 
queries developed for one DBMS could not be used with other DBMSs. However, 
eventually one query language, called SQL (pronounced "S-Q-L"), emerged as an industry 
standard. It was originally developed by IBM and was based on an earlier query language 
called SEQUEL, an acronym for "Structured English QUEry Language". Today, SQL is 
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the standard Structured Query Language used in many DBMSs. 
A query language can be easily learnt by a non-programmer. This enables normal users of a 
database to obtain desired information from the database without the help of any 
programmer 
 
Report Generator 
A report is presentation of information extracted from a database. Report generators 
enable users of a database to design the layout of a report in desired format. This means 
that that users can specify proper spacing between data items to be presented in a report, 
and can also include suitable report titles and subtitles, column heading, page numbers, 
separation lines, and other elements making a report more readable and presentable. Report 
generators can also be instructed to perform arithmetic operations (such as calculating 
subtotals and totals) on data found in numeric fields to make a report more meaningful and 
useful. 
 
4.3.6 Creating and Using a Database 
In this section, we will take a closer look at how a database is created and used. Large 
databases on large computer systems are created and maintained normally by professional 
programmers. Users of these databases, however, need not be programmers. They can be 
used easily by non-programmers to access data and produce reports. On the other hand, 
many database management systems, designed for personal computer systems, enable 
nonprogrammers to not only use, but even tolerate their own databases. These databases 
normally are simple in structure and small in size. 
 
4.3.6.1 Creating a Database 
Creation of a database is a three steps process: 
1. Defining its structure (schema) 
2. Designing forms (custom screens) for displaying and entering data  
3. Entering data into it  
These steps are described below 
 
Schema Definition 
First thing we do to set up a database is to define its structure (schema definition). This is 
done by identifying characteristics of each field in it. A good way to begin defining schema 
of a database is to list down on paper all fields to be included in the database, and then to 
determine the name, type, and size of each field. This information is then captured into the 
system by using a tool called schema builder. Schema builder enables a user to define a 
database schema interactively by prompting the user to enter name, type, size, etc. for each 
field. 
 
While defining the schema of a database, it is important to consider possible future needs 
and needs of all types of users of the database. That is, all possible fields that may be 
needed should be included in database structure while defining it. Although it is possible to 
modify database structure at any time, making such modifications is a time-consuming 
process. Hence, it is always better to carefully design a database in first instance, and 
minimize need to modify its structure later. 
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Fig 4.12 A typical database form used for data entry 
 

EMPLOYEE DATABASE DATA ENTRY FORM 

EMPLOYEE 
ID: 856392

SEX: 
M

AGE: 
48

EMPLOYEE NAME:  LAST NAME:    
        
     FIRST NAME:      
 
                             
     MIDDLE NAME: 

SINHA 

PUNIT 

KUMAR 

CONTACT ADDRESS:   ADDRESS1:     
       
      ADDRESS2:      
 
                             
      CITY:      
     
      STATE:  
 
 
   
                           POSTAL CODE: 

F/8, ANAND PARK 

SOCIETY, AUNDH 

PUNE 

MH 

411007 

TELEPHONE 
NO.: (020) 5680-4892 

ANY OTHER INFORMATION: 
IS FLUENT IN JAPANESE LANGUAGE 
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Designing Forms 
After defining the structure of a database, next step is to design forms (custom screens) for 
convenient data entry. Each form displays a set of fields of database structure with 
appropriate amount of blank spaces against each to enable data entry in those fields. Figure 
4.12 shows such a form. 
 
To facilitate easier data entry, often forms are designed with several fancy features, such 
as: 
l. A list-box for a field listing the options from which users can select a choice. For 
example, in Figure 4.10, SEX field may have a list-box listing options "Male" and 
"Female," and users simply select appropriate option for an employee. Depending on a 
user's selected option, system enters "M" or "F" automatically in SEX field. Similarly, 
STATE field may have a list-box listing all states, from which users can select appropriate 
option for an employee's address. 
 
2. Simple validation checks defined for a field to ensure correctness of entered data to some 
extent. For example, in Figure 4.10, a validation check may be defined for POSTAL CODE 
field to accept only six numeric characters. With this, the field will not accept less than or 
more than six characters, and will also not accept alphabetic or special characters. 
Similarly, a validation check may be defined for AGE field-to accept values in the range 18 
to 70 only (both inclusive). Validation checks can be used also to force a certain character 
position of a field to be a letter or numeral. 
 
3. Automatic conversion of typed characters to upper-or lower-case. For example, in Figure 
4.10, this feature may be used with STATE field. Hence, the system will accept 
"mh","Mh";"mH" or "MH'; for state code of Maharashtra, and will convert the entry to 
"MH" automatically. This feature greatly eases data entry and ensures uniformity of data. 
 
4. Automatic formatting of certain fields. For example, in Figure 4.10, this feature can be 
used with TELEPHONE NO field to display the value of this field automatically in 
specified format (with parentheses, space, and hyphen). That is, to enter telephone number 
"(020) 5680-4892", user only needs to type "02056804892", and the system displays "(020) 
5680-4892" in that field automatically. 
 
Entering Data 
After forms have been designed, the database is ready for entry of data. Data is entered one 
record at a time. To enter data, a user issues a command that calls up and displays 
appropriate form with blank fields. The user then keys in data for each field in appropriate 
spaces. In this manner, the user enters data for first record, then for second record, and so 
on. In most database systems, records are assigned a number automatically as they are 
entered. 
 
While entering data into fields, the Tab or Enter key is used usually to move to next field. 
Pressing Enter or Tab key in last field of the form saves the record in database and moves 
to a new, blank form for next record's data entry. In addition to using the Tab or Enter key 
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to move forward through fields one can call directly go to any field on the form by c1icking 
on it with mouse. 
 
4.3.6.2 Viewing, Modifying, Deleting and Adding Records 
All database systems provide commands to add, delete, view, or modify records of a 
database. Command for viewing a record only enables users to display data in various 
fields of a record in same screen format as that used for data entry. Users can specify a 
record to be displayed by specifying its key field value. Database systems usually also 
provide flexibility to users to move between records for viewing different records, such as 
"go to first record", "go to previous record", "go to next record", and "go to last record". 
 
Many database systems also provide facility to set up filters, which allow users to browse 
through and view those records only that meet some criterion. For example, in employee 
database created by using the form of Figure 4.10 if a user wants to view records of female 
employees only, the user can set a filter for "Sex" field, and only records containing "F" in 
that field will be displayed. Note that while a filter is set, the user cannot access records 
that do not meet the filter criteria. Filters provide a quick and convenient way to narrow 
down the number of records with which users have to work. 
 
Command for modifying a record enables users to not only view, but also update data in 
various fields of a record. To modify contents of a particular field of a record, the record is 
displayed first, then cursor is positioned in the field at appropriate character position 
where change is to be made by clicking mouse there, and then contents of the field is 
edited appropriately. Data in any other field of the record can be edited similarly. Finally, 
Enter key has to be pressed for changes to take effect. Some database systems may prompt 
the user to confirm the changes made, before effecting the changes and allowing the user 
to move to another record. 

 
Command for deleting a record enables users to remove records from a database. To delete 
a record, a user first selects the record, either by specifying its key field value, or by using 
the facility to move between records just as is done in case of viewing a record. The user 
then uses delete command, to delete the record. Most database systems prompt the user to 
confirm deletion of the selected record before deleting it. This feature prevents deletion of a 
record by mistake. 
 

Command for adding a record enables users to add new records to a database. When this 
command is enabled, the system displays a blank form and waits for a user to enter data. 
The user then keys in data for each field in appropriate spaces, and finally presses Enter or 
Tab key, after keying data in last field to save the record. On doing this, the system 
displays a new blank form for next record's data entry. If no more records are to be added, 
the user uses mouse to select the option to terminate the process for adding new records. 
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4.3.6.3 Searching for Desired Information 
 
A database management system enables its users to quickly search for desired information 
from large volume of data stored in a database with great ease. Features supported 
commonly in modem database systems for this are: 
 

1. Find command 
2. Query language 
3. Query by Example (QBE) 
 

These features are described below. 
 
Find Command 
Find command is used for simple database queries, like searching for records having a 
particular string pattern in a field. For example, in employee database created by using the 
form .of figure 4.10, Find command may be used to list records of all employees whose last 
name is "SINHA". Similarly, it may be used to list records of all employees who belong to 
the city of "PUNE". 
 
To use Find, a user has to type the string pattern to be searched and then has to indicate 
which field to search in. For instance, in the example above, user has to type "SINHA" and 
indicate that this string has to be searched in the "LAST NAME" field. User can specify 
either a single field or all fields. 
 
Find command cannot be used for creating an elaborate set of criteria for complex queries. 
Furthermore, it can operate only on one table at a time, and a user cannot save a specified 
criterion for future use. 
 
Query Language 
For handling complex queries, all database systems support a query language. Most of 
these query languages conform to the SQL standard. In SQL, a user has to specify criteria 
for search along with the fields and table (or tables) with which to work with. Criteria for 
search can be built by using relational operators (= [equal to], > [greater than], < [less 
than], and combinations of these operators), and logical operators (AND, OR, and NOT). 
For example, to list names of all employees whose last name starts with letter "S", who 
belong to "PUNE", and whose age is more than 40 years, SQL query looks as follows: 
 
SELECT [LAST NAME], [FIRST NAME], [MIDDLE NAME]  
FROM Employee 
 
WHERE ([LAST NAME] = "S...”) AND (CITY = "PUNE") AND ([AGE> 40)) 
 
Keywords SELECT, FROM, and WHERE tell SQL engine how to interpret each part of 
the query statement. SELECT keyword tells SQL which fields are to be displayed for 
records that match the criteria. FROM keyword tells SQL which table(s) to work with. 
WHERE keyword tells SQL the criteria for selecting records (search criteria). Brackets [...] 
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around some field names are needed in the example above because these field names 
contain spaces, and brackets help the database to interpret each field name correctly. 
 
A query language can be learnt and used easily even by a non-programmer, because 
complexity of a query language statement is more or less of same order as given in the SQL 
statement above. Furthermore, a query language uses a few keywords only that are easy to 
remember and use. In fact, SQL has a few dozen or so basic keywords only. 
 
Other advantages of using a query language are that a query statement can be used for 
creating an elaborate set of criteria for complex queries, it can operate on multiple tables at 
a time, and specified criteria can be saved for future use. 
 
Query By Example (QBE) 
 
Although query languages are easy to learn and use, many database developers further 
simplify the job of specifying search criteria. For this, they provide a simpler user interface 
(called front end) to query language. A database user specifies facts about a query by using 
this interface and a query language builder composes query language statements 
automatically from the facts. Front end usually consists of a form (called QBE form), and a 
user specifies a search criteria simply by inputting values into the fields of this form. Again 
values may be input either by typing them or by selecting an option from a set of options 
provided for a particular field, depending on how the front end has been designed to work. 
 
QBE form is designed to collect all necessary information from a user for composing query 
language statement(s) for search criteria. Once the user completes the QBE form, QBE 
engine converts user inputs automatically into suitable query language statement(s) for 
search processing. Hence, the user is relieved of remembering query language keywords 
and using them with correct syntax to. Form queries. This front-end feature is called query 
by example (QBE). It is very useful for many database users, especially beginners. 
 
Creating Reports 
Users of a database system can use report generator to assemble output of a database query 
in desired format. For this, a user creates a report specifying the layout of display (or 
printout) of fields requested by the user in the query. Users can also specify titles and 
subtitles for a report, column headings for various fields, and other elements, to make the 
output appear more presentable. Furthermore, users can even specify sorting parameters to 
obtain sorted output with respect to one or more fields in the output. When sorting is on 
more than one field, a user has to specify the primary, secondary, and tertiary key fields. A 
user can save a created report and use it later for generating similar reports whenever 
required. 
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----------------------------------------------------------------------------------------------------------
4.4 REVIEW QUESTIONS 
--------------------------------------------------------------------------------------------------------- 

1. Differentiate between various data processing systems? 
2.  What is a file management system? 
3. Write a short notes on: 

a) Hierarchical database mode; 
b) lNetwork database model; 
c) Object-oriented database model. 

4. What is query by example (QBE)? How does it make the job of querying a database 
simpler? 

5. What is SQL? How it is useful? 
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---------------------------------------------------------------------------------------------------------
DATA COMMUNICATIONS  
--------------------------------------------------------------------------------------------------------- 

Structure 
 
5.1 Introduction 
 
5.2 Basic Elements of a Communication System 
 5.2.1 Data Transmission Modes 
 5.2.2 Transmission Basics 
 
5.3 Types of Data Transmission Media  
 5.3.1 Bounded Media 
 5.3.2 Unbounded Media 
 
5.4 Modulation Techniques 
 5.4.1 Modems 
 5.4.2 Analog versus Digital Transmission 
 
5.5 Multiplexing 
 5.5.1 Time Division Multiplexing (TDM) 
 5.5.2 Frequency Division Multiplexing (FDM) 
 
6.6 Review Questions 
 
--------------------------------------------------------------------------------------------------------- 
5.1 INTRODUCTION 
--------------------------------------------------------------------------------------------------------- 
The term Communication has a history as old as the existence of life on earth. The 
telegraph revolutionized long-distance communications almost everywhere, reducing the 
time taken to communicate across a country from days to hours or minutes, or from months 
to days between continents. The early telegraph was a very simple device; it used a direct 
current cell to operate an electromagnet. 
 
At the time of the invention of the telephone, most effort was directed towards the 
development of a 'multiple' telegraph: one that could signal more than one code at a time. 
Despite digital communication getting a head start, voice telephony rapidly came to 
dominate the wide-are a communications arena. It is only the last few decades that have 
seen the development of wide-area networks exclusively for data, and only in the last few 
years that this technology, in the form of ISDN, has become available to home subscribers. 
Until very recently, if one wished to communicate between a home computer and a remote 
site, one had no choice but to use a modem to convert the computer signals into a form 
suitable for a voice communications medium. 
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Frequently, however, data must be sent beyond the local circuitry that constitutes a 
computer. In many cases, the distances involved may be enormous. Unfortunately, as the 
distance between the source of a message and its destination increases, accurate 
transmission becomes increasingly difficult. This results from the electrical distortion of 
signals traveling through long conductors, and from noise added to the signal as it 
propagates through a transmission medium. Although some precautions must be taken for 
data exchange within a computer, the biggest problems occur when data is transferred to 
devices outside the computer's circuitry. In this case, distortion and noise can become so 
severe that information is lost. 
 
Data Communications concerns the transmission of digital messages to devices external to 
the message source. "External" devices are generally thought of as being independently 
powered circuitry that exists beyond the chassis of a computer or other digital message 
source. As a rule, the maximum permissible transmission rate of a message is directly 
proportional to signal power and inversely proportional to channel noise. It is the aim of 
any communications system to provide the highest possible transmission rate at the lowest 
possible power and with the least possible noise. 
 
--------------------------------------------------------------------------------------------------------- 
5.2 BASIC ELEMENTS OF A COMMUNICATION SYSTEM 
--------------------------------------------------------------------------------------------------------- 
Communication is the process of transferring messages and data from one point to another. 
The three basic elements of any communication process are: 
 
1) A sender (source) which creates the message to be transmitted. 
2) A medium which carries the message. 
3) A receiver (Sink) which receives the message. 
 
For example when we speak to our friend over telephone we are sender, the telephone line 
through which our voice is transmitted is a medium and our friend is a receiver. This is a 
simple example of voice communication. The same concept holds for the data 
communication also. 
 
 
 
 
 
 

 
Fig 5.1 Basic Elements of a Communication System 

 
 
5.2.1 Data Transmission Modes 
Data transmission, whether analog or digital, may also be characterized by the direction in 
which the signals travel over the media. 
 

   Sender 
  (Source) 

    Receiver 
     (Sink) 

Medium 
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Fig 5.2 Means of communication 
 

1. Simplex: 
In cases where signals may travel in only one direction, the transmission is considered 
simplex.  
 
For example, 
A football coach calling out orders to his team through a megaphone is using simplex 
communication. In this example, the coach’s voice is the signal, and it travels in only one 
direction—away from the megaphone’s mouthpiece and toward the team. Simplex is 
sometimes called one-way, or unidirectional, communication. 
 
2. Half Duplex 
In half-duplex transmission signals may travel in both directions over a medium but in only 
one direction at a time. Half-duplex systems contain only one channel for communication, 
and that channel must be shared for multiple nodes to exchange information. For example, 
an apartment’s intercom system that requires you to press a “talk” button in order to allow 
your voice to be transmitted over the wire uses half-duplex transmission. If you visit a 
friend’s apartment building, you press the “talk” button to send your voice signals to their 
apartment. When your friend responds, he presses the “talk” button in his apartment to send 
his voice signal in the opposite direction over the wire to the speaker in the lobby where 
you wait. If you press the “talk” button while he’s talking, you will not be able to hear his 
voice transmission. In a similar manner, some networks operate with only half-duplex 
capability over their wires. 
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3. Full-Duplex 
When signals are free to travel in both directions over a medium simultaneously, the 
transmission is considered full duplex. Full duplex may also be called bi-directional 
transmission or sometimes, simply duplex. When you call a friend on the telephone, your 
connection is an example of a full-duplex transmission, because your voice signals can be 
transmitted to your friend at the same time your friend’s voice signals are transmitted in the 
opposite direction to you. In other words, both of you can talk and hear each other 
simultaneously. 
 
Full-duplex transmission is also used on data networks. For example, modern Ethernet 
networks use full-duplex. In this situation, full-duplex transmission uses multiple channels 
on the same medium. A channel is a distinct communication path between two or more 
nodes, much as a lane is a distinct transportation path on a freeway. Channels may be 
separated either logically or physically.  
An example of physically separate channels occurs when one wire within a network cable 
is be used for transmission while another wire is used for reception. In this example, while 
each separate wire in the medium allows half-duplex transmission, when combined in a 
cable they form a medium that provides full-duplex transmission. Full-duplex capability 
increases the speed with which data can travel over a network. In some cases—for 
example, telephone service over the Internet—full-duplex data networks are a requirement. 
Many network devices, such as modems and NICs, allow you to specify whether the device 
should use half- or full-duplex communication. It’s important to know what type of 
transmission a network supports before installing network devices on that network. If you 
configure a computer’s NIC to use full duplex while the rest of the network is using half-
duplex, 
 
For example, computer will not be able to communicate on the network. 
 
 

 
 

Fig 5.3 Modes of Data Transmission 
 
5.2.2 Transmission Basics 
In data networking, the term transmission has two meanings. First, it can refer to the 
process of issuing data signals on a medium. It can also refer to the progress of data signals 
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over a medium from one point to another. Long ago, people transmitted information across 
distances via smoke or fire signals. Needless to say, many different types of data 
transmission have evolved since that time. The transmission techniques in use on today’s 
networks are complex and varied.  

Analog and Digital Signaling 
One important characteristic of data transmission is the type of signaling involved. On a 
data network, information can be transmitted via one of two signaling methods:  
 

i. Analog 
ii. Digital 

 
Both types of signals are generated by electrical current, the pressure of which is measured 
in volts. The strength of an electrical signal is directly proportional to its voltage. Thus, 
when network engineers talk about the strength of an analog or digital signal, they often 
refer to the signal’s voltage. The essential difference between analog and digital signals is 
the way voltage creates and sustains the signal. 
 
1. Analog Signaling 
 In analog signals, voltage varies continuously. In digital signals, voltage turns off and on 
repeatedly, pulsing from zero voltage to a specific positive voltage. An analog signal’s 
voltage appears as a continuous wave when graphed over time, because voltage is varied 
and imprecise in analog signals, analog transmission is more susceptible to transmission 
flaws such as noise than digital signals. To understand this concept, think of two tin cans 
connected by a wire. When you speak into one of the tin cans, you produce analog sound 
waves that vibrate over the wire until they reach the tin can at the other end. These sound 
waves are merely approximations of your voice, and they are significantly affected by the 
quality of the wire. 
 
For example, 
If you try the tin can experiment with a pure copper wire, your voice will arrive at the other 
end sounding clearer than if you used fishing line, because copper conducts sound better 
than plastic. Regardless of which medium you use, however, the sound waves will become 
distorted as they traverse the wire, arriving at the second tin can at least a little muddled. 
This vulnerability makes analog transmission less precise than digital transmission. 

2. Digital Signaling 
Unlike analog signals where there is a smooth curve, digital signals jump directly to the 
next value.  
 
For example,  
If the voltage changed from -5 V to 0 V, it would change instantly, not drop off with a 
curve. When digital signals can exist in only one of two values, they go directly to the next 
value, typically changing between 0 and 1. The jump from one value to another is known 
as a transition. In digital signaling, transitions give a notched appearance to the graph. 
Digital signals are synchronized in bits which can be clocked by either sending a separate 
clocking scheme across the network with the bits, or by using a guaranteed state-change 
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clocking scheme. Data rate is measured in bits per second (bps). Also known as hertz or 
baud, this rate is sometimes called baud rate. Encoding data in a digital signal can be 
done using several encoding types. The different encoding types can be described as either 
state-transition encoding or current-state encoding. State-transition encoding uses a change 
(or lack of a change) in a signal to represent a data value. One way this is done is to let a 
change in voltage represent a 1. Whenever the voltage changes this is translated to a 1; if 
the voltage remains the same, the value is a 0. State-transition could also allow that a 
change in voltage represents a specific value. When the voltages changes from high to low 
this represents a 1, while a change from low to high represents a 0. 
 

 
 

Fig 5.4 Analog Signal 
 

 

 
 
 

Fig 5.5 Digital Signal 
 

Data rate: This is the rate, in bits per second (bps), at which data can be communicated.  
Bandwidth: This is the maximum bandwidth of the transmitted signal as constrained by 
the nature of the transmission medium or transmission channel, expressed in cycles per 
second, or hertz (Hz). 
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Noise: The average level of noise over the communications path. 
 
Error rate: The rate at which errors occur, where an error is the reception of a 1 when a 0 
was transmitted or the reception of a 0 when a 1 was transmitted. 
 
The problem we are addressing is this communications facilities are expensive, and, in 
general, the greater the bandwidth of the transmission facility, the greater the cost. 
Furthermore, all transmission channels of any practical interest are of limited bandwidth. 
The limitations arise from the physical properties of the transmission medium or from 
deliberate limitations at the transmitter on the bandwidth to prevent interference from other 
sources. Accordingly, we would like to make as efficient use as possible of a given 
bandwidth. For digital data, this means that we would like to get as high a data rate as 
possible at a particular limit of error rate for a given bandwidth. The main constraint on 
achieving this efficiency is noise. 
 
--------------------------------------------------------------------------------------------------------- 
5.3 TYPES OF DATA TRANSMISSION MEDIA  
------------------------------------------------------------------------------------------ 
Data Transmission Media is divided into two types 
1) Bounded Media 
2) Unbounded Media 
 
5.3.1 Bounded Media 
It is also known as guided media. Bounded transmission media constrain and guide 
communication signals. These are made up of a central conductor (usually copper) 
surrounded by a jacket material. Bounded media are great for LANs because they offer 
high speed, good security, and low cost. However, sometimes they cannot be used due to 
distance limitations. 
 
Cables differ by their properties. Depending on your needs, you may opt for one cable type 
over another because it has some characteristics that are more important to you. 
For example, coaxial cable is fairly resistant to outside interference but cannot be used for 
some high-speed LANs. Some of the characteristics you will look at for each cable type 
include the following: 
 
Cost: Cost can be an important consideration when deciding on a network cable. Only a 
few years ago, fiber-optic cable was extremely expensive, and almost no one could justify 
the cost to use it. 
 
Installation: Using the example above, one reason fiber-optic cable was so expensive was 
due to the installation. Only highly skilled technicians were capable of installing this cable 
correctly. Obviously the best situation is having someone on staff that can install the cable. 
If you need to get an outside contractor, the installation cost may outweigh the actual cable 
cost. 
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Capacity: So you have gotten past the cost and installation issues, and now the question is, 
“How fast will it go?” Normally, cable speed is referred to as bandwidth and is an 
important characteristic of a media type. Bandwidth is usually measured in bits per 
second. For example, standard Ethernet cable is usually up to 10 Mbps, which is 10 mega 
bits per second (note the small b for bits, not B for Bytes). 
 
Attenuation (Maximum Distance): Depending on what you need to network together, the 
maximum cable distance may also be another consideration. 
 
Immunity to Interference: The last property is how well the cable holds up against 
interference, normally electromagnetic interference, or EMI. EMI could play a big part in 
which cable type you use, depending on the location. Suppose you needed to run a network 
into a manufacturing facility with a lot of heavy machinery that used electrical motors. An 
unshielded type of cable may not be the best choice in that situation. 
 
Three common types of bounded media are in use out in the world they are 
 

a) Coaxial 
b) Twisted pair 
c) Fiber optic 

a) Coaxial Cable 
Coaxial cable, called “coax” for short, was the foundation for Ethernet networks in the 
1980s and remained a popular transmission medium for many years. Over time, however, 
twisted-pair cabling has replaced coax in most modern LANs. Coaxial cable consists of a 
central copper core surrounded by an insulator, a braided metal shielding, called braiding, 
and an outer cover, and called the sheath or jacket. The copper core carries the 
electromagnetic signal, and the braided metal shielding acts as both a shield against noise 
and a ground for the signal. The insulator layer usually consists of a plastic material such as 
polyvinyl chloride (PVC) or Teflon. It protects the copper core from the metal shielding, 
because if the two made contact, the wire would short-circuit. The jacket, which protects 
the cable from physical damage, may be PVC or a more expensive, fire-resistant plastic 
 
Because of its insulation and protective braiding, coaxial cable has a high resistance to 
interference from noise. It can also carry signals farther than twisted-pair cabling before 
amplification of the signals becomes necessary, although not as far as fiber-optic cabling. 
On the other hand, coaxial cable is more expensive than twisted-pair cable because it 
requires significantly more raw materials (such as copper for the core, Teflon for the 
insulation, and so on) to manufacture. Coaxial cable is also less desirable than twisted-pair 
because it supports lower throughput. 
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Fig 5.6 Coaxial Cable 
 

 
b) Twisted-Pair Cable 
The most popular network cabling right now is twisted pair. It is lightweight, easy to 
install, inexpensive, and supports many different types of networks. It can also supports 
speeds of up to 100Mbps. 

 
Twisted-pair cabling is made up of pairs of solid or stranded copper twisted around each 
other. The twists are done to reduce the vulnerability to EMI and cross talk. The number of 
pairs in the cable depends on the type. The copper core of the cable is usually 22-AWG or 
24-AWG, as measured on the American Wire Gauge standard. 
 
Twisted-pair (TP) cable is similar to telephone wiring and consists of color-coded pairs of 
insulated copper wires, each with a diameter of 0.4 to 0.8 mm, or 22-24 AWG (American 
Wire Gauge) standard copper wires. The wires are twisted around each other to form pairs 
and all the pairs are encased in a plastic sheath, The twists in the wire help to reduce the 
effects of crosstalk. Crosstalk, which is measured in decibels (dB), occurs when signals 
traveling on nearby wire pairs infringe on another pair’s signal. If you envision the wire 
pairs in a single cable as couples in an elevator, you can imagine how one couple speaking 
very loudly might impair the other couple’s ability to converse. Because they are twisted 
around each other, the release of current from one wire cancels out the release of current 
from the adjacent wire. Another form of crosstalk, called alien crosstalk, can occur when 
signals from an adjacent cable (as opposed to adjacent wires) interfere with another cable’s 
transmission. Alien crosstalk becomes a real threat when network administrators bundle 
more cables into smaller conduits. 

 

 
Fig 5.7 Twisted-pair cable 
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The more twists per inch in a pair of wires, the more resistant the pair will be to all forms 
of noise. Higher-quality, more expensive twisted-pair cable contains more twists per foot. 
The number of twists per meter or foot is known as the twist ratio. Because twisting the 
wire pairs more tightly requires more cable, however, a high twist ratio can result in greater 
attenuation. For optimal performance, cable manufacturers must strike a balance between 
crosstalk and attenuation reduction. Because twisted-pair is used in such a wide variety of 
environments and for a variety of purposes, it comes in hundreds of different designs.  

 
iii. Fiber-Optic Cable 
Fiber-optic cable, or simply fiber, contains one or several glass fibers at its center, or core. 
Data are transmitted via pulsing light sent from a laser or light-emitting diode (LED) 
through the central fibers. Surrounding the fibers is a layer of glass called cladding. The 
cladding glass is a different density from the glass in the strands. It acts as a mirror, 
reflecting light back to the core in patterns that vary depending on the transmission mode. 
This reflection allows the fiber to bend around corners without diminishing the integrity of 
the light-based signal. Outside the cladding, a plastic buffer protects the glass cladding and 
core. Since it is opaque, it also absorbs any light that might escape. To prevent the cable 
from stretching, and to further protect the inner core, strands of Kevlar (an advanced 
polymeric fiber) surround the plastic buffer. Finally, plastic sheath covers the strands of 
Kevlar.  
 

 
 

Fig 5.8 A fiber-optic cable 
 

Like twisted-pair cable, fiber comes in a number of different types. Fiber cable variations 
fall into two categories: single-mode and multimode. Single-mode fiber uses a narrow core 
(less than 10 microns in diameter) through which light generated by a laser travels over one 
path, reflecting very little. Because it reflects little, the light does not disperse as the signal 
travels along the fiber. This continuity allows single mode fiber to accommodate high 
bandwidths and long distances (without requiring repeaters). 
Single-mode fiber may be used to connect a carrier’s two facilities.  However, it costs too 
much to be considered for use on typical data networks.  Multimode fiber contains a core 
with a larger diameter than single mode fiber (between 50 and 100 microns in diameter) 
over which many pulses of light generated by a light emitting diode (LED) travel at 
different angles. Because light is being reflected many different ways in a multimode fiber 
cable, the waves become less easily distinguishable the longer they travel. Thus, multimode 
fiber is best suited for shorter distances than single-mode fiber. It is commonly found on 
cables that connect a router to a switch or a server on the backbone of a network. Because 
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of its reliability, fiber is currently used primarily as a cable that connects the many 
segments of a network. Experts predict, however, that it will replace UTP as the primary 
means of bringing data to the desktop within the next decade. Fiber-optic cable provides 
the benefits of nearly unlimited throughput, very high resistance to noise, and excellent 
security. Because fiber does not conduct electricity like copper wire, it does not emit a 
current. As a result, the signals it carries stay within the fiber and cannot easily be picked 
up except at the destination node. Copper, on the other hand, generates   signal that can be 
monitored by taps into the network. Fiber can also carry signals for longer distances than 
can coax or twisted-pair cable. In addition, you can use longer lengths of fiber with fewer 
repeaters than on a copper-based network. Finally, fiber is widely accepted by the high-
speed networking industry. Thus, industry groups are establishing standards to ensure that 
fiber-networking equipment from multiple manufacturers can be integrated without 
difficulty. 
 

 
 

Fig 5.9 Single-mode and multimode fiber-optic cables 
 
The most significant drawback to the use of fiber is its high cost. Another disadvantage is 
that fiber can transmit data in only one direction at a time; to overcome this drawback, each 
cable must contain two strands—one to send data and one to receive it. Finally, unlike 
copper wiring, fiber is difficult to splice, which means quickly repairing a cable in the field 
(given little time or resources) is difficult if not impossible.  
 
5.3.2 Unbounded Media 
Unbounded, or wireless, media does not use any physical connectors between the two 
devices communicating. Usually the transmission is sent through the atmosphere, but 
sometimes it can be just across a room. Wireless media is used when a physical obstruction 
or distance blocks the use of normal cable media. Following are the types of unbounded 
media: 
1. Radio Waves 

 i. Short-wave 
ii. Very-high frequency (VHF) television and radio 

  iii. Ultra-high frequency (UHF) television and radio Micro waves  
2. Microwaves 
  i. Terrestrial Microwaves 
  ii. Satellite Microwaves 
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3. Infrared 
  i. Point-to-point 

ii. Broadcast 
 
 
1. Radio Waves 
Radio waves have frequencies between 10 KHz and 1GHz. Radio waves include the 
following types: 

 
i.Short-wave 

ii.Very-high frequency (VHF) television and radio 
iii.Ultra-high frequency (UHF) television and radio 

 
Most radio frequencies in the US and Canada are regulated. To gain permission to use a 
regulated frequency can take a long time and a large amount of money. The good news is 
that there are some frequencies that are not regulated and anyone can use.  
 
The problem with unregulated frequencies is that they can get saturated. To ease this, there 
have been limits set on the amount of power that devices can broadcast in these 
frequencies. While letting more people use the frequencies, this cuts down on the usable 
range. 
 
2. Microwaves 
Microwaves travel at higher frequencies than radio waves and provide better throughput as 
a wireless network media. Microwave transmissions require the sender to be within sight of 
the receiver. These systems use licensed frequencies, which makes them more costly than 
radio wave systems. Microwaves are utilized on the following two types of communication 
systems: 
 
i. Terrestrial Microwaves 
Terrestrial microwave transmissions are used to transmit wireless signals across a few 
miles. These systems are often used to cross roads or other barriers that make cable 
connections difficult. Terrestrial systems require that direct parabolic antennas be pointed 
at each other. Relay towers can be used as repeaters to extend the distance of the 
transmission. These systems operate in the low giga hertz range and require licensed 
frequencies. Installation can be difficult because terrestrial microwave transmissions 
require that the antennas have a clear line of sight. 

 
ii. Satellite Microwaves 
Satellite microwave transmissions are used to transmit signals throughout the world. These 
systems use satellites in orbit about 50,000 kilometers (km) above the earth. Satellite dishes 
are used to send the signal to the satellite where it is then sent back down to the receiver’s 
satellite. These transmissions also use directional parabolic antennas within line-of-site. 
The large distances the signals travel can cause propagation delays. These delays vary from 
under a second to several seconds. These delays are roughly the same for transmissions 
down the street as for transmissions across the world. This equipment is expensive and 
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quite complicated. Launching a satellite into orbit is a task beyond many organizations. 
These systems can provide average bandwidth but lack advanced security and protection 
from interference. These systems can provide a good bandwidth connection to link LANs 
across the world, but this capability comes with (literally) a hefty price. 
 
3. Infrared 
Infrared frequencies are just below visible light. These high frequencies allow high-speed 
data transmissions. This technology is similar to the use of a remote control for a television. 
Infrared transmissions can be affected by objects obstructing the sender or receiver and by 
interference from light sources. These systems are immune to electromagnetic interference 
and can be used successfully where certain types of cable media fail. These transmissions 
fall into the following two categories: 

i. Point-to-point Infrared 
Point-to-point infrared transmissions utilize highly focused beams to transfer signals 
directly between two systems. Many laptop systems and PDAs (personal data assistants) 
use point-to-point transmissions. Point-to-point systems require direct alignment between 
devices. Point-to-point can provide an alternative to terrestrial microwave as well. If two 
buildings have direct line-of-site availability, point-to-point can utilize high-power infrared 
beams. This does not require an FCC license and is immune to EMI. These systems are 
susceptible to interference from anything that can block the path of the beam. This provides 
a high level of security, as any attempt to interfere with the beam would be noticeable. One 
must be careful when working with high-power laser beams, as they can cause damage to 
eye and skin tissue. 
 
ii. Broadcast 
Broadcast infrared transmissions use a spread signal, one broadcast in all directions, 
instead of a direct beam. This helps to reduce the problems of proper alignment and 
obstructions. It also allows multiple receivers of a signal. Some systems utilize a single 
broadcast transceiver to communicate with many devices. This type of system is easy to 
install. Broadcast infrared transmissions operate in the same frequencies as point-to-point 
infrared and are susceptible to interference from light sources. The drawback of this system 
is that the diffused signal reduces transmission rates to 1Mbps. This system overcomes 
some of the problems of point-to-point transmissions, but the trade-off is a decrease in 
speed. 
 
--------------------------------------------------------------------------------------------------------- 
5.4 MODULATION TECHNIQUES 
--------------------------------------------------------------------------------------------------------- 
Data modulation is a technology used to modify analog signals in order to make them 
suitable for carrying data over a communication path. In modulation, a simple wave, called 
a carrier wave, is combined with another analog signal to produce a unique signal that gets 
transmitted from one node to another. The carrier wave has preset properties (including 
frequency, amplitude, and phase). Its purpose is merely to help convey information; in 
other words, it does not represent information. Another signal, known as the information or 
data wave, is added to the carrier wave. When the information wave is added, it modifies 
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one property of the carrier wave (for example, the frequency, amplitude, or phase).The 
result is a new, blended signal that contains properties of both the carrier wave and added 
data. When the signal reaches its destination, the receiver separates the data from the 
carrier wave. 
 
Modulation can be used to make a signal conform to a specific pathway, as in the case of 
frequency modulation (FM) radio, in which the data must travel along a particular 
frequency. Modulation may also be used to issue multiple signals to the same 
communications channel and prevent the signals from interfering with one another. In 
frequency modulation, the frequency of the carrier signal is modified by the application of 
the data signal. 
 
There are three forms of modulation- amplitude, frequency and phase modulation. They are 
described below: 

1) Amplitude modulation (AM) is a technique used in electronic communication, most 
commonly for transmitting information via a radio carrier wave. AM works by varying the 
strength of the transmitted signal in relation to the information being sent. It  is a method of 
impressing data onto an alternating-current (AC) carrier waveform. The highest frequency 
of the modulating data is normally less than 10 percent of the carrier frequency. The 
instantaneous amplitude (overall signal power) varies depending on the instantaneous 
amplitude of the modulating data. For example, changes in the signal strength can be used 
to reflect the sounds to be reproduced by a speaker, or to specify the light intensity of 
television pixels. 

2) Frequency Modulation (FM) In telecommunications, frequency modulation (FM) 
conveys information over a carrier wave by varying its frequency (contrast this with 
amplitude modulation, in which the amplitude of the carrier is varied while its frequency 
remains constant). In analog applications, the instantaneous frequency of the carrier is 
directly proportional to the instantaneous value of the input signal. Digital data can be sent 
by shifting the carrier's frequency among a set of discrete values, a technique known as 
frequency-shift keying. 

It is a method of impressing data onto an alternating-current (AC) wave by varying the 
instantaneous frequency of the wave. This scheme can be used with analog or digital data.  
Examples; FM is also used at audio frequencies to synthesize sound. This technique, 
known as FM synthesis, was popularized by early digital synthesizers and became a 
standard feature for several generations of personal computer sound cards. 

3) Phase modulation (PM) It is a form of modulation that represents information as 
variations in the instantaneous phase of a carrier wave. 

Unlike its more popular counterpart, frequency modulation (FM), PM is not very widely 
used. This is because it tends to require more complex receiving hardware and there can be 
ambiguity problems in determining whether, for example, the signal has changed phase by 
+180° or -180°. This scheme can be used with analog or digital data. 
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Fig 5.10 (a) Analog Source signal (b ) FM (c) PM 

5.4.1 Modems 
The word "modem" is a contraction of the words modulator-demodulator. A modem is 
typically used to send digital data over a phone line.  

The sending modem modulates the data into a signal that is compatible with the phone 
line, and the receiving modem demodulates the signal back into digital data. Wireless 
modems convert digital data into radio signals and back.  

 
 

Fig 5.11 Modem 
 

A modem is the peripheral used to transfer information between several computers over a 
wire transmission medium (e.g. telephone lines). Computers operate digitally using binary 
language (a series of zeros and ones), but modems are analogue. The digital signals pass 
from one value to another. There is no middle or half-way point. It is "All or Nothing" 
(one or zero). On the other hand, analogue signals do not move "in steps", but rather 
continuously. 
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Modems came into existence in the 1960s as a way to allow terminals to connect to 
computers over the phone lines. A typical arrangement is shown in Fig. 5.11. 

 
 
 

 
 

(a) 
 
 
 

(b) 
 

Fig 5.12 An Architecture of Modem 
 

5.4.2 Analog versus Digital Transmission 
As a technology, analog is the process of taking an audio or video signal (the human voice) 
and translating it into electronic pulses. Digital on the other hand is breaking the signal into 
a binary format where the audio or video data is represented by a series of "1"s and "0"s.  
 
Analog is a transmission standard that uses electrical impulses to emulate the audio 
waveform of sound. When you use a phone, the variations in your voice are transformed by 
a microphone into similar variations in an electrical signal and carried down the line to the 
exchange. 
 
A method of storing, processing and transmitting information through the use of distinct 
electronic or optical pulses that represent the binary digits 0 and 1 is known as Digital 
Signal 
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Advantages of Analog 
1. Uses less bandwidth 
2. More accurate 
 
Disadvantages of Analog 
1. The effects of random noise can make signal loss and distortion impossible to recover 
 
Advantages of Digital 
1. Less expensive 
2. More reliable 
3. Easy to manipulate 
4. Flexible 
5. Compatibility with other digital systems 
6. Only digitized information can be transported through a noisy channel without 
degradation 
7. Integrated networks 
 
Disadvantages of Digital 
1. Sampling Error 
2. Digital communications require greater bandwidth than analogue to transmit the same 
information. 
 3. The detection of digital signals requires the communications system to be synchronized, 
whereas generally speaking this is not the case with analogue systems. 
 
--------------------------------------------------------------------------------------------------------- 
5.5 MULTIPLEXING 
--------------------------------------------------------------------------------------------------------- 
A form of transmission that allows multiple signals to travel simultaneously over one 
medium is known as multiplexing. In order to accommodate multiple signals, the single 
medium is logically separated into multiple channels, or sub channels.In 
telecommunications and computer networks, multiplexing (also known as mixing) is a 
process where multiple analog message signals or digital data streams are combined into 
one signal over a shared medium. There are many different types of multiplexing, and the 
type used in any given situation depends on what the media, transmission and reception 
equipment can handle.The aim is to share an expensive resource. For each type of 
multiplexing, a device that can combine many signals on a channel, a multiplexer (mux), is 
required at the sending end of the channel. At the receiving end, a demultiplexer (demux) 
separates the combined signals and regenerates them in their original form. 
 
Multiplexing is commonly used on networks to increase the amount of data that can be 
transmitted in a given time span.  
 
5.5.1 Time division multiplexing (TDM) 
Time-Division Multiplexing (TDM) is a type of digital or (rarely) analog multiplexing in 
which two or more signals or bit streams are transferred apparently simultaneously as sub-
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channels in one communication channel, but are physically taking turns on the channel. 
The time domain is divided into several recurrent timeslots of fixed length, one for each 
sub-channel divides a channel into multiple intervals of time, or time slots. It then assigns a 
separate time slot to every node on the network and in that time slot, carries data from that 
node.  
 
For example, if five stations are connected to a network over one wire, five different time 
slots would be established in the communications channel. Workstation A may be assigned 
time slot 1, workstation B time slot 2, workstation C time slot 3, and so on. Time slots are 
reserved for their designated nodes no matter whether the node has data to transmit or not. 
If a node does not have data to send, nothing will be sent during its time slot. This 
arrangement can be inefficient if some nodes on the network rarely send data. 
 

 
 

Fig 5.13 Time division multiplexing 
 
5.5.2 Frequency Division Multiplexing (FDM) 
In FDM, available bandwidth of a physical medium is divided into several smaller, disjoint 
logical bandwidths. Each component bandwidth is used as a separate communication line 
(channel). Figure 5.14 illustrates FDM process. 
 
The best example of FDM is the manner in which multiple radio stations are supported 
simultaneously. Each radio station is assigned a frequency range within a bandwidth of 
radiofrequencies. Several radio stations may be transmitted speech signals simultaneously 
over physical channel “ether”. Note that the concept of “ether” an invisible, ever present, 
and un-provable medium was proposed to explain the theory of transmission of waves in 
space. The electromagnetic propagation of wave in space is now a more acceptable and 
proven concepts but the term “ether” has come to stay. A radio receiver antenna receives 
signals transmitted by all stations. Finally tuning dial in a radio set is used to isolate signals 
of the station tuned. In FDM, signals to be transmitted must be analog signals. Hence, 
digital signals must be converted to analog form, if they are to use FDM 
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  Figure 5.14 Illustrates FDM Process 
 
--------------------------------------------------------------------------------------------------------- 
5.6 REVIEW QUESTIONS 
--------------------------------------------------------------------------------------------------------- 

1. Differentiate among simplex, half-duplex, and full-duplex modes of data 
transmission. 

2. Explain the term bandwidth and baud. 
3. What is an optical fiber? How it is used for data communication. 
4. List the difference between FDM and TDM. Which method is suitable for 

communication between computers and why? 
5. Write short note on: 

a) Microwave system; 
b) Coaxial cable; and  
c) Modem. 
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-------------------------------------------------------------------------------------------------------------- 
COMPUTER NETWORKS  
-------------------------------------------------------------------------------------------------------------- 
 

Structure 
6.1 Need for Computer Communication Networks  
 6.1.1 Advantages of Networking  
 
6.2 Types of Network 
 
6.3 Network Topologies 
 
6.4 Network Protocol 
 6.4.1 Key Features of Protocols 

 6.4.2 Roles of Protocol 
 6.4.3 Need for Protocol Architecture 
 
6.5 OSI and TCP/IP Model 
 6.5.1 ISO and Other Models 
 6.5.2 How the OSI Model Works 
 6.5.3 Key Words and Concepts from the OSI Model 
 6.5.4 The TCP/IP Model 
 6.5.5 Internetworking With TCP/IP 
 
6.6 The Future of Internet Technology  
 
6.7 Internet Protocols 
 6.7.1 Low Level Protocols 
 6.7.2 High Level Protocols 
 
6.8 World Wide Web 
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 6.10.1 Types of Search Engines 
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--------------------------------------------------------------------------------------------------------- 
6.1 NEED FOR COMPUTER COMMUNICATION NETWORKS  
--------------------------------------------------------------------------------------------------------- 
Definition: A computer network is a collection of computers and devices connected to 
each other. The network allows computers to communicate with each other and share 
resources and information 
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Need: If your business has more than one computer, chances are you could benefit from 
networking them. A local area network (LAN) connects your company's computers, 
allowing them to share and exchange a variety of information. While one computer can be 
useful on its own, several networked computers can be much more useful. Resource 
sharing and communication are two principal reasons of building and using computer 
networks. 
 
Here are some of the ways a computer network can help your business:  
 

o File sharing: Have you ever needed to access a file stored on another computer? A 
network makes it easy for everyone to access the same file and prevents people 
from accidentally creating different versions.  

o Printer sharing: If you use a computer, chances are you also use a printer. With a 
network, several computers can share the same printer. Although you might need a 
more expensive printer to handle the added workload, it's still cheaper to use a 
network printer than to connect a separate printer to every computer in your office.  

o Communication and collaboration: It's hard for people to work together if no 
one knows what anyone else is doing. A network allows employees to share files, 
view other people's work, and exchange ideas more efficiently. In a larger office, 
you can use e-mail and instant messaging tools to communicate quickly and to 
store messages for future reference.  

o Organization: A variety of scheduling software is available that makes it possible 
to arrange meetings without constantly checking everyone's schedules. This 
software usually includes other helpful features, such as shared address books and 
to-do lists.  

o Remote access: Having your own network allows greater mobility while 
maintaining the same level of productivity. With remote access in place, users are 
able to access the same files, data, and messages even when they're not in the 
office. This access can even be given to mobile handheld devices.  

o Data protection: You should know by now that it's vital to back up your computer 
data regularly. A network makes it easier to back up all of your company's data on 
an offsite server, a set of tapes, CDs, or other backup systems. Of course, another 
aspect of data protection is data security.  

 
6.1.1 Advantages of Networking  
Speed: Networks provide a very rapid method for sharing and transferring files. Without a 
network, files are shared by copying them to floppy disks, then carrying or sending the disks 
from one computer to another. This method of transferring files in this manner is very time-
consuming.  
 
Cost: The network version of most software programs are available at considerable savings 
when compared to buying individually licensed copies. Besides monetary savings, sharing a 
program on a network allows for easier upgrading of the program. The changes have to be 
done only once, on the file server, instead of on all the individual workstations.  
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Centralized Software Management: One of the greatest benefits of installing a network is the 
fact that all of the software can be loaded on one computer (the file server). This eliminates 
that need to spend time and energy installing updates and tracking files on independent 
computers throughout the building.  
 
Resource Sharing: Sharing resources is another area in which a network exceeds stand-alone 
computers. Most companies cannot afford enough laser printers, fax machines, modems, 
scanners, and CD-ROM players for each computer. However, if these or similar peripherals are 
added to a network, they can be shared by many users.  
 
Flexible Access: Networks allow employees/students to access their files from computers 
throughout the company/college. Students can begin an assignment in their classroom, save 
part of it on a public access area of the network, and then go to the media center after college to 
finish their work.  
 
Security: Files and programs on a network can be designated as "copy inhibit," so that you do 
not have to worry about illegal copying of programs. Also, passwords can be established for 
specific directories to restrict access to authorized users.  
 
Requires Administrative Time: Proper maintenance of a network requires considerable time 
and expertise. Many companies have installed a network, only to find that they did not budget 
for the necessary administrative support.  
 
File Server May Fail: Although a file server is no more susceptible to failure than any other 
computer, when the files server "goes down," the entire network may come to a halt. When this 
happens, the entire school may lose access to necessary programs and files.  
 
-------------------------------------------------------------------------------------------------------------- 
6.2 TYPES OF NETWORK 
-------------------------------------------------------------------------------------------------------------- 
When we talk about computer networks apart from the communication media we are 
concerned with how computers are connected with each other. In the sense we are having 
basically following types of networks: 
 

• LAN (Local Area Network) 
• WAN (Wide Area Network) 
• MAN (Metropolitan Area Network) 

 
Local Area Network (LAN) 
LAN stands for Local Area Network. It's a group of computers which all belong to the 
same organization, and which are linked within a small geographic area using a network, 
and often the same technology (the most widespread being Ethernet). This is a computer 
network covering a small physical area, like a home, office, or small group of buildings, 
such as a school, or an airport. 
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Fig 6.1 Three most popular LAN implementations 

 
A local area network is a network in its simplest form. Data transfer speeds over a local 
area network can reach up to 10 Mbps (such as for an Ethernet network) and 1 Gbps (as 
with FDDI or Gigabit Ethernet). A local area network can reach as many as 100, or even 
1000, users. By expanding the definition of a LAN to the services that it provides, two 
different operating modes can be defined:  
 
• In a "peer-to-peer" network, in which communication is carried out from one 

computer to another, without a central computer, and where each computer has the 
same role.  

• In a "client/server" environment, in which a central computer provides network 
services to users.  

 
 

Fig 6.2 LAN 
 

http://www.studynama.com/?utm_source=pdf&utm_medium=downloaded_file&utm_campaign=studynama_referral


 119

 
 
Metropolitan Area Network (MAN)  
 
A Metropolitan Area Network is a system of LANs connected throughout a city or 
metropolitan area. A metropolitan area network (MAN) is a network that connects two or 
more local area networks or campus area networks together but does not extend beyond the 
boundaries of the immediate town/city. Routers, switches and hubs are connected to create 
a metropolitan area network.  MANs have the requirement of using telecommunication 
media such as voice channels or data channels. Branch offices are connected to head 
offices through MANs. Examples of organizations that use MANs are universities and 
colleges, grocery chains, and banks.  
 
Location: Separate buildings distributed throughout a city. MAN takes over the rein in 
hand where LAN is not optimal feasible both technical and financially.  
 

 
 

Fig 6.3 MAN 
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The main criterion for a MAN is that the connection between LANs is through a local 
exchange carrier (the local phone company).  
 
WAN (Wide Area Network)  
As the term implies, a WAN spans a large physical distance. The Internet is the largest 
WAN, spanning the Earth. A WAN is a geographically-dispersed collection of LANs. A 
network device called a router connects LANs to a WAN. In IP networking, the router 
maintains both a LAN address and a WAN address.  
 
A WAN differs from a LAN in several important ways. Most WANs (like the Internet) are 
not owned by any one organization but rather exist under collective or distributed 
ownership and management. 
 
A Wide Area Network is a network system connecting cities, countries, or continents 
together. WANs are connected together using one of the telecommunications media.  
The main difference between a MAN and a WAN is that the WAN uses Long Distance 
Carriers. Otherwise the same protocols and equipment are used a MAN.  
 

 
 

Fig. 6.4 WANs use Long Distance Carriers 
 

 
(a) 
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(b) 
Fig 6.5 Examples of WAN 

 
 

They may link the computers by means of cables, optical fibers, or satellites, but their users 
commonly access the networks via a modem (a device that allows computers to 
communicate over telephone lines). The largest wide – area network is the Internet, a 
collection of networks and gateways linking millions of computer users on every continent. 
 
--------------------------------------------------------------------------------------------------------- 

6.3 NETWORK TOPOLOGIES 
-------------------------------------------------------------------------------------------------------------------------------------------------------------- 

Topology of a network refers to the way in which the network’s nodes (computers or other 
devices that need to communicate) are linked together. It determines the various data paths 
available between any pair of nodes in the network. Choice of a topology for a computer 
network depends on a combination of factors such as: 
 
1. Desired performance of the system 
2. Desired reliability of the system 
3. Size (number of nodes and their geographical distribution) of the system. 
4. Expandability of the system 
5. Cost of components and services required to implement the network. 
6. Availability of communication lines. 
7. Delays involved in routing information from one node to another. 
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Network topologies are categorized into the following basic types: 
 

1. Bus Topology;  
2. Ring Topology; 
3. Star Topology; 
4. Tree Topology; 
5. Mesh Topology. 

 
Bus Topology: Bus networks (not to be confused with the system bus of a computer) use a 
common backbone to connect all devices. A single cable, the backbone functions as a 
shared communication medium that devices attach or tap into with an interface connector. 
A device wanting to communicate with another device on the network sends a broadcast 
message onto the wire that all other devices see, but only the intended recipient actually 
accepts and processes the message. Ethernet bus topologies are relatively easy to install and 
don't require much cabling compared to the alternatives  
 
Benefits of Bus Topology  
1. Cabling costs are minimized because of the common trunk. 
2. Failure of a node does not affect communication among other nodes in the network 
3. Addition of new nodes to the network is easy. 
 
Disadvantages of Bus topology  
1. Difficult to trouble shoot because no central distribution points exist.  
2. Cable breaks can disable the entire segment because they remove the required 
termination from each of the two cable fragments.  
 

 
Fig 6.6 Bus Topology 

 
Ring Topology: In a ring network, every device has exactly two neighbors for 
communication purposes. All messages travel through a ring in the same direction (either 
"clockwise" or "counterclockwise"). A failure in any cable or device breaks the loop and 
can take down the entire network. 
Ring topologies are found in some office buildings or school campuses. 
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Benefits of Ring Topology  
1. Each repeater duplicates the data signals so that very little signal degradation occurs.  
2. Ring network works well where there is no central node for making routing decisions. 
3. It is more reliable because communication is not dependant on a single central node. If a 
link between any two nodes fails, or if one of the nodes fails, alternate routing is possible. 
 
Disadvantages of Ring topology  
1. A break in the ring can disable the entire network. Many ring designs incorporate extra 
cabling that can be switched in if a primary cable fails. 
2. Because each node must have the capability of functioning as a repeater, the networking 
devices tend to be more expensive. 
3. It requires more complicated control software  

 
Fig 6.7 Ring Topology 

 
Star Topology: Many home networks use the star topology. A star network features a 
central connection point called a "hub" that may be a hub, switch or router. Devices 
typically connect to the hub with Unshielded Twisted Pair (UTP) Ethernet.  The star 
topology is a popular method of connecting the cabling in a computer network. In a star, 
each device connects to a central point via a point-to-point link. Depending on the logical 
architecture used, several names are used for the central point including the following:  
 

• Hub  
• Multipoint Repeater  
• Concentrator  
• Multi-Access Unit (MAU)  

 
Compared to the bus topology, a star network generally requires more cable, but a failure in 
any star network cable will only take down one computer's network access and not the 
entire LAN. (If the hub fails, however, the entire network also fails).  
 
Benefits of Star Topology 
1. Each device is isolated on its own cable. This makes it easy to isolate individual devices 
from the network by disconnecting them from the wiring hub. 
2. All data goes through the central point, which can be equipped with diagnostic devices 
that make it easy to trouble shoot and manage the network. 
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3. Hierarchical organization allows isolation of traffic on the channel. This is beneficial 
when several, but not all, computers place a heavy load on the network. Traffic from those 
heavily used computers can be separated from the rest or dispersed throughout for a more 
even flow of traffic. 
4. It has minimal line cost because only n-1 lines are required for connecting n nodes. 
 

 
 

Fig 6.8 Star Topology 
 
 
Disadvantages of Star topology  
1. Because point-to-point wiring is utilized for each node, more cable is required.  
2. Hub failures can disable large segments of the network.  
 
Tree Topology: Tree topologies integrate multiple star topologies together onto a bus. In 
its simplest form, only hub devices connect directly to the tree bus and each hub functions 
as the "root" of a tree of devices. This bus/star hybrid approach supports future 
expandability of the network much better than a bus (limited in the number of devices due 
to the broadcast traffic it generates) or a star (limited by the number of hub connection 
points) alone. 

Benefits of Tree Network topology 
1. A Tree Topology is supported by many network vendors and even hardware vendors.  
2. A point to point connection is possible with Tree Networks.  
3. All the computers have access to the larger and their immediate networks.  
4. Best topology for branched out networks.  
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Fig 6.9 Tree Topology 

Disadvantages of Tree Topology  
1. In a Network Topology the length of the network depends on the type of cable that is 
being used.  
2. The Tree Topology network is entirely dependant on the trunk which is the main 
backbone of the network. If that has to fail then the entire network would fail.  
3. Since the Tree Topology network is big it is difficult to configure and can get 
complicated after a certain point.  
 
Mesh Topology: Mesh topologies involve the concept of routes. Unlike each of the 
previous topologies, messages sent on a mesh network can take any of several possible 
paths from source to destination. (Recall that even in a ring, although two cable paths exist, 
messages can only travel in one direction.) Some WANs, most notably the Internet, employ 
mesh routing.  
 
A mesh network in which every device connects to every other is called a full mesh. As 
shown in the Fig 6.10 below, partial mesh networks also exist in which some devices 
connect only indirectly to others.  

Benefits of Mesh Topology 
1. Provides redundant paths between devices. 
2. The network can be expanded without disruption to current users. 
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3. It is fault tolerant; since there is no gateway, nodes can connect to each other with no 
regard to the state of the rest of the network. In addition, nodes can create their own paths 
through the network because there is no gateway computer.  

Disadvantages of Mesh Topology  
1. Requires more cable than the other LAN topologies 
2. Complicated implementation 
3. Setup time can be quite time consuming. 
 

 
Fig 6.10 Mesh Topology 

 
--------------------------------------------------------------------------------------------------------- 

6.4 NETWORK PROTOCOL 
--------------------------------------------------------------------------------------------------------- 

A protocol is the formal code of behavior for a system, or to be more precise the set form 
in which data must be presented for handling by a particular computer configuration. A 
protocol defines the set of rules governing the exchange of data between two entities such 
as user application programs, file transfer packages, email etc. 
 
6.4.1 Key Features of Protocols 

a) Syntax. This is concerned with the format of the data blocks; 
b) Semantics. This includes control data for co-ordination and error handling; 
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c) Timing. This allows for speed matching and sequencing. 
 
6.4.2 Roles of Protocol 
In any computer network, data communication software normally performs the following 
functions for the efficient and error free transmission of data: 
 

i. Data sequencing: It refers to breaking a long transmission into blocks and 
maintaining control that is along message is split up into smaller packets of fixed 
size. These packets are further fragmented into data frames, this techniques is 
widely used in conjunction with error control techniques to reduce the amount of 
data that must be retransmitted in case of a detected error. 

 
ii. Data routing: Routing algorithms are designed to find the most efficient paths 

between sources and destinations. They can handle varying degree of traffic on the 
present network configuration with optimum time utilization. Normally, they are 
dynamic enough to accommodate network changes and growth. 

 
iii. Flow control: A communication protocol also prevents a fast sender from 

overwhelming a slow receiver. It ensures resources sharing and protection against 
congestion by regulating the flow of data on the communication lines. 

 
iv. Error control: Error detecting and recovering routines are also important elements 

of communication protocols. The most common methods for correcting errors are to 
retransmit a block. This method requires coordination of the two stations that the 
block having error is discarded by the receiving station and is repeated by the 
transmitting station. 

 
v. Precedence and order of transmission: There are well defined rules to condition 

all stations about when to transmit their data and when to receive data from other 
stations. It is ensured that all stations get a chance to use the communication lines 
and other resources of the network depending upon the priorities assigned to them. 

 
vi. Connection establishment:  When two stations of a network want to communicate 

with each other, the communication protocol establishes and verifies a connection 
between the two. 

 
vii. Data security:  Providing data security and privacy is also built into most 

communication software packages it prevents access of data by unauthorized users 
because it is relatively easy to tap a data communication line. 

 
viii. Log information: Data communications software’s can also develop log 

information which consists of all jobs and data communications tasks that taken 
place. Such information is normally used for financial purposes and the various 
users of the network are charged accordingly. 
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6.4.3 Need for Protocol Architecture 
When any two computer based entities wish to exchange data there must exist more than 
just a physical data path between the two communicating devices. There has to be some 
amount of co-operation between the two devices to enable the data transfer to take place. 
Some typical tasks that need to be performed for the data transfer to take place are: 
 

i. The source system must set up the communication path or inform a remote network 
of the identity of the system it wishes to communicate with. 

 
ii. The source system must determine whether the remote system is ready to accept 

data. 
 
iii. The file transfer application on the source system must make sure that the file 

management program within the remote system is ready to accept the data from the 
source. 

 
iv. If there is any incompatibility between the two system's file formats, one of the 

systems must perform a format translation. 
 

v. If data are lost, there must be some recovery system. 
 
vi. When the data transfer is complete, the systems must inform each other of their 

readiness to break the connection. 
 
vii. The tasks described above are a highly simplified view of the process that actually 

takes place and the logic to implement this co-operation is too complex to be 
installed as a single module. Instead, this logic is broken down into a set of sub-
tasks, each of which is implemented separately. 

 
viii. In protocol architecture, the logic modules are arranged in a vertical stack. Each 

layer of this stack performs a subset of the entire logic necessary to communicate 
with a remote system. Layers should be designed so that changes in one layer do 
not affect any higher or lower layers. 

 
ix. This stack of logic modules must be implemented in both of the machines that wish 

to communicate. Communication is achieved by corresponding, or peer levels in 
both machines communicating with each other. Each of these peer levels 
communicate according to a set of rules or conventions that are known as a 
protocol. 
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-------------------------------------------------------------------------------------------------------------- 

6.5 OSI AND TCP/IP MODEL 
-------------------------------------------------------------------------------------------------------------- 

6.5.1 ISO and Other Models 
 Figure 6.11 shows the reference model of the Open Systems Interconnection (OSI), which 
has been developed by the International Standards Organization (ISO). We will briefly 
define the functions and operation of each layer of this architecture in turn. 
 
Layer 1: the Physical Layer 
This layer is concerned with transmitting an electrical signal representation of data over a 
communication link. Typical conventions would be: voltage levels used to represent a “1” 
and a “0”, duration of each bit, transmission rate, mode of transmission, and functions of 
pins in a connector. An example of a physical layer protocol is the RS-232 standard. 
 
Layer 2: the Data Link Layer 
This layer is concerned with error-free transmission of data units. The data unit is an 
abbreviation of the official name of data-link-service-data-units; it is sometimes called the 
data frame. The function of the data link layer is to break the input data stream into data 
frames, transmit the frames sequentially, and process the acknowledgement frame sent 
back by the receiver. Data frames from this level when transferred to layer 3 are assumed to 
be error free. 
 
Layer 3: the Network Layer 
This layer is the network control layer, and is sometimes called the communication subnet 
layer. It is concerned with intra-network operation such as addressing and routing within 
the subnet. Basically, messages from the source host are converted to packets. The packets 
are then routed to their proper destinations. 
 
Layer 4: the Transport Layer 
This layer is a transport end-to-end control layer (i.e. source-to-destination). A program on 
the source computer communicates with a similar program on the destination computer 
using the message headers and control messages, whereas all the lower layers are only 
concerned with communication between a computer and its immediate neighbors, not the 
ultimate source and destination computers. The transport layer is often implemented as part 
of the operating system. The data link and physical layers are normally implemented in 
hardware. 
 
Layer 5: the Session Layer 
The session layer is the user’s interface into the network. This layer supports the dialogue 
through session control, if services can be allocated. A connection between users is usually 
called a session. A session might be used to allow a user to log into a system or to transfer 
files between two computers. A session can only be established if the user provides the 
remote addresses to be connected. The difference between session addresses and transport 
addresses is that session addresses are intended for users and their programs, whereas 
transport addresses are intended for transport stations. 
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Layer 6: the Presentation Layer 
This layer is concerned with transformation of transferred information. The controls 
include message compression, encryption, and peripheral device coding and formatting. 
 
Layer 7: the Application Layer 
This layer is concerned with the application and system activities. The content of the 
application layer is up to the individual user. 

 

 
Fig 6.11 Layers, Protocols & interfaces 
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Fig. 6.12 The OSI model 
 
 
6.5.2 How the OSI Model Works 
At the top of the model in the application layer are the actual programs operated by the 
computer users, such as email clients or web browsers.  On the bottom is the physical layer 
comprised of the network media that makes the actual physical connection between 
computers.  In between lie all the layers that make the actual communication occur. 
 
Each computer on a network needs to have a protocol stack, sometimes called a protocol 
suite, which provides the software necessary for the computer to communicate on the 
network.  TCP/IP is the most common protocol suite.  These stacks are comprised of 
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several different protocols that perform the functions of the various layers of the OSI 
Reference Model. 
 
When an application sends information from one computer to another, the data is passed 
down through the protocol stack on the sending computer, across the network, and then up 
through the protocol stack on the receiving computer.  At each level of the process, 
information is attached to the data as it is sent.  On the receiving end, this information is 
stripped off until the original data is finally available to the receiving application.  
 
6.5.3 Key words and concepts from the OSI model 

Application – Layer 7 
E-mail 
FTP 
Client/Server 
TCP 

Presentation – Layer 6 
Encryption/decryption 
ASCII to EBCDIC 
TCP 
 
Session – Layer 5 
Traffic Light or mediator 
Maintains order 
TCP 

Transport – Layer 4 
Checks for lost or incomplete transmissions 
End to end validity 
TCP 

Network – Layer 3 
WAN 
Node to node transmission 
CSU/DSU 
Switching functions 
IP, IPX, SNA, AppleTalk 

Data Link – Layer 2 
LAN 
Checks integrity of transmissions 
Router functions 
LAN types:   
Bus- Ethernet  
Ring-Token Ring, Sonet, FDDI 
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Star-Mainframe, Switched Ethernet 
MAC addressing 
CSMA/CD 
ATM 

Physical – Layer 1 
Plugs and connectors (RJ-11: telephone use; RJ-45: Ethernet use) 
Sonet 
Wiring 
Unshielded vs. Shielded Twisted Pair (Cat 3, Cat 5, 10baseT) 
Thin-net vs. thick-net Coax (Ethernet) 
Single-mode Vs Multimode Fiber 
 
6.5.4 The TCP/IP model 
TCP/IP is based on a four-layer reference model. All protocols that belong to the TCP/IP 
protocol suite are located in the top three layers of this model. 
 
As shown in the following figure, each layer of the TCP/IP model corresponds to one or 
more layers of the seven-layer Open Systems Interconnection (OSI) reference model 
proposed by the International Standards Organization (ISO). 
 
 

 

 
Fig 6.13 TCP/IP Model 

 
The types of services performed and protocols used at each layer within the TCP/IP model 
are described in more detail in the following table. 
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Layer  Description  Protocols  

Application Defines TCP/IP application protocols and how 
host programs interface with transport layer 
services to use the network. 

HTTP, Telnet, 
FTP, TFTP, 
SNMP, DNS, 
SMTP, 
X Windows, 
other application 
protocols 

Transport Provides communication session management 
between host computers. Defines the level of 
service and status of the connection used when 
transporting data. 

TCP, UDP, RTP 

Internet Packages data into IP datagram, which contain 
source and destination address information that 
is used to forward the datagram between hosts 
and across networks. Performs routing of IP 
datagram. 

IP, ICMP, ARP, 
RARP 

Network 
interface 

Specifies details of how data is physically sent 
through the network, including how bits are 
electrically signaled by hardware devices that 
interface directly with a network medium, such 
as coaxial cable, optical fiber, or twisted-pair 
copper wire. 

Ethernet, Token 
Ring, FDDI, 
X.25, Frame 
Relay, RS-232, 
v.35 

 
Note 

• The OSI reference model is not specific to TCP/IP. It was developed by the ISO in 
the late 1970s as a framework for describing all functions required of an open 
interconnected network. It is a widely known and accepted reference model in the 
data communications field and is used here only for comparison purposes. 

 
6.5.5 Internetworking with TCP/IP 
In today's computing environment, the hierarchical, terminal-based networks of the past are 
becoming less important. Modern computer networking technologies allow organizations 
to construct flexible enterprise inter networks that permit intelligent computing devices of 
all types to be interconnected to solve business problems. TCP/IP, which is an acronym for 
Transmission Control Protocol/Internet Protocol, represents a particularly important 
form of internetworking technology that allows organizations to extend the reach of their 
computing systems. 
 
The term TCP/IP refers to a set of protocols, or a protocol suite, that defines the rules 
governing how messages are exchanged in a computer network. The TCP/IP protocol suite 
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grew out of a research project that began in 1969 and was funded by the U. S. Department 
of Defense. The TCP/IP protocols are based on the packet-switching ideas developed for an 
early research computer network called the ARPANET, whose acronym was based on the 
name of the Advanced Research Projects Agency (ARPA) that funded its development. 
ARPA is now known as the Defense Advanced Research Projects Agency (DARPA). The 
early ARPANET tied together a number of research computers using conventional leased 
telecommunications lines. 
 
The original idea behind the TCP/IP protocol suite was to define a standard set of 
procedures to allow individual computer networks to be connected to the ARPANET. 
Today, the main purpose of the TCP/IP protocol suite is to allow diverse types of physical 
networks to be tied together so that any networked computer can talk to any other 
computer. The TCP/IP protocols allow the interconnected individual networks to give the 
appearance of a single, unified network-called an internet-in which all computers can freely 
exchange data as if they were all directly connected. The TCP/IP protocols make it appear 
to a system that there is a simple point-to-point connection to any other system in the 
internet, even though data might have to follow a quite complex path in traveling from one 
system to another. 
 
--------------------------------------------------------------------------------------------------------- 
6.6 THE FUTURE OF INTERNET TECHNOLOGY  
-------------------------------------------------------------------------------------------------------------------------------------------------------------- 

From the humble beginning in the late 60s, today internet spans the whole world with 
hundreds of millions of computers connected to it (500 million in 2004 estimated). The 
remarkable achievement of the internet technology is that it has been able to accommodate 
exponential growth (i.e., doubling each year) of the number of computers connected to it. 
Also the speed of computers has been doubling every year and there are a variety of 
computers connected to the internet. Individual LANs in an organization may use one of a 
variety of interconnections and local protocols for communication. The physical connection 
between computers may range from fast gigabit fiber optics to slower wireless. In spite of 
this variety of technologies and speeds internet still works effectively. The reason for this is 
the universal adoption of TCP/IP as the standard protocol which has proved very robust in 
spite of rapid changes in technology. TCP/IP protocol emerged as a result of cooperative 
effort in which a large number of persons participated and experimented before accepting 
any version. The internet protocol accommodates a variety of hardware and a variety of 
network speeds as it makes no assumptions regarding the underlying network hardware. 
Packet switching ensures efficient and fault tolerant routings of packets. TCP ensures 
reliable receipt of all packets sent by a sender to a receiver. It continuously monitors traffic 
conditions on the internet and automatically adapts when there is congestion in the 
network. 

 
The only major problems currently faced by the internet are: 

1. IP addresses are limited to 32 bits and the number of requests for addresses will 
exceed this limit soon. 

2. Originally the major traffic on the internet was e-mail and character files. Now 
multimedia use has increased and one expects to send audio and video files in real 
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time for which internet was not designed. 
 

To meet these demands a new generation internet protocol called IPv6 has been proposed 
which is expected to replace IPv4, the current protocol. Currently extensive research and 
experiments are in progress to test IPv6. Thus IPv6 may slowly replace the current protocol 
(IPv4) over the next few years. The major new features proposed in IPv6 are: 

 
1. 128 bit addresses for source and destination in place of 32 bits which is the current 

address size. This address size will allow a huge increase in allowed devices to be 
connected to the internet. 

2. The packet lengths can go upto 64 KB. This will allow easy transfer of multimedia 
data, particularly voice. 

3. The protocol has a feature to specify the kind of data being transmitted and will 
permit real-time multimedia data to be given priority in transmission. 

4. The proposed protocol improves security of data being sent over the internet. 
 
It is thus clear that internet has come to stay and will continue to grow in the coming years. 
With increasing use of wireless and mobile systems one may see even ordinary household 
systems such as refrigerators, ovens, etc., connected to the internet and controlled remotely. 
 
-------------------------------------------------------------------------------------------------------------- 
6.7 INTERNET PROTOCOLS 
--------------------------------------------------------------------------------------------------------------------------------------------------------------------- 

Let us try to find the meaning of protocols in real life. In our day-to-day life, protocols are 
a set of procedures and customs that aid in communication and relationships between 
people. Many times the term is used in governmental foreign relations and other similar 
human dialogue. When used in the context of computer networking, a protocol has a 
similar meaning, but is more specific. A network protocol is the set of very detailed rules, 
sequences, message formats, and procedures that computer systems use and understand 
when exchanging data with each other.  
 
In other words, a network protocol (which includes all of the Internet protocols) is the term 
used to describe how computer systems communicate with each other at the bit and byte 
level. Network protocols are layered on top of each other, with each layer providing 
additional capabilities, but using the facilities provided by the lower layer.  
Depending upon their capabilities, we can divide the Internet Protocols in two categories: 
 
6.7.1 Low Level Protocols 
Let's start with the lowest-level Internet protocol, and gradually move upwards to the 
higher levels.  
 
IP: The most fundamental protocol is called IP, i.e. 'Internet Protocol'. IP is responsible 
only for transmitting each chunk of data from one system to another. It needs to know only 
the network location of source and destination computer in which data is to be sent back 
and forth. 
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The common term for a network location is 'address', and each system on the Internet has 
an address. This address is called an IP address, and there are two formats for an IP 
address.  
 
Internally, each computer system uses an IP address that is composed of four numbers, 
usually written for humans with dots between each number. An example IP numeric 
address is ‘178.127.201.1’. However, since it's easier for humans to remember names 
instead of numbers, most IP addresses have corresponding English-like names, also 
separated with dots. The previous address can be written as a name as 'halcon.com'. 
 
Scattered throughout the Internet are systems with the responsibility of translating Internet 
name addresses into the IP address numeric form. These systems are called 'name servers'. 
In general, it is better to use an Internet name address rather than the IP numeric address. 
This is because IP numeric addresses can sometimes change for a given location, and the 
change will be transparent if you are using the Internet name address rather than the IP 
numeric address. However, the name servers have to be updated.  
 
Occasionally you do need to use the numeric form of an Internet address, and most Internet 
applications allow you to enter either format. Another term used in conjunction with 
Internet name addresses is 'host name', because every Internet address must correspond to a 
computer system (a 'host') somewhere on the Internet. The systems that provide IP name to 
number translation are called 'Domain Name Servers', or DNS.  
 
TCP and UDP: We have just seen how systems communicate at a very low level, using IP 
addresses in either a numeric or name form to identify each other. The IP layer doesn't 
provide many capabilities other than sending chunks of data back and forth. Much more is 
needed than that, which is where TCP and UDP come in.  
 
TCP, which is an abbreviation for 'Transmission Control Protocol', is very common on 
the Internet, and is almost always mentioned together with IP, making the acronym TCP/IP 
(TCP running on top of IP).  
 
The TCP protocol provides a virtual connection between two systems, along with certain 
guarantees on the data chunks (called 'packets') that are passed between the systems. Two 
guarantees are retransmission of packets that are dropped (because of some network 
problem), and ensuring that the packets are received in the same order that they are sent 
(there can be multiple routes that a packet can take while traversing the Internet).  
 
A third guarantee is that each packet received by the application has exactly the same 
content as when it was sent. If a bit has changed or been dropped for some reason, TCP 
will detect it and cause the packet to be re-transmitted.  
 
Some applications use a different protocol running on top of IP called UDP ('User 
Datagram Protocol'). UDP sends data one chunk at a time (called a 'datagram') to the 
other system and doesn't provide a virtual connection like TCP does. UDP also doesn't 
provide the same guarantees that TCP does, which means that datagram may be lost or 
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arrive out of sequence. Each received datagram is checked for internal integrity (like TCP), 
but if it has been corrupted it is dropped, rather than re-transmitted (as TCP does).  
 
You might be wondering why UDP is used instead of TCP since UDP is not as reliable as 
TCP. To provide the extra guarantees, TCP has a lot of overhead compared to UDP, which 
makes TCP slower than UDP. For applications where performance is more important than 
reliability, UDP makes more sense. Some examples include audio and video streaming 
over the Internet, and Internet phone applications.   
 
SLIP and PPP: Many people are now connecting to the Internet (through an Internet 
Service Provider, commonly abbreviated as ISP) by dialing up through a modem. Since IP 
wasn't designed to be used over dial-up lines, this requires yet another protocol.  
 
SLIP and PPP both allow IP data to be sent over dial-up lines. SLIP is an abbreviation for 
'Serial Line IP' and PPP is short for 'Point-to-Point Protocol'. Both take IP data and 
package it up so that it can be sent over modem dial-up lines. PPP is considered to be 
newer and better than SLIP, although many Internet providers continue to support SLIP 
dial-up access.  
 
While connected to an ISP using SLIP or PPP, your system is now another location on the 
Internet, with its own IP address. Your account with the ISP may assign you a permanent, 
fixed IP address and name, or it may provide what is called a 'dynamic' IP address. Since at 
any given time only a subset of dial-up lines are in use for an ISP, the provider may assign 
an IP number (and also typically an IP name) from a pool of available addresses.  
 
6.7.2 High Level Protocols 
At this point we know a little bit about how different systems communicate with each other 
on the Internet at the lower protocol levels. Your workstation or PC is most likely on a 
LAN that is connected to the Internet, or using PPP or SLIP to dial-up to an ISP. TCP/IP or 
UDP/IP is used to send packets of information back and forth from your system to a remote 
system somewhere on the Internet. Now let's discuss the higher-level applications that are 
using a client / server relationship to send information back and forth. These higher-level 
applications are actually the things used on the Internet. That is why high-level protocols 
are also known as Internet Application Protocols. 
 
FTP and Telnet: FTP ('File Transfer Protocol') is a way to upload and download files on 
the Internet. Downloading and uploading are two basic processes used on the Internet. 
Downloading is the process of transferring the data from the Internet to the local computer, 
while uploading is the reverse process i.e. transferring the data from the local computer to 
the Internet. 
 
Typically a site on the Internet stores a number of files (they could be application 
executables, graphics, or audio clips, for example), and runs an FTP server application that 
waits for transfer requests. To download a file to your own system, you run an FTP client 
application that connects to the FTP server, and request a file from a particular directory or 
folder. Files can be uploaded to the FTP server, if appropriate access is granted. FTP 
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differentiates between text files usually ASCII (American Standard Code for Information 
Interchange), and binary files (such as images and application executables), so care must be 
taken in specifying the appropriate type of transfer.  
 
When an Internet site makes files available to the general public, this is called 'anonymous' 
FTP. A password does not need to be supplied, although the user e-mail address is typically 
requested. Some sites have confidential files or directories, and an FTP login and password 
is needed to download or upload.  
 
Telnet is a way to remotely login to another system on the Internet. The Telnet allows you 
to remotely connect into other computers and access them just as if you were sitting 
directly in front of them. A telnet server must be running on the remote system, and a telnet 
client application is run on the local system. When you are logged in to a system using 
telnet, it is as if you were logged in locally and using the operating system command line 
interface on the telnet server system. Typical operating systems for telnet servers are 
UNIX, Windows NT, and VMS.  
 
HTTP:  HTTP stands for 'HyperText Transfer Protocol'. It is the primary protocol of the 
World Wide Web (WWW). When a Web browser (such as Internet Explorer or Netscape) 
connects to a Web server, it uses HTTP to request Web pages. A Web browser is an 
Internet client application, and the Web server is an Internet server application.  
 
HTTP has the ability to transfer Web pages, graphics, and any other type of media that is 
used on the Web. HyperText Markup Language (HTML) the internal format of Web pages. 
HTML consists of a set of tags and internal commands that are embedded inside Web 
pages to control the appearance and layout of Web pages, as well as links to other Web 
pages.  
 
-------------------------------------------------------------------------------------------------------------- 
6.8 WORLD WIDE WEB 
--------------------------------------------------------------------------------------------------------------
Since we have learnt about the Internet advantages and the famous tools available with the 
Internet, it is the time now to look at a very interesting topic i.e. World Wide Web 
(WWW). World Wide Web is a system of Internet servers that uses HTTP to transfer 
specially formatted documents. The documents are formatted in a language called HTML 
(HyperText Mark-up Language) that supports links to other documents, as well as graphics, 
audio, and video files.  
 
Hypertext refers to a computer-based document in which words or phrases are cross-
referenced and a user can easily jump between these cross-references by selecting the 
highlighted word.  For example, the word web here is highlighted, indicating that it is a 
hypertext link to another document. 
 
A related term is hypermedia, which means that graphics, audio and video are also used as 
cross-referenced items. One can jump from one document to another simply by clicking on 
hyperlinks.  
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Here are some of the advantages of WWW:  

 
• Standard Interface: Because the web presents a standard interface to FTP, News, 

e-mail, gopher and other Internet tools, as well as a standard way of accessing 
information through web pages and databases through forms, the web has become 
an invaluable tool for simple access to the net.  

• Formatted Output: The Web supports formatted text. You can have:  
 

 Headings of a number of sizes... 
while normal text can be formatted in a number of ways, including: bold, 
italicized, super or sub-scripted. You can also have lists and tables.  

 Hypertext: As mentioned above, web pages use hypertext links to provide a 
very easy and straightforward way to navigate around the net. Hypertext links 
can be within a document, between web pages on the same computer or 
between web pages on different computers. Hypertext links can also be between 
graphics, audio and video.  

 Multimedia: One of the big advantages the web over earlier systems such as 
telnet-based programs and gopher is that it is multimedia capable.  

 
Any of the graphical browsers (like Internet Explorer and Netscape Navigator) 
can display formatted text, as well as GIF images. Some browsers can also 
handle JPEG images. You can also have images embedded in your web page, 
like this structure:  

 
If you want to view a file that your browser can't read, then you can easily 
configure your browser to call up another program to view the file. This means 
that you can send any type of data file across the web: MPEG or QuickTime 
movies, WAV sound files, Excel spreadsheets, PhotoCD photos, postscript 
files... the list is endless. The best solution of this type is a plug-in, which is 
installed as part of your browser. We will study about browsers and plug-ins in 
more details later in the chapter. However you can configure your browser to 
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feed files with a specific extension to a particular program. Excel files, for 
example, with a .xls extension would open up MS Excel.  

 Interactive Pages: With forms, users can interact with web pages to obtain 
dynamic or customized information. A typical example of form is the 
registration form that you have to fill up while registering for an email account. 

 
 

 
 

Fig 6.14 Registration Form for an email account   
 
------------------------------------------------------------------------------------------------------------- 
6.9 E-Mail 
------------------------------------------------------------------------------------------------------------- 

E-mail is an abbreviation for Electronic Mail. It is a way of sending messages from one 
computer user to another computer user. The mail could be sent between two people using 
the same computer or between two people on different sides of the world.  
 
Advantages of E-Mail 
 

 Speed: Because e-mail is based around computer networks, it is fast - much 
faster than standard mail (otherwise known as snail mail). An e-mail message 
that you send to someone in Finland or Brazil could take only a few seconds to 
reach them.  

 Cost: Depending on how you have obtained your Internet access, e-mail is free 
or very cheap, much cheaper than the 45 cents it takes to send a standard letter 
within Australia.  

 Flexibility: With the new MIME e-mail system being used today, you aren't 
limited to text in your e-mail messages. You can include pictures, sound files, 
movies, data files from your favorite spreadsheet program, etc.  
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--------------------------------------------------------------------------------------------------------------
6.10 SEARCH ENGINES 
-------------------------------------------------------------------------------------------------------------- 

Search engines are automated computers owned by companies such as Google, AltaVista, 
Yahoo etc that spend all of their time day and night surfing the Internet. 
A search engine helps you find information on the Internet. To use a search engine, you 
must enter a word (or words) that you expect will be in the Web pages or newsgroup 
messages you're looking for, then click a Search button. The search engine will look 
through its collection of documents for Web pages and newsgroup messages containing 
these keywords. 
Search engines can be used to find Web sites in many languages. Your computer's ability to 
process accented letters and other characters will determine whether you can search for 
French sites, or sites in any other language. 
 
Advantages of using a search engine 

• They are very comprehensive  
• The flexibility of indexing every word gives users complete search control  

 
Disadvantage 

• Submitting queries to search engines can result in millions of results  
 
6.10.1 Types of Search Engines 
 

• Crawler-Based Search Engines: Crawler-based search engines, such as Google, 
create their listings automatically. They "crawl" or "spider" the web, then people 
search through what they have found. If you change your web pages, crawler-based 
search engines eventually find these changes, and that can affect how you are listed. 
Page titles, body copy and other elements all play a role. 

 
• Human-Powered Directories: A human-powered directory, such as the Open 

Directory, depends on humans for its listings. You submit a short description to the 
directory for your entire site, or editors write one for sites they review. A search 
looks for matches only in the descriptions submitted. Changing your web pages has 
no effect on your listing. Things that are useful for improving a listing with a search 
engine have nothing to do with improving a listing in a directory. The only 
exception is that a good site, with good content, might be more likely to get 
reviewed for free than a poor site. 

 
• Hybrid Search Engines: In the web's early days, it used to be that a search engine 

either presented crawler-based results or human-powered listings. Today, it is 
extremely common for both types of results to be presented. Usually, a hybrid 
search engine will favor one type of listings over another. For example, MSN 
Search is more likely to present human-powered listings from LookSmart. 
However, it does also present crawler-based results, especially for more obscure 
queries. 
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-------------------------------------------------------------------------------------------------------------- 
6.11 REVIEW QUESTIONS 
-------------------------------------------------------------------------------------------------------------- 

1. What is a LAN? What are its main objectives? 
2. Describe layering concepts in the OSI model of network architecture with functions 

of each layer. 
3. Who actually controls the internet? 
4. What are the advantages and disadvantages of Internet? 
5. Why High-level protocols are called Application protocols? 
6. What are the differences between Low-level and high-level Internet Protocols? 
7. What are E-Mail Etiquettes? Discuss. 
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-------------------------------------------------------------------------------------------------------------
OFFICE AUTOMATION SYSTEMS - PART I  

-------------------------------------------------------------------------------------------------------------- 

Structure 
7.1 MS Word –I 
 7.1.1 What Is Word Processor 
 7.1.2 Starting Microsoft Word 
 7.1.3 Key Terminologies 
 7.1.4 Opening and Formatting Documents 
 7.1.5 Formatting Page 
 7.1.6 Inserting a Table  
 7.1.7 Inserting a Picture  
 7.1.8 Inserting Page Numbers and Date/Time  
 
7.2 MS Word – II 
 7.2.1 Autocorrect Facility 
 7.2.2 Spelling and Grammar  
 7.2.3 Macros 
 7.2.4 Mail-Merge in Microsoft Word 2000  
 7.2.5 Create a Template 
 7.2.6 Style 
 
7.3 MS-Excel-I 
 7.3.1 Working with Worksheet 
 
7.4 MS Excel-II 
 7.4.1 Using Excel's Built-In Functions  
 7.4.2 What-if Analysis 
 7.4.3 Data Table sorting  
 
7.5 MS-Excel-III 
 7.5.1 Graphs and Charts 
 
7.6 Review Questions 
 
-------------------------------------------------------------------------------------------------------------- 
7.1 MS WORD – I 
--------------------------------------------------------------------------------------------------------------
Over the centuries, we as human beings have always felt the need to communicate and 
share our ideas and thoughts.  The written word has always remained the best and the most 
effective way of interaction irrespective of the place and nature of job of the person.  
Sometimes, writing a note comes more easily to us than conveying it verbally.  We often 
prefer to talk to our distant friends and relatives by way of writing only.  At times, it is far 
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easier to express our feelings by setting them down on paper rather than saying them orally.  
Any kind of formal or informal message can be best sent across by penning it down. 
 
Once the whole work of writing is done, you would be very anxious to read it through to 
check for any grammatical errors or spelling mistakes.  If there are any, then imagine the 
disappointment you will have to face because then it will demand the pains of writing the 
whole document again.  Similar kinds of problems are faced with our old conventional 
typewriter also.  A small change in the typewritten text would involve retyping the entire 
text again.  Now, as and when the work of writing the whole document is over, we must 
concentrate our attention at the final look of the document.  The document has to be made 
attractive with text neatly and properly organized within margins.  Paragraphs are required 
to be indented with reasonable spacing between lines.  Finally, the document should be free 
from all kinds of spelling mistakes and grammatical errors.  This is a universal truth that a 
neatly organized and well formatted document is definitely more appealing to the reader's 
eye. 
 
The following things are to be kept in mind while giving a neat and formal look to your 
document. 
 

 A long document should be broken down into small paragraphs. Proper line spacing 
should be given. 

 
 The words at the end of the line should not be incomplete. 

 
 The important words and headings should be highlighted either by way of 

underlining them or by putting them in different font and size. 
 

 There should not be any grammatical and spelling mistakes.  The text should be 
placed properly between margins. 

 
 Inspite of taking all the efforts and precautions, we cannot keep track of all the 

above mentioned requirements.  Now, for easing our job, software called 'Word 
Processor' has come to our rescue.  A Word Processor can do all of these things 
without any hassle. 

 
7.1.1 What Is Word Processor 
Word processing includes typing in text and manipulating it so as to give a very 
systematic and organized look to your document, which enables easy reading.  The 
application software or program, which helps us in processing the text, is called ’Word 
Processing Software' or simply a 'Word Processor’.   
 
So, you can say that a word processor is nothing but a computer program that helps you to: 
type your text, correct spelling mistakes and grammatical errors align text within margins 
offer a variety of font styles and font sizes see a preview of the text that you have typed in. 
The commonly used word processing packages are:  
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• MS-WORD,  
• Word Star 
• Word Perfect 
• Professional Write 

 
Normally, a word processor can accomplish the following tasks: 
 

 Brochures 
 Newsletters 
 Reports 
 Advertisements 
 Resumes and Cover letters 
 Books 
 Directories 
 World Wide Web Pages 

 
There is absolutely no end to what a word processor can do.  By now you must have 
realized that the word processing applications have become much more sophisticated than 
before. 
 
7.1.2 Starting Microsoft Word 

1. Double click on the Microsoft Word icon on the desktop.  

 

2. Click on Start --> Programs --> Microsoft Word  

 

Fig 7.1  
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Fig 7.2 

7.1.3 Key Terminologies 

 
Fig 7.3 (a) 
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Fig 7.3 (b) 

 
Fig 7.3 (c) 
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Fig 7.3 
(d)

 
Fig 7.3 (e) 

 
Fig 7.3 Key Terminologies 
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Viewing the toolbars  
The toolbars in Microsoft Word provide easy access and functionality to the user. There are 
many shortcuts that can be taken by using the toolbar. First, make sure that the proper 
toolbars are visible on the screen.  

1. Click View  
2. Select Toolbars  
3. Select Standard, Formatting, and Drawing  
4. Other toolbars can be selected if you wish 

 

 

Fig 7.4 

Name Icon Description 

New Blank Document  
Creates a new, blank file based on the default 
template. 

Open (File menu)  Opens or finds a file. 

Save (File menu)  
Saves the active file with its current file name, 
location, and file format. 

Mail Recipient  
Sends the contents of the document as the body of 
the e-mail message. 

Print (File menu)  
Prints the active file or selected items. To select print 
options, on the File menu, click Print. 

Print Preview (File menu)  Shows how a file will look when you print it.  
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Spelling and Grammar 
(Tools menu)  

Checks the active document for possible spelling, 
grammar, and writing style errors, and displays 
suggestions for correcting them. To set spelling and 
grammar checking options, click Options on the 
Tools menu, and then click the Spelling and 
Grammar tab.  

Cut (Edit menu)  
Removes the selection from the active document and 
places it on the Clipboard. 

Copy (Edit menu)  Copies the selection to the Clipboard. 

Paste (Edit menu)  

Inserts the contents of the Clipboard at the insertion 
point, and replaces any selection. This command is 
available only if you have cut or copied an object, 
text, or contents of a cell. 

Format Painter (Standard 
toolbar)  

Copies the format from a selected object or text and 
applies it to the object or text you click. To copy the 
formatting to more than one item, double-click , 
and then click each item you want to format. When 
you are finished, press ESC or click again to turn 
off the Format Painter.  

Undo (Edit menu)  
Reverses the last command or deletes the last entry 
you typed. 

Redo (Edit menu)  Reverses the action of the Undo command. 

Hyperlink  
Inserts a new hyperlink or edits the selected 
hyperlink. 

Tables and Borders  

Displays the Tables and Borders toolbar, which 
contains tools for creating, editing, and sorting a 
table and for adding or changing borders to selected 
text, paragraphs, cells, or objects. 

Zoom Enter a magnification between 10 and 400 percent to 
reduce or enlarge the display of the active document. 

Office Assistant  The Office Assistant provides Help topics and tips to 
help you accomplish your tasks. 

 
Table 7.1 Basic Terminologies of Tool Bar 

 
7.1.4 Opening and Formatting Documents 
 
Opening a document: If your document is stored on any of the storage devices like hard 
disk or floppy disk, then it becomes possible to retrieve that document and the user can 
manipulate it the way he/ she wants. WORD offers a variety of ways to open your 
documents which are discussed below: 
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Method 1: Opening a document from desktop 
Click at the Start button.  Point at 'Open Office Document and click it . Alternatively, click 
at the option 'Open Office Document’ of the Office shortcut bar available on the desktop. 
 
Method 2: Opening a document from Word’s startup screen 
Click at the 'File' menu and select the option 'Open'  
 
Alternatively, for opening a document, just double-click at the 'Open' button from the 
standard toolbar.  This icon looks exactly similar to a file folder. 
 
One very important thing to observe here is that - an 'Open' dialog box appears on the 
screen after employing any of the above mentioned methods of opening a document.  In 
this 'Open' dialog box you would notice a 'look in' box which is used for selecting the drive 
as well as the folder where your required document is resident in.  Then, there is 'Files of 
Type' box which helps you to select the kind of file that you want to open.  Suppose you 
want that only the WORD documents should be shown in the file list, then click at the pull 
down arrow and from the drop down list, select 'Word Documents' option.  In case you 
want to see all the files in the selected drive, then select 'All Files' option from the drop 
down list.  Finally click the filename in the file list and click at the <Open> button or 
double click the filename to open up the file. 
 
Creating a New Document  

1. Click on File  
2. Select New  

o To create a blank document, simply select Blank Document. To create a 
document based on one of the templates provided in Microsoft Word, select 
which one you would like to create and select OK  

Saving a document 
For future retrieval of the document, it needs to be saved on hard disk or floppy disk.  Once 
all the text is entered, save the document with any of the following methods: 
 
Method 1: Click at the 'File' menu and then select 'Save' option.   When the file is being 
saved for the very first time, the 'Save as' dialog box comes up because WORD needs some 
additional information from you. 
 
Firstly, WORD wants you to give a name to your file.  This has to be given in the 
'Filename' box.  Secondly, the kind of file you are trying to save, should be given in the 
'Save as type' box.  Thirdly, the place where you want to save your document should be 
given in the 'Save in' box.  After giving all this information, click at the <Save> button.  
Your file is finally saved onto the disk. 

 
The 'Save as' dialog box is displayed only once till the time you don't give a name to your 
document.  Once the document has a name, next time if you try to save your file after 
making a few changes in it, then the 'Save as' dialog box will not appear on the screen. 
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Method 2: The other way of saving you r files is by clicking at the 'Save' button available 
on the standard toolbar. It's a good idea to keep saving your documents after every few 
minutes.  The reason is if the computer goes down or a power failure occurs, then the 
chances of recovering something in the document are high.  Unsaved new documents are 
the most vulnerable. 
 
Closing a document 
WORD offers a very handy method of closing documents.  Like, you would prefer to close 
and remove the office files that are no more required on your table, in the similar manner 
you may want to close WORD documents too.  So, for closing a file, click at the 'File' 
menu and select the 'Close' option. This will close the file that is recently opened.  As many 
documents are opened in WORD, you are required to issue 'File - Close' commands for 
those many times to close all the files one by one. 
 
Exiting Word 
To quit WORD or to close the WORD application program, click at 'File\Exit' option. With 
this command, all the currently opened documents are also closed automatically.  WORD 
will again prompt you to save your files before quitting. 
 
Formatting Text 
  

1. Highlight the text that you want to format by dragging your mouse over while 
holding down the left mouse button  

2. Change the text to your desire  
3.  

o  

Formatting Documents 
Each one of us have a hidden desire that the reader should feel interested in whatever we 
are trying to convey.  So, for achieving this, a special effort on our front is required.  We 
must give a refined look to the document.  The formatting features like fonts, bullets and 
numbering, font type etc. can be used very intelligently to create the whole impact.  Now, 
let us proceed further learning about these special features smartly. 

 
Defining Font Type and Size of Text 
A font can be defined as a set of letters that have a common or the same typeface.  
Different font types and sizes can be applied using the formatting toolbar or the Format 
menu.  Let's discuss them one by one. 
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Using Formatting Toolbar: The formatting toolbar is designed very artistically.  
 

 
 
It contains most of the tools that need to be used to give a complete and wholesome look to 
your document.  The toolbar also shows you the font type and size as applied to your text.  
It also displays the effects (Bold, Italic or Underline) as given to the text.  For applying a 
font type and size to your text, use the formatting toolbar in following steps: 
 

1. Select the text. 
2. Click at the arrow beside the font type box and select a font type of your choice 

from the drop down list. 
3. Again, click at the arrow beside the font size box and select an appropriate font size 

from the drop down list. 
 
Using Format Menu: The required font type and size can also be applied to the text by 
using 'Format Menu’ as described in the following steps: 
 

1. Select the text. 
2. From the 'Format' menu, select the 'Font' option.  The 'Font' dialog box appears on 

the screen. 
 

 
 

Fig 7.5 Font Dialog Box 
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3. Choose appropriate font type from the 'font' box.  You can move up or down in the 

'Font' box with the help of up and down arrow keys. 
4. Similarly, choose the required font style and size for your text from the 'Font style' 

and 'Size' boxes respectively. 
5. The preview of the selected text can be seen in the 'Preview' window with the 

applied formatting features. 
6. Click <OK> button. 

 
You will find the look of your text changing with the application of new font type, style 
and size. 
 
Making Text Bold, Italic & Underlined Using Formatting Toolbar: If you have 
given a keen look at the formatting toolbar, then you must have observed three buttons 
showing the letters B, I and U. The letter 'B' stands for Bold, '1' for Italic and 'U' for 
Underline. In order to make your text look a bit darker then the rest of the document, 
concentrate on the following steps: 
 
1. Select the text. 
2. Click at the 'B' button. 
 
On carrying out these steps, the 'B' button becomes depressed or lightened.  If you do not 
want the text to be bold, select the text again and click at the 'B' button.  This button on the 
toolbar again becomes prominent and your text is not bold anymore. 
 
At times you would like to see your text in italics or would like to underline it.  To do this, 
do the following steps: 
 
1. Select the text. 
2. Click at 'U' button to underline and ‘I’ button to italicize it. 
 
Alternatively, the same work can also be done using the 'Format' menu by following steps:  
 

1. Select the text. 
2.  Click at the 'Font' option of the 'Format' menu. 
3. In the 'Font' dialog box, activate the 'Bold' option or 'italic' option from the 'Font 

style' box to show your text in bold or italics. 
4.   In order to underline the text, select the required option from the 'Underline' box 

drop down list. 
 
If you are a keyboard person, you can also use one or more of the following key sequences 
to achieve the same, after selecting the text: 
 
Press <Ctrl + B> keys to bold the text 
Press <Ctrl + 1> keys to italics the text 
Press <Ctrl+ U> keys to underline the text 
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Fig 7.6 
 
Changing Case of Text: WORD offers a quick and handy way to change the case of your 
text.  Lowercase characters can easily be changed to uppercase by hitting <Shift + F3> 
keys.  To achieve the contrary effect, press the <Shift + F3> keys again.  This would 
convert uppercase characters to lowercase. 
 
Alignment of Text: Text alignment means placement of text between the margins.  Your 
text can be left, right, centre aligned or it can be justified within the margins.  Left 
alignment of text would mean the arrangement of text evenly in a straight line at the left 
side of the document but with uneven edges on the right side.   
 
Right aligned text is just the opposite of left aligned text with text evenly arranged at the 
right edge of the document but uneven from the left side.  Justified text would involve even 
edges of text along both margins.  Centre aligned text means that the text is placed exactly 
in the centre of the page.  Centre aligned text is most suitable for giving titles, headings etc.  
Generally and most frequently the text is left aligned because then the text becomes easily 
readable and understandable.  Now, let us find out how text can be aligned using the 
formatting toolbar. 
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1. Select the text (it could be a single line or a paragraph or the whole document). 
2. Click at any of the alignment buttons from the formatting toolbar to get the desired 

result.  
 
If you are more in the habit of using keyboard, then give the following keyboard shortcuts 
after selecting the text: 
 
Press <Ctrl + L> keys to left align the text Press <Ctrl + R> keys to right align the text 
Press <Ctrl + E> keys to show the text in the center. 
 
Formatting Paragraphs: Formatting means deciding alignment of the paragraph.  It also 
includes the spacing that is to be put in between the lines.  In order to carry out formatting 
on paragraph, it needs to be selected first.  Then go to the 'Format' menu and do the 
following steps: 
 

1. From the 'Format' menu, select 'Paragraph' option.  A 'Paragraph' dialog box shoots 
up on the screen. 

  

 
 

Fig 7.7 Paragraph 
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2. You can set the alignment i.e. decide the placement of text on the screen by clicking 
on the dropdown arrow of the 'Alignment' box.  Your whole of the paragraph can be 
left, right or center aligned. 

3. Go to the 'Line Spacing' box and click at the drop down arrow to make a choice.  
Finally click at the <OK> button.  In the 'Line Spacing' box there are many options 
that need a bit of elaboration.  Let us find them.  For the options 'At least', 'Exactly' 
and 'Multiple', a number has to be given in the 'At' box.  In these cases, the space is 
measured (between the lines) in terms of print size.  The 'At least' option uses the 
space as given in point size but it can also use some extra space in a case where it 
needs to accommodate some text.  'Exactly' option gives exactly the same space as 
defined in the 'At' box.  If word needs extra space to adjust some more text, then it 
cannot get it.  'Multiple' option allows you to specify the line spacing of your own 
choice.  If you want the lines to be triple spaced then type '3' in the 'At' box. 

EXERCISE  

Create a First-line Indent 

 

1. Place your cursor anywhere within the first paragraph of the sample text you 
created in Exercise 2.  

2. Choose the Home tab.  
3. In the Paragraphs group, click the launcher. The Paragraph dialog box appears.  
4. Choose the Indents and Spacing tab.  
5. Click to open the drop-down menu on the Special field.  
6. Click First Line.  
7. Enter 0.5" in the By field.  
8. Click OK. The first line of your paragraph is now indented half an inch.  
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Bullets and Numbering: It is always advisable to put the text entries, which are separated 
by commas in the bulleted or the numbered form.  Adding bullets to the text makes it easy 
to read and understand.  Major points can be very well emphasized through this technique.  
Points put in the order of preference are long remembered by the reader.   
 
Moreover, in our day to day life, we prefer to make our daily list in the numbered manner 
rather than putting it in a paragraph.  The only idea is that the chances of forgetting are 
turned low and visibility of important points is clearer.  You can put bullets or numbers in 
an existing list by using either the formatting toolbar or the 'Format' menu. 
 
Using Formatting Toolbar 
1. Select the text. 
2. Click at either the 'Bullets' button or the 'Numbers' button on the formatting toolbar. 
 
In case you decide that you don't require 'numbers' or ‘bullets’, you can very easily put 
them off by repeating the above steps. This method perhaps offers a wider choice of 
symbols other than the typical black circle.  Let us discuss this method: 
 
1. Select the text. 
2. Select the 'Format-Bullets and Numbering' option. 
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A 'Bullets and Numbering' dialog box appears on the screen(see figure below) . Select the 
'Bulleted' tab in case you want bullets in your document.  If you wish to put numbers then 
select the 'Numbered' tab.  Choose any of the bullets or numbers and apply it onto your 
document by clicking <OK> button.  You see how easy it is to place bullets and numbers in 
your document. 
 

 
 

Fig 7.8 
 
7.1.5 Formatting Page 
Page Setting: Page setting includes putting your text neatly between margins.  Margins are 
nothing but an invisible frame within which the whole text appears.  When a blank new 
document is opened, a default margin is always there.  This margin is laid for sides, top and 
bottom of the page.  You can always fiddle with the default settings of WORD according to 
your demand and requirements.  We will learn to set margins by two methods: 
Margin Setting through File / Page Setup 
 
The default setting of the top and bottom margin is 1 inch and in the sides, it is 1.25 inches.  
To modify the default margin setting, follow the steps given below: 
 

1. Select 'Page Setup' option of 'File' menu. A 'Page Setup' dialog box appears on the 
screen. 
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Fig 7.9 
 

2. Click in the 'Top' box and erase off the current setting by using either the <Del> key 
or the <Backspace> key from the keyboard.  Type in the desired number.  
Alternatively, you can use the top arrow to increase the margin and down arrow to 
decrease it. 

3. Similarly, change the settings in the Bottom, Left and Right boxes as well. 
 
At times, you might want that the changes that have been made recently should apply to the 
current document only, and then click at <OK> button.  But in case, you want that the 
current document as well as any other new document that you open should have these page 
settings, then click at the <Default> button.  The next step would be to click at the <Yes> 
button in which case WORD is trying to seek your permission in changing the default 
settings for page setup. 
 
Setting Margins using Ruler Line: Ruler line is very frequently used to change margins.  
It is a quick and easy way to set margins but needs some amount of practice also.  To set 
margin using the ruler line, carry out the steps discussed below: 
 

1. Place your mouse pointer on the left side of the horizontal ruler line.  Slowly, move 
the mo use pointer towards your right side till the place where your mouse pointer 
acquires the shape of a double-headed arrow.  A 'Left Margin' tool tip appears on 
the screen.  

2.  Click at that location and drag the mouse towards right side to increase the margin 
or on the left side to reduce it. 

3.  Release the mouse button when suitable margin is attained. 
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In order to set right margin, the method is just the same as discussed in the above three 
steps.  If you observe closely, you will find a thin gray line above the 'Right Indent' button 
which is in the extreme right of the Ruler Line.  This is the Right Margin Line.  Place the 
mouse pointer at this line and click on it.  Drag the pointer in either direction to increase or 
decrease the right margin.  Finally, release your mouse button. 
 
Now, let us learn how to set the top and bottom margins using the vertical ruler line.  This 
vertical ruler line appears only in the Page Layout view.  So, in a case if your vertical ruler 
line is not apparent on the screen, then first switch yourself to Page Layout view by 
selecting 'Page Layout' option from the 'View' menu.  To set the top margin: 
 

1. Take your mouse pointer on the thin gray line that appears between the darkened 
and white areas on the top side of the vertical ruler line. 

2. As soon as your mouse pointer takes the shape of a double headed arrow, click and 
drag it either upwards or downwards to attain the desired top margin. 

3. Release the mouse button. 
 
When you are trying to play with the margins, a line is shown across the page which keeps 
moving up or down according to the movement of your mouse pointer.  This gives you the 
exact location of your margin on the page. 
 
7.1.6 Inserting a Table  

 
1. Click where you want your table to go. 
2. To create a four-column, five-row table 
3. Choose Table > Insert > Table from the menu. The Insert Table dialog box opens.  
4. Type 4 in the Number of Columns field.  
5. Type 5 in the Number of Rows field.  
6. Select Auto in the Column Width field. Selecting Auto allows Microsoft Word to 

determine the size of your column widths. Alternatively, you can enter the column 
width you desire.  

7. Click OK. Your table should look like the one shown here, with four columns and 
five rows 
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Fig 7.10 Table  
 
Alternate Method -- Creating a Table by Using the Insert Table Icon:  
 
You can also create a table by clicking on the Insert Table icon on the Standard toolbar.  
 
1. Click the Insert Table icon.  

 
 

2. Highlight the number of rows and columns you need. The maximum table size you can 
create by this method is a four-row by five-column table.  

 

 
3. Press Enter (or click) to create the table.  
 
Note: Microsoft Word has a Tables and Borders toolbar. This lesson does not cover the 
Tables and Borders toolbar.  
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Moving Around a Table: Each block in a table is called a cell. Use the Tab key to move 
from cell to cell from left to right. Use Shift-Tab to move from cell to cell from right to left. 
The following exercise demonstrates.  
 

1. Click in the first cell in the first column.  
2. Press the Tab key nine times. The cursor moves forward nine cells.  
3. Press Shift-Tab six times. The cursor moves backward six cells.  

Note: You can also move to a cell by clicking in the cell. In addition, you can move around 
the table by using the left, right, up, and down arrow keys.  
 
Entering Text into a Table:  To enter text into a table, simply type as you normally 
would. Press Tab to move to the next cell. Enter the text shown below into your table. 
  

1. Type Salesperson in the first cell in the first column. Press the Tab key.  
2. Type Dolls in the first cell in the second column. Press the Tab key.  
3. Continue until you have entered all of the text.  

 
Salesperson Dolls Trucks Puzzles 
Kennedy, Sally 1327 1423 1193 
White, Pete  1421 3863 2934 
York, George  2190 1278 1928 
Banks, Jennifer  1201 2528 1203 

 
Selecting a Row and Bolding the Text: You learned about bolding in Lesson Three. In 
this exercise, you will select the first row of the table and bold all of the text on the row.  
Click anywhere on the first row of your table.  
 
Choose Table > Select > Row from the menu.  
Press Ctrl-b to bold the row.  
 
Right-Aligning Text: You learned about alignment in Lesson Five. In this exercise, you 
will right-align the second (Dolls), third (Trucks), and fourth (Puzzles) columns of the table 
you created.  
You need to highlight "Dolls," "Trucks," and "Puzzles." Place the cursor before the "D" in 
"Dolls." Press the F8 key to anchor the cursor. Then press the right arrow key until you 
have highlighted "Dolls," "Trucks," and "Puzzles."  
Choose Table > Select > Column from the menu.  
Press Ctrl-r to right-align the cells.  
 
Your table should look like the one shown here. Make any needed corrections before 
continuing.  
Note: All of the formatting options you learned about in previous lessons can be applied to 
cells in a table.  
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Adding a New Row to the End of the Table  
You can add additional rows to your table. The simplest way to add a new row is to move 
to the last column of the last row and press the Tab key. You can then type any additional 
text you need to add.  

1. Move to the last column of the last row of your table.  
2. Press the Tab key.  
3. Type the text shown here.  
 

Atwater, Kelly 4098 3079 2067 
 
Adding a Row within the Table  
You can add a new row anywhere in the table. The exercise that follows demonstrates.  
To add a row just above York, George:  
 

1. Place the cursor anywhere in the fourth row (the row with York, George as the 
salesperson).  

2. Choose Table > Insert > Rows Above from the menu.  
3. Add the information shown here to the new row.  
 

Pillar, James  5214 3247 5467 
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Resizing the Columns  
You can easily change the size of your column widths. In this exercise, you will select the 
entire table and adjust all the column widths.  

1. Click anywhere in your table.  
2. Choose Table > Select > Table from the menu. Your table is selected.  
3. Choose Table > Table Properties from the menu.  
4. Choose the Column tab.  
5. Type 1" in the Preferred Width field. This will cause Microsoft Word to set all the 

columns to a width of one inch.  
6. Click OK.  

 
Depending on your font, the first column of your table might not be wide enough and the 
text might be wrapping.  

 
To widen the first column:  
 

1. Place the cursor anywhere in the first column.  
2. Choose Table > Select > Column from the menu.  
3. Choose Table > Table Properties from the menu.  
4. Choose the Column tab.  
5. Type 1.5 in the Preferred Width field.  
6. Click OK.  

 
Alternate Method -- Resizing Your Column Widths by Using the Width Indicator  
You can resize your column widths by placing the cursor on the line that separates two 
columns. This causes the width indicator to appear. After the width indicator appears, left-
click and drag with the mouse to adjust the column width.  
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Adding a New Column to a Table  
You can add new columns to your table. To add a new column between the Salesperson 
and Dolls columns:  

1. Place the cursor anywhere in the Dolls column.  
2. Choose Table > Insert > Columns to the Left from the menu.  
3. Label the new column Region and add the text shown in the table below.  
 

Salesperson Region Dolls Trucks Puzzles 
Kennedy, Sally S 1327 1423 1193 
White, Pete N 1421 3863 2934 
Pillar, James N 5214 3247 5467 
York, George S 2190 1278 1928 
Banks, Jennifer S 1201 2528 1203 
Atwater, Kelly S 4098 3079 2067 

 
Sorting a Table 
With Microsoft Word, it is easy to sort the data in your table. To sort your table data by 
Region and within Region by Salesperson in ascending order:  

1. Click anywhere on your table.  
2. Choose Table > Sort from the menu.  
3. Select Region in the Sort By field.  
4. Select Text in the Type field (because you are sorting text). 
5.  Select Ascending.  
6. Select Salesperson in the Then By field.  
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7. Select Text in the Type field (because you are sorting text). 
8.  Select Ascending. 
9.  Select Header Row (because your table has titles across the top of the table).  
10. Click OK.  

 
Microsoft Word should have sorted your table like the one shown here:  
   

Salesperson Region Dolls Trucks Puzzles 
Pillar, James N 5214 3247 5467 
White, Pete N 1421 3863 2934 
Atwater, Kelly S 4098 3079 2067 
Banks, Jennifer S 1201 2528 1203 
Kennedy, Sally S 1327 1423 1193 
York, George S 2190 1278 1928 

 
Deleting a Column  
You can delete columns from your table. To delete the Trucks column:  

1. Place your cursor anywhere in the Trucks column.  
2. Choose Table > Delete> Columns from the menu.  

 
Deleting a Row  
You can delete rows from your table. To delete the York, George row:  

1. Place your cursor anywhere in the York, George row.  
2. Choose Table > Delete > Rows from the menu.  

 
Merge Cell 
Using Microsoft Word, you can merge cells -- turn two or more cells into one cell. In this 
exercise, you are going to create a new row at the top of your table, merge the cells, and 
add a title to the table.  

1. Move to the cell located on the first row of the first column of your table (the 
Salesperson cell).  

2. Choose Table > Insert > Rows Above from the menu.  
3. Choose Table > Merge Cells from the menu.  
4. Type Toy Sales in the new cell.  
5. Press Ctrl-e to center the title.  

 
Table Headings  
If Microsoft Word splits your table with a page break, the table heading will display on the 
first page but not on subsequent pages. To correct this problem, you can designate rows as 
headings. Heading rows are repeated on the top of your table at the top of each page. To 
designate a row as a heading:  

1. Place your cursor on the row.  
2. Choose Table > Heading Rows Repeat from the menu.  
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Converting Text to a Table  
You can convert text to a table; however, a delimiter such as a comma, paragraph marker, 
or tab must separate columns of text. In the exercise that follows, you will convert comma-
delimited text into a table.  

1. Type the following as shown (do not bold).  
Color, Style, Item  
Blue, A980, Van  
Red, X023, Car  
Green, YL724, Truck  
Name, Age, Sex  
Bob, 23, M  
Linda, 46, F  
Tom, 29, M  

2. Highlight the text.  
3. Choose Table > Convert > Text to Table from the menu.  
4. Type 3 in the Number of Columns field.  
5. Select Auto in the Column Width field.  
6. Select the Commas radio button in the Separate Text At frame.  
7. Click OK.  

Microsoft Word should have converted your text to a table and your table should look like 
the one shown here.  
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Splitting a Table  
With Microsoft Word, splitting a single table into two tables is easy. To separate the table 
you just created into two tables:  

1. Place your cursor anywhere on the row that reads "Name, Age, Sex."  
2. Choose Table > Split Table from the menu.  

You should now have two tables.  
 
Table AutoFormat  
You can use AutoFormats to apply borders, shading, special fonts, and color to your table. 
Microsoft Word lists all Formats in the Table AutoFormat dialog box. While in the Table 
AutoFormat dialog box, click a format to see that format displayed in the Preview box. You 
can customize how the format is applied. Check the features you want in the Formats to 
Apply and the Apply Special Formats To frames. Microsoft Word comes with a long list of 
AutoFormats.  
To apply an AutoFormat to your Name, Age, and Sex table:  

1. Click anywhere in the table.  
2. Choose Table > Table AutoFormat from the menu.  
3. Click Table Colorful 1 in the Table Styles box.  
4. Select Heading Rows and First Column in the Apply Special Formats To frame. Do 

not select Last Row and Last Column.  
5. Click Apply.  

Your table should look like the one shown here.  
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Table Properties 
Use the Table Properties dialog box to modify the alignment of the table with the body 
text and the text within the table. Access the box by selecting Tables|Table Properties. 
 

 
 

 Size - Check the Preferred width box and enter a value if the table should be an 
exact width.  

 Alignment - Highlight the illustration that represents the alignment of the table in 
relation to the text of the document.  

 Text wrapping - Highlight "None" if the table should appear on a separate line 
from the text or choose "Around" if the text should wrap around the table.  

 Borders and Shading - Select from a number of border styles, colors, and widths. 
Click the Shading tab to change the background color and pattern. 
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 Options - Click the Options button on the Table Properties window. To change 
the spacing between the document text and the table borders under Default cell 
margins. Check the Allow spacing between cells box and enter a value to add 
space between the table cells. 

 

 
Save File  
Save your file by following these instructions:  

1. Choose File > Save As from the menu.  

http://www.studynama.com/?utm_source=pdf&utm_medium=downloaded_file&utm_campaign=studynama_referral


 173

2. Specify the correct folder in the Look In field.  
3. Name your file by typing lesson7.doc in the File Name field.  
4. Click Save.  
5. Choose File > Exit from the menu to close Microsoft Word.  

 
 
7.1.7 Inserting a Picture  
When choosing a clip to add to your document, keep in mind that just about anything can 
be adjusted.  You can size, crop, add lines and fill effects, use a layout that lets you type 
text over the clip and more.  To insert clipart: 

1. Place the insertion point in the location where clipart is to be added. 
2. From the Insert menu, choose Picture and Clipart.  The Insert Clipart dialog box 

displays as below. 
 

 
Fig 7.11 Clip Art 

 
Note the Favorites category that you can add often used clips to for easy access.  You'll 
find out how below.  Also note, that there is a Search for clips field available for your use.  
Clipart in Word is categorized and related to keywords.  By typing a keyword in this box 
and pressing Enter, Word will search for all clips associated with that word regardless of 
the category. 

3. Click on a category that suits your needs.  In our example, we've chosen 
"Entertainment".  The first page of clips immediately displays. 

4. To navigate through the clipart pages, use the arrows outlined in yellow below, or 
click on Keep Looking to go to the next page. 
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5. Click on the image you want to insert.  A shortcut menu appears.  This little 

shortcut menu can be a valuable tool - see the explanations in the graphic below. 

 
The last tool, which finds clipart that is similar, can be great if you need more than one clip 
to insert with the same theme or if you like the look of one and want to see other clipart 
with the same artistic effect. 

 
6. Once you are sure have located the right clip, click and choose the Insert Clip 

button or right-click on the clip and choose Insert Clip. 
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The clipart is inserted in your document, but it probably needs some adjusting to fit your 
needs. 
 
Modifying Clipart   
The first thing you should know about modifying clipart, is how to adjust the size.  When 
you single-click on clipart, the clipart is selected and square "nodes" appear on the corners 
and sides, as below. 

 
To resize: 
A double arrow is displayed when hovering the mouse over one of these nodes.  Holding 
the mouse button down, drag to reduce or enlarge the image.   
To have more control over adjusting the size, hold down the Alt key while dragging.  This 
allows for more precise adjustments. 
Note:  The nodes on the corners adjust the size proportionally, and do not distort the 
image.  More than likely, you will want to use the corner nodes to adjust size.  The nodes 
on the bottom and top adjust the height only, and the nodes on the sides adjust the only the 
width.  Take a look at the following comparison. 
 

 
Size adjusted with corner node.

(no distortion) 
 

Size adjusted with side node. 
(distortion) 

To crop: 
You can also use the Picture toolbar to adjust brightness, crop, change the layout, etc.  To 
use the picture toolbar, select the clipart, then right-click on the existing toolbars at the top 
of your screen and choose Picture.  The toolbar is displayed. 
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This same toolbar is used when you insert a picture from a file - like a family photo.  If you 
crop a picture, you cut out part of the picture along one of the sides.  So, let's pretend our 
clipart is a family photo and cut out our mother-in-law!   

1. Choose the Crop tool, as above. 
2. Move your mouse over one of the top, bottom, or side nodes.  The crop tool appears 

along with your mouse. 
3. Hold the mouse button down and drag to crop.  Note that you can also press the Alt 

key here while dragging for greater control. 

 
Other useful Picture toolbar tools: 
If tools or selection options are grayed out, it is because the tool is only available when 
inserting a picture file such as a JPEG or GIF. 

 The first button on the toolbar inserts a picture from a file into your document.  You 
will not use this tool when working with clipart. 

 The second tool is Image Control.  You can use this tool to grayscale your clipart 
or make it black and white.  We'll discuss a watermark later on. 

 
 Following image control, are buttons that can be used to increase or decrease the 

contrast and brightness of the clipart. 
 The Text Wrapping tool tells word how you want to treat text that surrounds the 

clipart.  For example, you might want to type text over the clipart and use it as a 
background. 
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 The Format Picture tool (paint bucket) opens the Format Picture dialog box, 
which is discussed in the next section of this tutorial. 

 And last but not least, if you are not satisfied with the adjustments you have made, 
the Reset Picture button on the end of the toolbar resets the clipart to its original 
state. 

The Format Picture Dialog Box   
The methods discussed so far, are ones that I find are the easiest to use.  However, you can 
also make modifications with the Format Picture dialog box.  It allows you to make many 
changes at one time, and has a few additional features. 
The easiest way to access the Format Picture dialog box is to double-click on the clipart. 

 
 
The Picture tab is displayed first by default.  As you can see, there are fields for cropping 
and image control.  Exact measurements and percentages can be used here to adjust 
cropping, brightness, and contrast.  However, I find the Picture toolbar discussed earlier to 
be more "friendly".  Personally, I could spend all day going to this box and adjusting 
measurements, etc. - but if I use the Picture toolbar, I can see my changes immediately and 
modify accordingly. 
In the following example, some of the more useful features are demonstrated by creating a 
watermark of our clipart that we can type text over for a newsletter title. 

1. Select Watermark from the Color field. 
2. Move to the Colors and Lines tab of the dialog box and select Patterned Lines 

from the Line, Color field. 
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The Patterned Lines dialog box appears as below. 

 
3. Select a pattern and choose Foreground and Background colors to match your 

clipart.  A preview is shown in the Sample field. 
4. Choose OK. 
5. Next, move to the Layout tab. 
6. Use the picture examples and choose a Wrapping style.  In our example, we need 

Behind text. 

 
7. Choose OK on the Format Picture dialog box.  Our clipart now looks like the 

example below. 
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8. Move your insertion point and type text as you would in any document. 

 
When you choose to have Behind text as the layout, you are allowed to move the image 
around on your screen.  In this case, we want to move the image down and a bit to the right. 

9. Select the image.  Move your mouse to the middle of the image, hold the button 
down, and drag the clipart to the proper location.  Remember, you can press and 
hold the Alt key for more precise movement. 

 
Voila!  We're finished.  Clipart can be an amazing addition to your documents.  It takes a 
little time and practice, but is well worth the effort! 

 
7.1.8 Inserting Page Numbers and Date/Time  
 

1. Click Insert at top of screen  
2. Select Page Numbers and/or Date & Time  
 

 

http://www.studynama.com/?utm_source=pdf&utm_medium=downloaded_file&utm_campaign=studynama_referral


 180

-------------------------------------------------------------------------------------------------------------- 
7.2 MS WORD – II 
-------------------------------------------------------------------------------------------------------------- 
7.2.1 Autocorrect facility 
Microsoft Word's AutoCorrect facility can automatically correct common spelling mistakes 
and often-used acronyms, initialisms etc.  AutoCorrect can be turned on and off from the 
Tools menu:  

1. Go to the Tools menu and select Options.  
2. Click the Spelling & Grammar tab.  
3. In the Spelling area, check (on) or uncheck (off) the Check spelling as you type 

checkbox.  
Adding entries to AutoCorrect  
To manually add entries to AutoCorrect:  
Go to the Tools menu and select AutoCorrect (Word 2000) or AutoCorrect Options (Word 
XP/2003).  
In the AutoCorrect: English (Australia) dialog, go to the Replace field and enter the 
incorrect word or acronym/initialism (eg. organize, ATO).  
In the with field, enter the correct word or full text of the acronym/initialism (eg. organize, 
Australian Taxation Office).  

• Click the Add button.  
• Click the OK button.  

Now, if you were to type: 'The ATO site can tell you how to organize your records', Word 
would automatically change the sentence to read: 'The Australian Taxation Office site can 
tell you how to organize your records, as you type.  

 
Fig 7.12 Autocorrect dialog box 

http://www.studynama.com/?utm_source=pdf&utm_medium=downloaded_file&utm_campaign=studynama_referral


 181

 
If you're using spell checking as you type, you can also add entries through the right-click 
menu:  

1. Right-click the underlined word and select AutoCorrect.  
2. From the sub-menu list of options, select the replacement word.  

 

 
 
Note: AutoCorrect can be used for phrases as well as single words. If you find yourself 
constantly using phrases such as 'give consideration to' instead of 'consider', or 'in the near 
future' instead of 'soon', you can tell MS Word to automatically correct the phrase as you 
type.  
 
AutoCorrect Options buttons  
In Word XP/2003, you can also manage auto-corrections using AutoCorrect Options 
buttons. To turn on AutoCorrect Options buttons:  
Go to the Tools menu and select AutoCorrect Options.  
Tick the Show AutoCorrect Options buttons checkbox.  
Click the OK button.  
 
Now, whenever Word makes an auto-correction, you can backspace (or move your mouse) 
to the correction to display the auto-correction underline:  

 
However over the underline to show the AutoCorrect Options button, and then click the 
button to display options:  
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Change back    : Undoes the correction for this one instance. 
 
Stop Automatically Correcting : Undoes the correction for this one instance, and then 
deletes the auto-correction so it will not happen again. 
 
AutoCorrect Options buttons remain available for each correction until the document is 
closed. If you change your mind about changing an auto-correction, open the button again 
and select Redo AutoCorrect.  
 
Deleting entries from AutoCorrect  
To delete entries from AutoCorrect: 
  

1. Go to the Tools menu and select AutoCorrect (Word 2000) or AutoCorrect Options 
(Word XP/2003).  

2. Click the Spelling & Grammar tab.  
3. Scroll through the list at the bottom of the tab and click on the entry to be deleted.  
4. Click the Delete button.  
5. Click the OK button.  

 
7.2.2 Spelling and Grammar  
Word will automatically check for spelling and grammar errors as you type unless you turn 
this feature off. Spelling errors are noted in the document with a red underline. Grammar 
errors are indicated by a green underline. To disable this feature, select Tools|Options from 
the menu bar and click the Spelling and Grammar tab on the dialog box. Uncheck 
"Check spelling as you type" and "Check grammar as you type", and click OK. 
 
To use the spelling and grammar checker, follow these steps: 
 

• Select Tools / Spelling and Grammar from the menu bar.  
• The Spelling and Grammar dialog box will notify you of the first mistake in the 

document and misspelled words will be highlighted in red. 
• If the word is spelled correctly, click the Ignore button or click the Ignore All 

button if the word appears more than once in the document.  
• If the word is spelled incorrectly, choose one of the suggested spellings in the 

Suggestions box and click the Change button or Change All button to correct all 
occurrences of the word in the document. If the correct spelling is not suggested, 
enter the correct spelling in the Not In Dictionary box and click the Change 
button.  

• If the word is spelled correctly and will appear in many documents you type (such 
as your name), click the Add button to add the word to the dictionary so it will no 
longer appear as a misspelled word.  
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As long as the Check Grammar box is checked in the Spelling and Grammar dialog 
box, Word will check the grammar of the document in addition to the spelling. If you do 
not want the grammar checked, remove the checkmark from this box. Otherwise, follow 
these steps for correcting grammar: 
 

 If Word finds a grammar mistake, it will be shown in the box as the spelling errors. 
The mistake is highlighted in green text. 

 

 
 

 Several suggestions may be given in the Suggestions box. Select the correction that 
best applies and click Change.  
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 If no correction is needed (Word is often wrong more than it is right), click the 
Ignore button.  

 
Synonyms 
Word 2000 has a new feature for finding synonyms. Simply right-click on the word and 
select Synonyms from the shortcut menu. From the list of suggested words, highlight the 
word you would like to use or click Thesaurus... for more options. 
 

 
 
Thesaurus 
To use the thesaurus, select Tools | Language |Thesaurus from the menu bar or select it 
from the Synonyms shortcut menu as detailed above. 
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A list of meanings and synonyms are given on the windows. Double-click on the words in 
the Meanings box or click the Look Up button to view similar words. Double-click words 
in the Replace with Synonym box to view synonyms of those words. Highlight the word 
you would like to add and click the Replace button. 
 
7.2.3 Macros 
Do you always perform repeated tasks in Microsoft Word? Repeated tasks, if not 
automated are prone to human errors.  If you perform a task repeatedly in Microsoft Word, 
you can automate the task by using a macro. 

A macro is a series of Word commands and instructions that you group together as a single 
command to accomplish a task automatically.  Since not all of us are programmers who can 
write code in Visual Basic, I will show you a way to create macros without even writing 
code. 

First open up your Word document then click Tools > Macro > Record New Macro 

 

Fig 7.13 Selecting Macros 

According to the help document the macro recorder in Word acts like a tape recorder. It 
records your deliberate keystrokes and mouse button clicks … when you record a macro, 
you can use the mouse to click commands and options, but not to select text.  

You must use the keyboard to record these actions. For example, you can use F8 to select 
text and press END to move the cursor to the end of the line. Remember that it records 
keystrokes and mouse clicks only. 
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When you record a macro it will ask for a macro name so assign it a descriptive macro 
name.  After that, click the OK button to record the macro. 

 

Once you see the recording toolbar, enter the keystrokes that you want to record.  In the 
example below I indented the first line of the paragraph (TAB) then I selected all (Control-
A) then I applied the bold format (Control-B).  After this I stopped the recording of macro 
by clicking the stop button. 
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The macro will be saved and you can run it by clicking the run macro command (or Alt-F8) 
from the Tools menu. 

 

Before the macro run: 

 

After the macro run: 

 

 

Now that you know how to make macros by recording keystrokes and mouse clicks, apply 
this tip on your own repeated tasks.  This will increase your productivity and also you 
quality of work. 
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7.2.4 Mail-Merge in Microsoft Word 2000  
Click Tools > Mail Merge 

 
 

 
 

The Mail Merge Helper opens. Mail Merge is a three step process. 
 

 
 

Fig 7.14 Mail Merge 
 
Step 1: 
Click Create to choose the document type. Click on the document type that you will be 
creating. On the next screen choose to use the current document as the Merge Document.  
 
Click Edit to edit the current document. 
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Step 2: 
Click Get Data. This gets enabled once Step 1 is completed. Choose from the Get Data list 
where the contacts are stored.  

 
 
When the data source is chosen, a message will warn that no Merge Fields are in the 
current document and will ask to insert Merge Fields in the document. Click "Edit Main 
Document" on this message to enter Merge Fields in the document.  
Merge Fields are placeholders for where the Contact's real information will be inserted by 
the wizard. 
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Click in the appropriate place in the document that you want to insert Merge Fields.  
From the Mail Merge toolbar Click "Insert Merge Field" and Click the Merge Field to 
insert into the document. The Merge Field will appear as "<<Company>>" in the 
document. 
 
Click "ABC" to view the document with the merged data. 
 
Click "Mail Merge Helper" button on the Mail Merge Toolbar. 
 
Step 3: 
 
Click Merge on the Mail Merge Helper screen.  

 

 
 

On the next screen Click Merge. 
 

Separate documents with the Merge Fields replaced by the actual contact details will be 
created. 
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The Mail Merge process is complete. Use this Mail Merged document to send faxes to 
multiple recipients using the Fax Merge feature in Fax4Word. 
 
How to Fax Merge 
Once you have created a Mail Merge document, all you need to do is... 
 
Click "Fax Merge" on the Fax4Word toolbar in MSWord. 
 

 
 
In the Fax Merge screen, fill the details from the drop down list and choose the appropriate 
fields from the list for Name, Company and Number. 
 
Note: Number is required. 

 
 
 

Click "Fax Only" to send the fax. 
Select a printer from the drop down list for "Use this printer to print a paper copy for 
filing". 
To send fax and print a copy of the sent fax click "Fax and Copy" on the Fax Merge screen. 
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The fax will be sent when "Fax only" or "Fax and Print" is clicked. To view the status of 
the faxes being sent, go to Fax Console. (Click Start > All Programs > Accessories > 
Communications > Fax > Fax Console). 
The Fax Merge is completed and multiple faxes are sent with just a few clicks. 
 
7.2.5 Create a Template 
Templates are a special type of Word document that can hold text, styles, macros, keyboard 
shortcuts, custom toolbars and AutoText entries. A document created using a template will 
have access to all of these features and a large part of your job in creating a new document 
will be done for you if your templates are well thought out. You don't need to use all (or 
even any) of these features for templates to help you and those with whom you work. 
 
Using Templates 

• A template sets what text, formatting and graphics will automatically appear in the 
new document. The template is a base pattern of content for a document. 

• Templates can be created for expense reports, status reports — any document that 
is used repetitively. 

• Templates not only save you time, they allow for a custom editing environment, 
store tools to edit a document effectively, store Styles, store automated macro 
procedures, and store AutoText boilerplate 

 
Accessing Library Templates 
 

 The built-in Template Library gives you access to more than 40 preset templates 
from within Word. 

 From the main menu, choose File > New to open the New Document pane, and 
click on General Templates to open the Templates dialog box: 

 
To select a Template from the Templates dialog box: 

 From the main menu, choose File > New to open the New Document panel 

 Click on General Templates to open the Templates dialog box. 

 Select the required template. The Preview area will show a thumbnail image of the 
template. 

 Select the Template option in the Create New options area. 

 This will create the item as a template rather than a one-time document. 

 Click OK. 

 The new template will open. Make any adjustments if needed, and save with a 
different name under a different folder. 
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Modifying a Template 
 

 The templates in the Template Library and on the Microsoft.com Website cannot 
be altered until they have been saved in an alternate folder on the hard drive with a 
different name. 

 Once saved, open the template, and make any alterations required. 
 
To save a modified Template: 

 From the main menu, choose File > Save As to save the template as a template file. 

 Confirm that Document Template is selected in the Save as type field. 

 Once all selections are set and confirmed, click Save. 
 The various template tabs allow you to select and use templates to create Letters, 

Faxes and Memos, do a Mail Merge, etc. 

 Most of the templates have built-in directions that cover where to enter information 
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Fig 7.15 Templates 
 
 
7.2.6 Style 
When working with Word, you can use styles to quickly format your documents. A style is 
a set of formats consisting of such things as fonts, font colors, font sizes, and paragraph 
formats. Word 2007 supplies you with pre-designed style sets that contain styles for titles, 
subtitles, quotes, headings, lists and more. The sections that follow all show you how to 
work with styles. Click Save Target As from the menu that appears, and save the linked file 
to a directory on your computer. Then open the file. 
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EXERCISE: 

Choose a Style Set 

 

1. Choose the Home tab.  
2. Click Change Styles in the Styles group. A menu appears.  
3. Click Style Set. A menu appears. You can choose from any of the styles listed on 

the menu.  
4. Click Simple. Word 2007 reformats all of the paragraphs into the Simple style by 

applying the Normal format to each paragraph.  

Apply a Style 
You can see of all the styles available to you in the style set by clicking the launcher in the 
Styles group and opening the Styles pane. You can leave the Styles pane open and 
available for use by docking it. To dock the Styles pane, click the top of the pane and drag 
it to the left or right edge of the Word window.  

You do not need to select an entire paragraph to apply a style. If the cursor is anywhere in 
the paragraph, when you click on the style, Word formats the entire paragraph. 
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EXERCISE: 

Apply the Title Style 

 

1. Choose the Home tab.  
2. Click the launcher in the Styles Group. The Styles pane appears. You can drag it to 

the side of the Word window to dock it. To close the Styles pane, click the Close 
button in the upper right corner of the pane .  

3. Click anywhere in the paragraph "Single-Parent Family—Career Help."  
4. Click Title in the Styles pane. Word 2007 applies the Title style to the paragraph.  

Headings and subheadings mark major topics within your document. With Word 2007, you 
can easily format the headings and subheadings in your document.  

Apply Headings 
1. Click anywhere in the paragraph "The Nature of Single Parenthood."  
2. In the Style box, click Heading 1. Word reformats the paragraph.  
3. Repeat steps 1 and 2 in the following paragraphs:  

• Types of Single Parents  
• Career Development Needs of Single Parents  
• Career Development Programs  

Apply Subheadings 
1. Click anywhere in the paragraph "Displaced Homemakers"  
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2. In the Style box, click Heading 2. Word reformats the paragraph.  
3. Repeat steps 1 and 2 for the following paragraphs:  

• Displaced Homemakers  
• Adolescent Mothers  
• Single Fathers  
• High School Dropout Prevention  
• Established Education Sites  

Alternate Method -- Apply Styles with the Ribbon 
You can also choose styles by selecting the option you want from the Styles group on the 
Ribbon. First you must place your cursor in the paragraph to which you want to apply the 
style. Then you click the More button in the Styles group to see all of the styles in the 
currently selected set. As you roll your cursor over each of the styles listed, Word 2007 
provides you with a live preview of how the style will appear when applied. 

1. Select the paragraphs "Emotional Support" through "Parenthood Education" (they 
are probably on page two).  

2. Click the More button in the Styles group.  
3. Locate and click the List Paragraph style. Word applies the List Paragraph style to 

the paragraphs you selected.  

Change Style Sets 
Once you have applied styles, changing to another style set is easy. You simply open the 
Style Set gallery. As you move your cursor down the menu, Word 2007 provides you with 
a live preview of the effect of applying the style set. To choose a style set, you click it. 

EXERCISE: 
Change Style Sets 

1. Click Change Styles in the Styles group. A menu appears.  
2. Click Style Set. A menu appears. As you move your cursor down the menu Word 

2007 provides you with a live preview of the effect of applying the Style set to your 
document.  

3. Click Formal. Word 2007 reformats all of the paragraphs into the Formal style 
applying the appropriate format to each paragraph.  

 
-------------------------------------------------------------------------------------------------------------- 
7.3 MS-EXCEL-I 
-------------------------------------------------------------------------------------------------------------- 
Microsoft Excel is an electronic spreadsheet. You can use it to organize your data into rows 
and columns. You can also use it to perform mathematical calculations quickly. This 
tutorial teaches Microsoft Excel basics. Although knowledge of how to navigate in a 
Windows environment is helpful, this tutorial was created for the computer novice. This 
lesson will introduce you to the Excel window. You use the window to interact with Excel. 
To begin this lesson, start Microsoft Excel 2007. The Microsoft Excel window appears and 
your screen looks similar to the one shown here.  
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Note: Your screen will probably not look exactly like the screen shown. In Excel 2007, 
how a window displays depends on the size of your window, the size of your monitor, and 
the resolution to which your monitor is set. Resolution determines how much information 
your computer monitor can display. If you use a low resolution, less information fits on 
your screen, but the size of your text and images are larger. If you use a high resolution, 
more information fits on your screen, but the size of the text and images are smaller. Also, 
settings in Excel 2007, Windows Vista, and Windows XP allow you to change the color 
and style of your windows. 
 
The Microsoft Office Button 
 

 
 
In the upper-left corner of the Excel 2007 window is the Microsoft Office button. When 
you click the button, a menu appears. You can use the menu to create a new file, open an 
existing file, save a file, and perform many other tasks. 
 
The Quick Access Toolbar 
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Next to the Microsoft Office button is the Quick Access toolbar. The Quick Access toolbar 
gives you with access to commands you frequently use. By default, Save, Undo, and Redo 
appear on the Quick Access toolbar. You can use Save to save your file, Undo to roll back 
an action you have taken, and Redo to reapply an action you have rolled back. 
 
The Title Bar 
 

 
 
 
Next to the Quick Access toolbar is the Title bar. On the Title bar, Microsoft Excel displays 
the name of the workbook you are currently using. At the top of the Excel window, you 
should see "Microsoft Excel - Book1" or a similar name. 
 
The Ribbon 
 

 
 
You use commands to tell Microsoft Excel what to do. In Microsoft Excel 2007, you use 
the Ribbon to issue commands. The Ribbon is located near the top of the Excel window, 
below the Quick Access toolbar. At the top of the Ribbon are several tabs; clicking a tab 
displays several related command groups. Within each group are related command buttons. 
You click buttons to issue commands or to access menus and dialog boxes. You may also 
find a dialog box launcher in the bottom-right corner of a group. When you click the dialog 
box launcher, a dialog box makes additional commands available. 
 
7.3.1 Working with Worksheet 
 
Microsoft Excel consists of worksheets. Each worksheet contains columns and rows. The 
columns are lettered A to Z and then continuing with AA, AB, AC and so on; the rows are 
numbered 1 to 1,048,576. The number of columns and rows you can have in a worksheet is 
limited by your computer memory and your system resources. 
 
The combination of a column coordinate and a row coordinate make up a cell address. For 
example, the cell located in the upper-left corner of the worksheet is cell A1, meaning 
column A, and row 1. Cell E10 is located under column E on row 10. You enter your data 
into the cells on the worksheet. 
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Fig 7.16 Worksheet 
 
The Formula Bar 
 

 
 

If the Formula bar is turned on, the cell address of the cell you are in displays in the Name 
box which is located on the left side of the Formula bar. Cell entries display on the right 
side of the Formula bar. If you do not see the Formula bar in your window, perform the 
following steps: 
 

1. Choose the View tab.  
2. Click Formula Bar in the Show/Hide group. The Formula bar appears.  

 
Note: The current cell address displays on the left side of the Formula bar. 
 
The Status Bar 
 
The Status bar appears at the very bottom of the Excel window and provides such 
information as the sum, average, minimum, and maximum value of selected numbers. You 
can change what displays on the Status bar by right-clicking on the Status bar and selecting 
the options you want from the Customize Status Bar menu. You click a menu item to select 
it. You click it again to deselect it. A check mark next to an item means the item is 
selected. 
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Move around a Worksheet 
By using the arrow keys, you can move around your worksheet. You can use the down 
arrow key to move downward one cell at a time. You can use the up arrow key to move 
upward one cell at a time. You can use the Tab key to move across the page to the right, 
one cell at a time. You can hold down the Shift key and then press the Tab key to move to 
the left, one cell at a time. You can use the right and left arrow keys to move right or left 
one cell at a time. The Page Up and Page Down keys move up and down one page at a 
time. If you hold down the Ctrl key and then press the Home key, you move to the 
beginning of the worksheet. 
 
EXERCISE: 
Move around the Worksheet 
The Down Arrow Key 

• Press the down arrow key several times. Note that the cursor moves downward one 
cell at a time.  

The Up Arrow Key 
• Press the up arrow key several times. Note that the cursor moves upward one cell at 

a time.  
The Tab Key 

1. Move to cell A1.  
2. Press the Tab key several times. Note that the cursor moves to the right one cell at a 

time.  
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The Shift +Tab Keys 
• Hold down the Shift key and then press Tab. Note that the cursor moves to the left 

one cell at a time.  
The Right and Left Arrow Keys 

1. Press the right arrow key several times. Note that the cursor moves to the right.  
2. Press the left arrow key several times. Note that the cursor moves to the left.  

Page Up and Page Down 
1. Press the Page Down key. Note that the cursor moves down one page.  
2. Press the Page Up key. Note that the cursor moves up one page.  

The Ctrl-Home Key 
1. Move the cursor to column J.  
2. Stay in column J and move the cursor to row 20.  
3. Hold down the Ctrl key while you press the Home key. Excel moves to cell A1.  

Go To Cells Quickly  
The following are shortcuts for moving quickly from one cell in a worksheet to a cell in a 
different part of the worksheet. 
 
EXERCISE  
The Name Box 
You can also use the Name box to go to a specific cell. Just type the cell you want to go to 
in the Name box and then press Enter. 
 

 
 

1. Type B10 in the Name box.  
2. Press Enter. Excel moves to cell B10.  
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Select Cells 
 

 
 
If you wish to perform a function on a group of cells, you must first select those cells by 
highlighting them. The exercises that follow teach you how to select. 
 
Alternative Method: Select Cells by Dragging 
You can also select an area by holding down the left mouse button and dragging the mouse 
over the area. In addition, you can select noncontiguous areas of the worksheet by doing 
the following: 
 

 
1. Go to cell A1.  
2. Hold down the Ctrl key. You won't release it until step 9. Holding down the Ctrl 

key enables you to select noncontiguous areas of the worksheet.  
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3. Press the left mouse button.  
4. While holding down the left mouse button, use the mouse to move from cell A1 to 

C5.  
5. Continue to hold down the Ctrl key, but release the left mouse button.  
6. Using the mouse, place the cursor in cell D7.  
7. Press the left mouse button.  
8. While holding down the left mouse button, move to cell F10. Release the left mouse 

button.  
9. Release the Ctrl key. Cells A1 to C5 and cells D7 to F10 are selected.  
10. Press Esc and click anywhere on the worksheet to remove the highlighting.  

 
Enter Data 
In this section, you will learn how to enter data into your worksheet. First, place the cursor 
in the cell in which you want to start entering data. Type some data, and then press Enter. If 
you need to delete, press the Backspace key to delete one character at a time. 
 
EXERCISE: 
Enter Data 

 
 

1. Place the cursor in cell A1.  
2. Type John Jordan. Do not press Enter at this time. 
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Delete Data 
The Backspace key erases one character at a time.  

1. Press the Backspace key until Jordan is erased.  
2. Press Enter. The name "John" appears in cell A1.  

 
Edit a Cell 
After you enter data into a cell, you can edit the data by pressing F2 while you are in the 
cell you wish to edit. 

 
 
 
Alternate Method: Editing a Cell by Using the Formula Bar 
You can also edit the cell by using the Formula bar. You change "Jones" to "Joker" in the 
following exercise. 

 
 

1. Move the cursor to cell A1.  
2. Click in the formula area of the Formula bar.  
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3. Use the backspace key to erase the "s," "e," and "n."  
4. Type ker.  
5. Press Enter.  

 
Alternate Method: Edit a Cell by Double-Clicking in the Cell 
You can change "Joker" to "Johnson" as follows: 
 

 
 
 

1. Move to cell A1.  
2. Double-click in cell A1.  
3. Press the End key. Your cursor is now at the end of your text.  

http://www.studynama.com/?utm_source=pdf&utm_medium=downloaded_file&utm_campaign=studynama_referral


 207

 
 

4. Use the Backspace key to erase "r," "e," and "k."  
5. Type hnson. 
6. Press Enter.  

 
Change a Cell Entry 
Typing in a cell replaces the old cell entry with the new information you type. 

1. Move the cursor to cell A1.  
2. Type Cathy.  
3. Press Enter. The name "Cathy" replaces "Johnson."  
 

 
 
Wrap Text 
When you type text that is too long to fit in the cell, the text overlaps the next cell. If you 
do not want it to overlap the next cell, you can wrap the text. 
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EXERCISE: 
Wrap Text 
  

 
 

1. Move to cell A2.  
2. Type Text too long to fit.  
3. Press Enter.  
 

 
 

4. Return to cell A2.  
5. Choose the Home tab.  
6. Click the Wrap Text button . Excel wraps the text in the cell.  

 
Delete a Cell Entry 
To delete an entry in a cell or a group of cells, you place the cursor in the cell or select the 
group of cells and press Delete. 
 
EXERCISE: 
Delete a Cell Entry 

1. Select cells A1 to A2.  
2. Press the Delete key.  
3. Save a File 
4. This is the end of Lesson1. To save your file: 
5. Click the Office button. A menu appears.  
6. Click Save. The Save As dialog box appears.  
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7. Go to the directory in which you want to save your file.  
8. Type Lesson1 in the File Name field.  
9. Click Save. Excel saves your file.  
10. Close Excel 
11. Close Microsoft Excel. 
12. Click the Office button. A menu appears.  
13. Click Close. Excel closes.  
 

-------------------------------------------------------------------------------------------------------------- 
7.4 MS EXCEL - II 
-------------------------------------------------------------------------------------------------------------- 
7.4.1 Using Excel's Built-in Functions  
The following activity shows you how to use Excel's built-in functions in your calculations. 
If you have access to the program, you should do the activities as you read. This will 
enhance your understanding of each step.  
 
1. Employing the SUM function to compute sales totals. 
As our first example illustrating the use of an Excel built-in function, we will modify the 
Example1 worksheet. One of the Excel built-in functions is the function SUM which, as its 
name suggests, computes sums of values in a range of cells. 
To do this, we delete the formula in cell B10, type an = sign, then select the function 
selection dialog box (the symbol fx) from the tool bar (see the cursor position in the figure 
below). The dialog box shown in the figure is then displayed and we can choose from 
among the many Excel built-in functions. In the figure, we have selected the SUM function 
from the Most Recently Used function list. Once we make this selection we click to close 
the function selection dialog box. 
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Fig 7.17 Built-in Functions 
2. Setting the argument -- a range of cells. 
When we close the function selection dialog box, a second dialog box appears, as shown 
below. The purpose of this dialog box is to help us set the arguments for the function we've 
chosen. In this example, the spreadsheet "guesses" that we wish to sum the cells (starting 
with the first one from the top with numerical data in it) immediately above the formula 
cell. In other words it selects for us the range of cells B3:B9. This is almost correct. We 
probably don't care to include the empty cell B9, so we edit the range to read B3:B8, then 
click OK. 
Notice before going on that the dialog box also has a brief explanation of what the function 
we've selected does and what its arguments stand for. And it even tells us what the result 
would be for the arguments it has pre-selected for us. 
 

 
 
3. Completing the formula. 
Once we adjust the arguments to be the range B3:B8 and click OK, we get the result shown 
in the figure below. In a moment we will replicate the SUM function across the row to cells 
C10, D10, E10. But first, let's see how the SUM calculation differs from the previous 
calculation we made with the addition formula. 
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4. Comparing the SUM function and a formula using the + operator. 
The SUM function is a convenient way to compute sums when we expect the amount of 
data in our spreadsheet to expand or contract in the future. The reason is that the SUM 
function automatically accounts for inserting and deleting data within the range of cells in 
its argument. The formula constructed with the + operator will not adjust for this 
accommodation. 
 
Let's modify our spreadsheet to illustrate. Suppose for a moment we had a special 
promotion sale at the end of February and we want to now include these sales figures as a 
separate row in our data. It is easy to add more data in a spreadsheet by inserting rows (or 
columns) into the worksheet. 
 
The figure below shows how we would add a row after the February sales figure row. First 
you select the row before which you wish to insert a new row. Do this by clicking the row 
number at the right of the worksheet -- the entire row will be highlighted. Next you select 
the Rows choice from the Insert menu as shown in the figure. A new blank row will be 
inserted before the selected row. 
 

 
 
To complete our modification we add appropriate data to new row 5, as shown in the figure 
below. 
Now notice (compare totals with those in the previous figure in Step 3) that the total for 
Region 1 is automatically updated to include the additional $10,000 we just entered in cell 
B5. However, the total for Region 2 does not include the new amount in cell C5.  
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The formula in cell C11, as you can see from the figure, changes to keep exactly the same 
values in the sum as were there before the insertion of the new row. The new value is 
omitted altogether. The SUM function incorporates the new row as part of its new range. 
Hence the SUM function and the + operator are adjusted in different ways for the insertion 
of new data. We added the new row just for the purpose of making this point. Let's delete it 
before proceeding. To do this we select row 5 again (remember, click the row number on 
the left side) and then select Delete from the Edit menu. 
 
As a final adjustment to the worksheet in this step, replicate the SUM function formula in 
cell B10 to cells C10, D10, and E10. 
 

 
 
 
5. Computing average sales per month for each region. 
Next, we'll add formulas to calculate the average monthly sales for all three regions. The 
following figure illustrates entering the appropriate formula for computing the Region 1 
monthly average. Note that we're employing a built-in function AVERAGE. If we know 
the function's name and purpose already, we can simply type the formula. Or we could 
consult the function selection dialog box as we did for the SUM function earlier. 
 
In the figure below, we're entering the formula directly. The figure illustrates also that 
instead of typing in the range B3:B8, we can drag over that range of cells (note the dotted 
box surrounding the selected range) to indicate the range when the time comes for the 
function's argument to be entered in the formula. We would complete the formula shown 
below by typing in the closing right parenthesis and then clicking the green check mark to 
the left of the formula bar. 
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Once the average is computed for Region 1, you should replicate the formula to cells C12, 
D12, and E12 to compute monthly averages for the other regions and for the total monthly 
sales. 
 

 
 
6. Computing the standard deviation of the averages. 
As a final illustration, let's suppose we wish to compute the standard deviation of the 
averages we just calculated. Mimic the procedure given in Step 5 and enter a formula 
employing the built-in function STDEV for computing the standard deviation for the 
Region 1 monthly average. Consult the figure below for help if you need it. Now replicate 
the standard deviation calculation to cells C13, D13, and E13. 
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The completed worksheet should have the following figures in it. Check your work against 
these numbers and locate and correct any errors. 
 

 
 
7. An Exercise -- Computing Car Payments. 
In this exercise you will get a chance to practice employing an Excel built-in function on 
your own. Suppose you wish to compute the monthly payments you would have on a car 
you'd like to buy. Suppose the car costs $10,000 and you know you can secure a 10% 
annual interest rate loan for this amount. You'd like to do an analysis to decide what term 
(pay-back time) you should try to get. Of course the longer the term, the lower your 
monthly payments -- but the more interest you pay over the life of the loan. You want the 
shortest term for which you can still swing the monthly payments. 
 
Set up a worksheet like the one in the figure to calculate the various payments for different 
terms. Note that you can type a long text string (like the one shown here in C2) and it will 
overflow to adjacent cells to the right as long as there is no date in those cells. 
 

 
 
Excel has a built-in function for computing loan payments. It is called PMT and can be 
found in the financial function list as shown below. 
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The arguments for the PMT function hold the interest rate (Rate) for the period in which 
you're interested -- a month in this case, the number of periods (Nper) you expect to pay, 
the present value (Pv) or amount of the loan, the future value (Fv) of the loan (this will be 
0 if you intend to pay the loan off), and the type (Type) of payment to be made (this is 0 if 
your payments begin at the end of the month you get the loan; 1 if the payments begin 
immediately when you get the loan -- 0 is the most common option here). 
 
Convince yourself that the arguments for your function should be those shown below. 
 

 
 
The completed worksheet should have the following figures in it. Check your work against 
these numbers and correct any errors. The parentheses and red type face indicates that these 
numbers represent a payment (negative). 
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7.4.2 What - if Analysis 
What-if analysis is the process of changing the values in cells to see how those changes 
will affect the outcome of formulas on the worksheet. 
 
Three kinds of what-if analysis tools come with Excel: scenarios, data tables, and Goal 
Seek. Scenarios and data tables take sets of input values and determine possible results. A 
data table works only with one or two variables, but it can accept many different values for 
those variables. A scenario can have multiple variables, but it can accommodate only up to 
32 values. Goal Seek works differently from scenarios and data tables in that it takes a 
result and determines possible input values that produce that result. 
In addition to these three tools, you can install add-ins that help you perform what-if 
analysis, such as the Solver add-in. The Solver add-in is similar to Goal Seek, but it can 
accommodate more variables. You can also create forecasts by using the fill handle and 
various commands that are built into Excel. For more advanced models, you can use the 
Analysis Pack add-in. 
 
Use scenarios to consider many different variables 
A scenario is a set of values that Excel saves and can substitute automatically in cells on a 
worksheet. You can create and save different groups of values on a worksheet and then 
switch to any of these new scenarios to view different results. For example, suppose you 
have two budget scenarios: a worst case and a best case. You can use the Scenario Manager 
to create both scenarios on the same worksheet, and then switch between them. For each 
scenario, you specify the cells that change and the values to use for that scenario. When 
you switch between scenarios the result cell changes to reflect the different changing cell 
values. 
 
Worst case scenario 

 
 

Changing cells 
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Result cell 
 

Best case scenario 

 
 

Changing cells 
 Result cell 

 
If several people have specific information in separate workbooks that you want to use in 
scenarios, you can collect those workbooks and merge their scenarios. 
 
After you have created or gathered all the scenarios that you need, you can create a 
scenario summary report that incorporates information from those scenarios. A scenario 
report displays all the scenario information in one table on a new worksheet. 
Scenario summary report 

 
 

 NOTE   Scenario reports are not automatically recalculated. If you change the values of a 
scenario, those changes will not show up in an existing summary report. Instead, you must 
create a new summary report. 
 
Use Goal Seek to find out how to get a desired result 
If you know the result that you want from a formula, but you are not sure what input value 
the formula requires to get that result, you can use the Goal Seek feature. For example, 
suppose that you need to borrow some money. You know how much money you want, how 
long a period you want in which to pay off the loan, and how much you can afford to pay 
each month. You can use Goal Seek to determine what interest rate you must secure in 
order to meet your loan goal. 
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 NOTE   Goal Seek works with only one variable input value. If you want to determine 
more than one input value, for example, the loan amount and the monthly payment amount 
for a loan, you should instead use the Solver add-in.  
 
Use data tables to see the effects of one or two variables on a formula 
If you have a formula that uses one or two variables, or multiple formulas that all use one 
common variable, you can use a data table to see all the outcomes in one place. Using data 
tables makes it easy to examine a range of possibilities at a glance. Because you focus on 
only one or two variables, results are easy to read and share in tabular form. If automatic 
recalculation is enabled for the workbook, the data in data tables immediately recalculates; 
as a result, you always have fresh data. 
 

 
 
A one-variable data table 
A data table cannot accommodate more than two variables. If you want to analyze more 
than two variables, you can use scenarios. Although it is limited to only one or two 
variables, a data table can use as many different variable values as you want. A scenario 
can have a maximum of 32 different values, but you can create as many scenarios as you 
want. 
 
7.4.3 Data Table sorting  
Microsoft Office Excel 2007 introduces significant changes to sorting table data. You can 
now sort up to 64 columns of data. You can also sort based on colors and custom lists. In 
my previous Office Talk column about table filtering in Microsoft Office Excel 2007, I 
briefly discuss changes to sorting features. One of the more important changes in sorting is 
the elimination of the three-condition limit. You can now sort up to 64 columns. Office 
Excel 2007 introduces updates to the Sort dialog box. Figure7.18 show sorting a table by 
five columns. 
 
More Sorting Options 
The Sort dialog box is similar in behavior to the Conditional Formatting Rules Manager 
dialog box that I discuss in the series of Office Talk columns on conditional formatting. For 
more information, see Additional Resources. To create sort conditions, on the Data tab, 
click Sort, and in the Sort dialog box, click Add Level. Like filters, sort levels change 
based on data types. Office Excel 2007 uses that information to offer settings that are more 
descriptive and easier to understand than "ascending" and "descending." For example, for 
text columns, you have A to Z and Z to A sorting; for numeric columns, you can sort from 
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Smallest to Largest and Largest to Smallest; and for date columns, you have Newest to 
Oldest and Oldest to Newest sorts. You can reorder sort conditions by using the buttons at 
the top of the Sort dialog box. You can also copy sort levels to save time. The Options 
button opens the Sort Options dialog box, which allows you to specify whether the sort 
should be case-sensitive and allows you to specify the sort orientation. Both of these 
features existed in Microsoft Office Excel 2003 but are more discoverable in Office Excel 
2007. 
 

 
 

Figure 7.18 Sort Options dialog box 
 
Sorting by Colors 
The following example illustrates additional sort functionality introduced in Office Excel 
2007. Assume you have the following table of formatted data. 
 

 
 

Figure7.19 Sample table with formatted data 
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One of the common requests from Excel users is the ability to sort by color, either 
manually applied or applied by conditional formatting. In Office Excel 2007, you can sort 
by:  

• Background color (however applied)  
• Font color (however applied)  
• Cell icon (applied by using conditional formatting) 

 
For example, you can set up several conditions on the table data as seen in Figure 7.20. 
 

 
 

Figure 7.20 You can easily set up multiple sort conditions 
 
When you click OK, Office Excel 2007 applies the sort starting from the top. Notice the 
buttons at the top of each column indicate that the column is being sorted. The filter state is 
displayed here if a filter is applied. 
 

 
 

Figure 7.21 Buttons at the top of each column provide sorting and filtering status 
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In addition to sorting by built-in values and color, you can specify a custom sort order by 
selecting Custom List at each level of sorting. You can create a custom list from the Sort 
dialog box. 
 

 
 

Figure 7.22 You can specify a custom list to sort by 
 
Sorting by Cell Color 
In Office Excel 2007, you can sort by color or cell icon by using in-grid filter capabilities 
(also known as AutoFilter). For example, assume that you have the table shown in Figure 
7.23 
 

 
 

Figure 7.23 Sorting by Cell Color 
 
To sort the table data so that all of the yellow and green items appear at the top of the 
column, use the sort button to sort first by the green background.  
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Figure 7.24 Sort first by green background 
 
This organizes all of the green values at the top of the column. 
 

 
 

Figure 7.25 Result of sorting on the color green 
 
Next, repeat the procedure for the yellow items. This results in the following table. 
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Figure 7.26 Result of sorting on two colors sequentially 
 
Sorting by color moves all rows that meet the criteria to the top of the table. This capability 
is also added to the context menu in a table or filtered range. For example, in the table 
shown in Figure 6, you can right-click a cell with a green background and select Put 
Selected Cell Color on Top in the Sort submenu. 

 
 

Figure 7.27 Sorting by using the context menu 
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Sorting with Custom Lists 
Next, consider an example that illustrates how to sort on a custom list of values. Assume 
you have a table with a column of modes of transportation. 
 

 
 

Figure 7.28 Column of text values 
 

First, in the Sort dialog box, specify the column name and then, in the Order list, select 
Custom List. Click OK. 
 

 
 

Figure 7.29 Select Custom List in the Order drop-down 
 
In the Custom List dialog box, select NEW LIST and then type in the data values 
separated by commas. Click OK when you are finished. 
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Figure 7.30 Resulting table after sorting on a custom list 
 
The table is now sorted by the custom list of values you specified. 
 

 
 

Figure 7.31 Sorted column 
Conclusion: The ability to sort up to 64 columns of data gives you greater control over 
how your data appears. Likewise, sorting by cell color or font color enables you to put the 
data that is important to you at the top of the table column or a range. The ability to sort 
user-defined lists of values allows you to customize tables in a way that is relevant to your 
needs. 
 
-------------------------------------------------------------------------------------------------------------- 
7.5 MS-EXCEL-III 
-------------------------------------------------------------------------------------------------------------- 
7.5.1 Graphs and Charts: A graph is a chart or drawing that shows the relationship 
between changing things. They are a diagram displaying the relationship between numbers 
or amounts. Common graphs use bars, lines, or parts of a circle to display data. Below are 
the steps given to insert Graphs and charts. They are: 
Step 1 - Enter the data to be graphed. For the purpose of this lesson you will use data from 
a Favorite Fruit Survey. Enter it as you see below: 
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Step 2 - Highlight data to be graphed. Do not include the row with heading titles, only the 
names of fruit and the numbers. If your worksheet looks like the one above; put your cursor 
in call A2, click hold the mouse button down and drag to cell B7. Highlighted data should 
look like the image below: 
 

 
 

Note: Cell A2 is selected; the select color extends around the cell 
Step 3 - Select the Chart Wizard. That is done by going to the Insert menu and selecting 

Chart. You can also click on the Chart Wizard button on the Standard toolbar.  
Step 4 - From the Chart Wizard box that opens select Chart type. For this activity, I 
selected pie. 
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After you have selected the Chart type, click and hold your mouse pointer down on the 
Press and Hold... button to see what your data looks like in the chart type you selected. If 
you do not like the look, select another chart type. After you have selected the chart type 
you will have two options: 

• Select Next and let Chart Wizard show you a series of options to make changes to 
your chart.  

• Select Finish and Chart Wizard puts your completed chart on the spreadsheet. You 
can see the finished product below.  

 
The first step taken by Chart Wizard is to verify the range of data being used for this chart. 
The Data range displayed below is read "all cells from A2 to B7." 
 

 
 
Notice where the cursor is located in the dialog box above. It is pointing to the small box at 
the end of the line where the Data range is displayed. If the data range should be changed, 
click on the box the cursor is pointing to. 
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The dialog box shrinks allowing you to see your entire spreadsheet. You can edit the data 
range in this small window. When you are finished, click the same box at the end to restore 
the window. 
 
Select Next to go to the dialog box below. This box allows you to add a title to the chart, 
make changes on the legend, or make changes on the data labels. 
 

 

Select Next to move to the final dialog box which allows you to see the chart as a new 
sheet or place it on one of the sheets in your workbook. 

 
 

 If you let the Chart Wizard finish your chart after the first dialog box, or work through 
each of the four steps, your chart will look something like the one below. 
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-------------------------------------------------------------------------------------------------------------- 
7.6 REVIEW QUESTIONS 
-------------------------------------------------------------------------------------------------------------- 
 

1. State whether the following statement True (T) or False (F) : 
a) MS-Word has the facility of Macros. 
b) Mouse setting can be changed from control panel. 
c) Print preview option is in edit menu 
d) In MS-Word a table consists of rows and columns. 
e) Using the Edit option you can switch over from Normal mod to outline 

mode. 
f) The tool bar allows you to format the vertical alignment to text. 
g) Mail merge option is in table menu. 
h) Del key removes the one character form the left position. A byte is equal to 

8 bits. 
2. Answer the following Questions briefly: 

a) Write the steps to insert a page break 
b) Write the steps to insert table 
c) How will you move a paragraph in MS-word? 
d) Write any four features of Word Processing. 
e) How to insert rows and columns in a table? 
f) What is the Auto Correct feature used for? 
g) Write the steps in creating a chart in Ms Excel 
h) Distinguish between the following: 

• save and save as; and 
• cut past and copy past. 

i) How to convert text in to a column? 
j) Explain how to create a MS-Excel work sheet to calculate the employee 

pay. Find out the gross pay, detection and net pay. 
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-------------------------------------------------------------------------------------------------------------- 
OFFICE AUTOMATION SYSTEMS - PART II 
-------------------------------------------------------------------------------------------------------------- 
Structure 
 
8.1 Ms PowerPoint-I 
 8.1.1 Starting Microsoft PowerPoint  
 8.1.2 Auto Layout 
 8.1.3 Toolbars 
 8.1.4 Insertion of New Slides 
 
8.2 MS PowerPoint-II 
 8.2.1 Apply a Design Template 
 8.2.2 Presentation Using Chart Wizards 
 8.2.3 Frame Movements of The Above 
 
8.3 Review Questions 
-------------------------------------------------------------------------------------------------------------- 
8.1 MS POWERPOINT-I 
--------------------------------------------------------------------------------------------------------------
Microsoft PowerPoint is a powerful tool to create professional looking presentations and 
slide shows. PowerPoint allows you to construct presentations from scratch or by using the 
easy to use wizard. 
 
8.1.1 Starting Microsoft PowerPoint  
Two Ways  

Double click on the Microsoft PowerPoint icon on the desktop.           
Click on Start --> Programs --> Microsoft PowerPoint  
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Creating & Opening a Presentation: After you open up Microsoft PowerPoint, a screen 
pops up asking if you would like to create a New Presentation or Open an Existing 
Presentation.  

 

 
 

• AutoContent Wizard  
o Creates a new presentation by prompting you for information about content, 

purpose, style, handouts, and output. The new presentation contains sample 
text that you can replace with your own information. Simply follow the 
directions and prompts that are given by Microsoft PowerPoint.  

 
• Design Template  

o Creates a new presentation based on one of the PowerPoint design templates 
supplied by Microsoft. Use what is already supplied by Microsoft 
PowerPoint and change the information to your own.  

 
• Blank Presentation  

o Creates a new, blank presentation using the default settings for text and 
colors.  

 
8.1.2 Auto Layout 
After you have opened a new presentation, PowerPoint displays the New Slide dialog box 
containing several Auto Layouts. Auto Layouts provide a pre-determined layout for each 
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specific type of slide. They provide consistency throughout the presentation. Each layout 
depicted is described in the lower right corner when you click the layout. This sample New 
Slide dialog box shows the Title Slide selected (denoted with the thick border).  
 

 
 
After you select Blank Presentation a window pops up asking you to select the layout of the 
first slide.  
 
Pre-Designed Slide Layouts (Left to Right)  

• Title Slide  
• Bulleted List  
• Two Column Text  
• Table  
• Text & Chart  
• Chart & Text  
• Organizational Chart  
• Chart  
• Text & Clip Art  
• Clip Art & Text  
• Title Only  
• Blank Slide  

 
NOTE: If you already know what you want in your next slide, it is a very good idea to 
choose one of the pre-designed layouts from above. However if you do not, then you 
can still insert what you want in throughout your Presentation anytime you desire. 
Just choose Blank Slide and insert items as you see fit.  
 
Different Views That PowerPoint Demonstrates:  
There are different views within Microsoft PowerPoint that allow you to look at your 
presentation from different perspectives.  
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Normal View Outline View Slide View Slide Sorter View Slide Show View 

     
Switches to 
normal view, 
where you can 
work on one slide 
at a time or 
organize the 
structure of all the 
slides in your 
presentation  

Switches to 
outline view, 
where you can 
work with the 
structure of your 
file in outline 
form. Work in 
outline view when 
you need to 
organize the 
structure of your 
file.  

Switches to slide 
view, where you 
can work on one 
slide at a time 

Displays 
miniature versions 
of all slides in a 
presentation, 
complete with 
text and graphics. 
In slide sorter 
view, you can 
reorder slides; add 
transitions, and 
animation effects. 
You can also set 
the timings for 
electronic slide 
shows. 

Runs your slide 
show in a full 
screen, beginning 
with the current 
slide if you are in 
slide view or the 
selected slide if 
you are in slide 
sorter view. If you 
simply want to 
view your show 
from the first 
slide:  
Click Slide Show 
at the top of the 
screen  
Select View 
Show  
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8.1.3 Toolbars 
Toolbars include important components for developing a presentation. A toolbar is an 
onscreen bar which contains shortcut buttons. These allow easy access to frequently used 
commands. You can easily get to the toolbars you need by telling PowerPoint which ones 
to display.  
 
PowerPoint includes 13 toolbars including commonly used ones such as the Standard, 
Formatting, Drawing, Picture, and E-mail toolbars. You don't need all of them at once, and 
some you may seldom use so you don't want them taking up space on your screen. You can 
pick and choose which toolbars are visible, and once you know how to turn toolbars on and 
off, you can always get to the toolbar you need.  
 
Display and Hide PowerPoint Toolbars 
Click View. Then click on Toolbars. A fly-out menu will appear with a list of all of the 
Windows toolbars and any others that you may have installed from other applications on 
your computer.  

 

 In the list of PowerPoint toolbars, the ones with the check mark next them are visible. 
The ones without a checkmark are hidden.  
 
To make a toolbars visible, simply click on its name in the list, a checkmark will appear 
next to the toolbar name in the list and the toolbar will become visible in your PowerPoint 
workplace. Check the toolbar you want to be visible and repeat as necessary.  
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You can also right-click on any existing toolbar and check or uncheck any entry in the 
shortcut menu.  

 

 

 

 

 

 

 

 

  

  
 You can also right-click your mouse anywhere in a toolbar area and the list of PowerPoint 
toolbars will appear. From here you can turn toolbars on or off.  
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Moving and Changing the Toolbars:  
You can reposition toolbars on the presentation you are working on. You can also resize 
toolbars so that all or only a few of the buttons contained in them are visible.  
 
Each toolbar has four vertical dots that help you move them to a fixed position on the 
screen or to floating positions on the screen. To move a toolbar, click the four dots that are 
found on the left end of each toolbar.  

 

Note that when you choose to view a toolbar, it appears in the position in which it was most 
recently used. It was last docked at the bottom of the screen, then that's where it will appear 
again when it is turned back on. You may need to experiment with various toolbar 
locations until you find the arrangement that works best for you.  
 
Creating Your Own Toolbar:  
You can create your own customized toolbar. Right click any toolbar and hit Customize. In 
the Customize dialog box. Select the toolbars tab and click New. Name the toolbar and 
allocate a template.  
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In the Toolbars list, click the toolbars you want to display. Click Close, and the toolbars 
you selected appear on the workspace.  
 
8.1.4 Insertion of new slides 
To create a new slide: 

1. Do one of the following:  
• Choose Insert > New Slide from the menu.  

• Click the New Slide button . 
• Press Ctrl-M.  

The Apply Slide Layout pane will appear on the right side of the screen. The Apply Slide 
Layout pane provides you with slide templates you can use when creating your PowerPoint 
presentation. There are four types of Text Layout templates.  
Title Slide - The Title Slide contains two text placeholders that you can use to display a 
title and a subtitle of your presentation. 
Title Only - The Title Only slide contains a single placeholder. You can use it to display a 
title. 
Title and Text - The Title and Text template provides a placeholder for a title and a 
placeholder for text. 
Title and 2 Column Text - The Title and Text template provides a placeholder for a title 
and two placeholders for text. 
 

2. To select a layout, click the layout you want in the Apply Slide Layout pane. The 
layout will then appear in the Slide pane.  

 

 
3. To add text, click inside the placeholder and type.  
4. To add an additional slide to your presentation do one of the following: 
• Right-click on the slide layout. A menu will appear. Choose Insert New Slide.  
• Click the down arrow next to the slide layout. A menu will appear). Choose Insert 

New Slide.  

 
 
Change Your Slides 
After creating a slide, if you want to add text: 

1. Place the cursor at the point at which you would like to add text.  
2. Type the information you want to add.  

 
If you would like to change text: 

1. Highlight the text you want to change.  
2. Type the new text.  

You can use the backspace key to delete text. You can also delete text by highlighting the 
text and pressing the Delete key. 
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-------------------------------------------------------------------------------------------------------------- 
8.2 MS POWERPOINT-II 
-------------------------------------------------------------------------------------------------------------- 
8.2.1 Apply a Design Template 

 

 
 

1. Click the design icon .  
2. Design templates will appear on the left side of the screen. 
3. Scroll down to view the design templates.  
4. Right-click the design template you want to apply. A context menu will appear. Choose  
Apply to All Slides. We used the Lock and Key design template.  
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Outline and Slides Tab 
 

1. Use the Slides tab to view thumbnails of your slide. 
  

 
 

2. Click the Outline tab to view the text of your presentation as an outline.  
 

 
 
Slide Sorter View 

1. Choose View > Slide Sorter from the menu to move to Slide Sorter view.  
 

 
 

2. Double-click a slide to return to Normal view.  
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Run Your Slide Show 
1. Press F5 to run the Slide Show.  
2. Use the arrow keys on your keyboard to move forward and backward through your 

slides.  
3. Use the Esc key to return to Normal view.  
 

Print Your Outline 
1. Choose File > Print Preview from the menu.  
2. Click the down arrow next to the Print What icon.  
 

 
 

3. Select Outline view.  
 

 
4. Click the Print icon. 
5.  Click Close.  

 
Print Your Slides 

1. Choose File > Print Preview from the menu.  
2. Click the down arrow next to the Print What icon.  
3. Select the slides you want to print.  
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4. Click the down arrow next to Options. A menu will appear.  
5. Choose Color/Grayscale > Pure Black and White.  
6. Click the Print icon. 
7.  Click Close.  

 
Print Your Slides as a Handout 

1. Choose File > Print Preview from the menu.  
2. Click the down-arrow next to the Print What icon.  
3. Select Handouts (2 Slides per Page).  
4. Click the Print icon. 
5.  Click Close.  

 
8.2.2 Presentation using Chart Wizards 
 
a) To animate a single object on a PowerPoint slide  

1. Select the object. 
2. Choose SLIDE SHOW: Preset Animation. 
3. Select the animation effect you desire for the selected object.  

 

 
 
Animated Layers or Slides you may find it useful to bring a layered object into a 
presentation one layer at a time, building it on-screen. To animate a layered object or to 
animate each object on a slide:  
 

1. Choose SLIDE SHOW: Custom Animation. (You must be in Normal, Outline, or 
Slide View.) 

2. In the Custom Animation dialog box, each object is identified in the Check to 
animate slide objects list. 
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3. (If you don't remember what a particular object is), click the object's name in the list; 
that object appears selected in the preview window. 

4. Click in the object's checkbox to animate that object. It will be added to the 
Animation order list. 

5. To change the order that the animated objects appear, select the object in the 
Animation order list, then click the up or down arrow to move the object through the 
list. 

6. Choose whether the object appears only on a mouse click or after a specified number 
of seconds.  

 
 

To choose other effects such as sound effects and how the object appears on the slide 
during the on-screen presentation, click on the Effects tab.  

 
To animate text:  

1. Click on the Effects tab. 
2. In the Introduce Text section, from the drop-down box, choose whether the text is 

introduced all at once, by word, or by letter.  
 

To animate charts click the Chart Effects tab. You can choose to introduce the data by 
series, categories, or elements.  

 
NOTE: Be careful of using too many effects in any single presentation because they soon 
become detraction to rather than an enhancement of the presentation.  
 
b) Create a Presentation Using the AutoContent Wizard in Microsoft PowerPoint 
 
1. In PowerPoint, click Getting Started to open the dropdown menu  
2. Select New Presentation from the menu  
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3.  Click From AutoContent Wizard  
4.  The AutoContent Wizard opens. In the opening pane, click Next and you arrive  
  at the second pane  
5.  Click a category from one of the following:  

• All: Lists all slide presentations in all categories. You can scroll the window 
and select a slide presentation to create from the list  

• General: Displays a list of general business topics  
• Corporate: Displays a list of corporate topics such as business plans, 

financial reports, employee orientation, and so on  
• Projects: Lists presentations that might be used in a planning process  
• Sales/Marketing: Lists presentations suited for a marketing program  

6. Click a presentation from within a category and click Next to move to the next pane   
7. Select an output option from one of the following:  

• On-Screen Presentation: Click this radio button to create a presentation that 
is intended to be shown on your computer or on a projector connected to your 
computer  

• Web Presentation: Click this radio button for a slide presentation that you 
want to show on a Web site  

• Black and White Overheads: Click this radio button if you want to print 
your slides on clear acetate on a black-and-white laser printer  

• Color Overheads: Click this radio button if you want to print your slides on 
clear acetate on a color printer  

• 35mm Slides: Click this radio button if you want to print your slides on a 
commercial film recorder that outputs to 35mm slides  

8. Click Next to advance to the next pane   
9. Type a title for your presentation in the Presentation Title text box  
10. Type a footer in the Footer text box if you want a footer to appear on your slides  
11. Click Next in the wizard to advance to the last pane in the wizard  
12. Click Finish to complete the slide creation and open it in PowerPoint   
13. Edit the presentation to customize it for your own needs. 
 
8.2.3 Frame movements of the above 
Using the Slide Sorter  

 The Slide Sorter shows a thumbnail of each slide in the presentation. From this 
view, it is easy to rearrange the presentation, make duplicate slides, delete slides, and place 
transitions into the presentation. To place your presentation in Slide Sorter View, click 
the Slide Sorter Tool. The current slide is denoted by a thicker border.  
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To select a different slide, click the slide you wish to become current.  
 
To duplicate or delete the current slide, choose EDIT: Duplicate (or Delete) Slide.  
PowerPoint provides visual indicators beneath each slide showing any slide transition, text 
animation, or advance timing that you have applied to that slide.  
 

 
Using Transitions:  
Transitions determine the effects applied when you move from one slide to another during 
an on-screen presentation. You must be in Slide Sorter View to access the Transition 
Toolbar.  
 
To choose only a transition effect, click the dropdown box beside the words "No 
Transition" and select a transition. To have other transition choices available to you, click 
the Slide Transition Tool.  

 

 
 

When you click the Slide Transition Tool, the Slide Transition dialog box allows you to 
choose not only a transition effect from a drop-down box, but also offers other choices that 
affect your on-screen presentation.  

 

 
 

TIP: Don't use a different transition on each slide because your audience's attention should 
remain focused on you and the content, not the effects. If you want to use multiple 
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transitions, a good rule of thumb is to apply a unique transition to each slide in a specific 
module of the presentation.  
 
Generally, you should leave the Effect Speed set to Fast. This brings in the next content 
slide quickly and keeps your audience's attention focused on the presentation content.  
PowerPoint contains a few built-in sounds. To play a sound as the slide is transitioning, 
make a sound selection from the Sound drop-down box. Unless you have a well thought 
out reason for doing so, don't choose to have the sound loop until the next sound; it can 
become annoying very fast while you're giving a presentation, as well as making it difficult 
for you to speak over. Also, many presentation locations don't have adequate speakers 
attached to the computer to allow all of your audience to hear the sound.  
 
Advance determines when the current slide proceeds to the next.  
On mouse click advances the presentation to the next slide, or displays the next bullet 
point, only when you click the mouse. (You can also use the keyboard arrow keys or the 
spacebar.) 
Automatically after xx seconds, makes the transition xx seconds after the preceding 
transition ended. 
 
NOTE: Make sure that if you select automatically, that you remove the check in on mouse 
click. 
For self-running presentations that function similar to a kiosk presentation where your 
audience may stop, watch, then leave, generally you will want to set the advance to 3-5 
seconds. 
For a self-running presentation where you are speaking in synchronization with the 
presentation, generally you will want to set the advance to 3-5 minutes.  
 
Rehearse Timings 
The Rehearse Timing Tool allows you to practice giving an on-screen presentation, 
regardless of any slide advance timings you may have set previously. The tool times not 
only the entire presentation, but also each individual slide, as you rehearse. Each time you 
advance the slide, the time is recorded. You must be in Slide Sorter View to access the 
Rehearse Timing Tool.  

 
 

To use the Rehearse Timing Tool, click the Rehearse Timing Tool. When you have 
completed rehearsing, PowerPoint displays the total time for the rehearsed presentation and 
ask if you want to record the new timings. If you click "Yes," these new timings will 
replace any slide advance timings you may have previously set for the presentation.  
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Bullet Effects: 
The Text Preset Animation Tool controls how bulleted points appear on the slide during an 
on-screen presentation. You must be in Slide Sorter View to access the Text Preset 
Animation Tool.  
 
To animate bulleted points, the slide containing bulleted points must be the current slide. 
Then click the drop-down box and choose the animation effect you desire.  
 

 
 

Hidden Slides 
You can hide slides within a presentation. Hidden slides remain available as part of the 
saved presentation and are accessible to you during development or in future presentations 
but do not appear as one of the consecutive presentation slides during a show. 

 You must be in Slide Sorter View to access the Hidden Slide Tool. To hide a slide, 
make sure it is the current slide, and then click the Hide Slide Tool.  

 Hidden slides display in Slide Sorter View with a slash through the slide number. 
Slide View does not differentiate between hidden and non-hidden slides, and all are 
displayed. During presentation, however, hidden slides are passed over unless specifically 
chosen by you through the Slide Show Navigator.  
 
--------------------------------------------------------------------------------------------------------------
8.3 REVIEW QUESTIONS 
-------------------------------------------------------------------------------------------------------------- 

1. How to create 5 slides using different design templates? 
2. How to make an effective presentation? 
3. Explain the steps of AutoContent Wizard to create presentations. 
4. What are the basic component of a slide? 
5. Explain the steps to create a title slide. 
6. How to create a slide show with time delay and user input? 
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-------------------------------------------------------------------------------------------------------------- 
 OFFICE AUTOMATION SYSTEMS - PART III 
-------------------------------------------------------------------------------------------------------------- 
Structure 
9.1 Introduction to Ms Outlook  
 9.1.1 How to Set Up Outlook Express 
 9.1.2 New For Outlook 2000 
 9.1.3 Exploring Outlook 2000  
 9.1.4 Exploring Inbox 
 
9.2 Difference between Outlook Express and Microsoft Outlook 
 
9.3 Computer in Office Automation 
 9.3.1 Office Automation Technologies 
 
9.4 Computers in Engineering 
 
9.5 Review Questions 
 
-------------------------------------------------------------------------------------------------------------- 
9.1 INTRODUCTION TO MS OUTLOOK  
-------------------------------------------------------------------------------------------------------------- 
Microsoft Office Outlook or Outlook is a personal information manager from Microsoft. 
The 2007 version is available both as a separate application as well as a part of the 
Microsoft Office suite. 
 
Microsoft Outlook 2000 helps you to organize, find, and view all of this information—all 
in one place. It is easy to use, like the other programs in the Office suite, provides an 
integrated approach to the Web. Outlook 2000 offers e-mail and collaboration features 
when used with Internet-based messaging systems and even more advanced functionality 
when used on an intranet with Microsoft Exchange Server. 
 
Microsoft Outlook 2000 messaging and collaboration client provides the following 
capabilities: 

• Electronic mail 
• Personal calendar and group scheduling 
• Contact information and task list 
• Custom collaboration and information-sharing programs 

 
9.1.1 How to Set Up Outlook Express 
Before you can use Outlook Express to send and receive e-mail, you need to set up an 
account. You can have more than one account—for business, online shopping, and so on—
and each person who uses your computer may have their own, completely separate account. 
Outlook Express gracefully handles it all. 
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Start Outlook Express 
There are many ways to start Outlook Express, but here's a sure-fire way to find and start it. 
1. Click the Start button.  
2. Point to All Programs.  
3. Click Outlook Express. 
These first three steps are shown in the image below:  
 

 
 

Fig 9.1 Opening Outlook Express from the Start menu 
 
4. If asked whether you'd like to open this particular account automatically every time you 
start Outlook Express, click Yes (if you do) or No (if you don't). If you don't want to be 
asked this question again, click to check the Always perform this check... box.  
5. Check When Outlook Express starts, go directly to my Inbox. 
Outlook Express directs all incoming mail to the Inbox, so it makes sense to bypass this 
opening page. 
 
If you don't see the list of folders and contacts on the left, click Layout on the View menu. 
Click Contacts and Folder List to check them, and then click OK.  
 

 
 
 

Fig 9.2 Outlook Express list of folders 
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Quick start. You'll notice that when you use Outlook Express regularly, Windows XP will 
put the Outlook Express icon on the Start menu (along with other programs you've used 
recently). In that case, just click the Outlook Express icon in the Start menu to open the 
program. 
 
Set Up an Outlook Express E-Mail Account ; The Internet Connection Wizard makes 
short work of setting up your online mailbox by walking you through each step for every e-
mail account you set up. 
 
1. Before you get going, make sure you know your email address along with the following 

information. (You may need to contact your ISP, Internet Service Provider, to get it.) 
 
First, information about the e-mail servers:  

 The type of e-mail server you use: POP3 (most e-mail accounts), HTTP (such as 
Hotmail), or IMAP  

 The name of the incoming e-mail server  
 For POP3 and IMAP servers, the name of the outgoing e-mail server (generally 

SMTP)  
Second, information about your account:  

 Your account name and password (For some solid advice about making a secure 
password, read the Create strong passwords article.)  

 Find out if your ISP requires you to use Secure Password Authentication (SPA) to 
access your e-mail account—yes or no is all that's required.  

2. Start Outlook Express, and on the Tools menu, click Accounts. 
3. If the Internet Connection Wizard starts up automatically, skip ahead to step 4. Click 

Add, and then click Mail to open the Internet Connection Wizard 
 

 
 

Fig 9.3 Mail option from the Add button 
 

4. On the Your Name page of the wizard, type your name as you want it to appear to 
everyone who gets e-mail from you, and then click Next. 

5. Most people use their full name, but you can use any name—even a nickname—that 
people will recognize. 

6. On the Internet Explorer Address page, type your e-mail address, and then click 
Next. 
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Fig 9.4 Internet Connection Wizard's E-mail Server Names 
 
Note: If you chose HTTP as your incoming e-mail server—as for a Hotmail or MSN 
account—this wizard page changes slightly so you can identify your HTTP mail service 
provider. 
7. On the Internet Mail Logon page, type your account name and password.  
 

 
 

Fig 9.5 Internet Connection Wizard's Internet Mail Logon 
 

Note: If you're concerned about break-ins to your e-mail, click to clear the check in the 
Remember Password box. You'll then be prompted for the password each time you send 
or retrieve mail. 
8. Click Next, and then click Finish. 
You're ready to send your first e-mail!  
Unsure if your new e-mail account is working? Send an e-mail message to a friend. If 
they get the message, your account is ready to roll! But if you run into problems setting up 

http://www.studynama.com/?utm_source=pdf&utm_medium=downloaded_file&utm_campaign=studynama_referral


 251

your account, Outlook Express offers help. Search for troubleshooting topics from 
Contents and Index on the Help menu. 
 
Set Up a Web-based E-Mail Account 
The e-mail that you get in a Hotmail account and other Web-based accounts is not stored 
on your hard disk, but is kept on the account-provider's computer. That's what makes it 
possible to access your account from any computer in the world over the Internet. Here's 
how you set yourself up. 
1. Go to the Web site and follow the setup instructions—for example, 
http://www.hotmail.com/ for Hotmail.  
2. Set up Outlook Express to use the account, by following the instructions above in Set up 
an Outlook Express e-mail account.  
 
If you share your computer with someone else, take advantage of Fast User Switching. A 
feature of Windows XP, it lives up to its name by enabling you to switch among users on a 
single computer without closing any programs you are running or logging off. 
 

 To turn Fast User Switching on, open User Accounts in Control Panel. Click 
Change the way users log on or off. Make sure the Use Fast User Switching box 
is checked.   

 Then, to switch users, click Start, click Log off and then click Switch User. On the 
Welcome screen, click the user account you want to switch to. That's it!  

 
Close Outlook Express 
In closing, Outlook Express works just as all other Windows programs do.  
 

 On the File menu, click Exit.  
Tip: For a fast way out, press ALT+F4. 
 

Name Version 
Number Release Date Notes 

Outlook for 
MS-DOS - - Bundled with Exchange Server 5.5 

Outlook for 
Windows 3.x - - Bundled with Exchange Server 5.5 

Outlook for 
Macintosh - - Bundled with Exchange Server 5.5 
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Outlook 97 8.0 January 16, 
1997 

Included in Office 97 and also bundled with 
Exchange Server 5.5. 

Outlook 98 8.5 June 21, 1998
Freely distributed with books and magazines 
for coping with newest Internet standard such 
as HTML mail 

Outlook 2000 9.0 June 7, 1999 Included in Office 2000 and also bundled 
with Exchange 2000 Server. 

Outlook 2002 10 May 31, 2001 Included in Office XP. 

Office Outlook 
2003 11 October 21, 

2003 
Included in Office 2003 and also bundled 
with Exchange Server 2003. 

Office Outlook 
2007 12 November 

30, 2006 
Included in Office 2007, except Office Home 
and Student edition. 

 
Table 9.1 Versions of Microsoft Outlook 

 
9.1.2 New for Outlook 2000 
Whether you are a new user to a messaging and collaboration client or are already familiar 
with it, you will want to discover the new features that are present in Outlook 2000: 
 
Preview Pane: A preview window that appears in the Inbox, allowing you to view e-mail 
messages quickly without opening the message. The Preview Pane is now available for 
viewing items in all Outlook 2000 folders. 
 
Automatic spell check in multiple languages: Microsoft Word 2000 can serve as an e-
mail editor, offering Language AutoDetect spell check and proofing support. 
 
Run Rules Now: You can manually apply any of these rules to any Outlook 2000 folder at 
any point of time. 
 
Direct booking of resources: Reserve conference rooms without dedicated-resource 
computers running. 
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Enhanced Mail Merge: You can filter the Contacts list in Outlook 2000 as desired and 
then pass the contacts to the Microsoft Word Mail Merge and merge on any Outlook fields. 
 
Outlook Bar shortcuts: You can easily create a shortcut on the Outlook Bar to any file, 
folder, or Web page. 
 
Find Exchange Server Public Folder: Outlook 2000 can search on Microsoft Exchange 
Server Public Folder properties to locate items in public folders. 
 
Web integration: You can view a contact's personal Web page, post your calendar to a 
public folder for viewing on the Web, and share information within Outlook 2000. 
 
Folder home pages: You can associate one or more Web pages with any personal or 
Exchange Server folder. 
 
View the Web: Clicking any Outlook Bar shortcut to a Web page, displays the Web page 
in the right Outlook pane. Basic Web navigation is supported and the currently displayed 
page can be opened in your default Web browser. 
 
Internet group scheduling and iCalendar support: Group scheduling is possible over 
the Internet. You can publish and download free/busy information for scheduling meetings, 
as well as send and receive meeting requests and responses over the Internet. 
 
Online meetings: You can easily schedule real-time meetings and automatically start the 
Microsoft NetMeeting conferencing software.  
 
Microsoft NetShow™ Integration: You can easily schedule your time to watch 
broadcasts via Microsoft NetShow services and automatically start Microsoft NetShow at 
the designated time. 
 
Save as Web page: You can save Outlook 2000 items as HTML, making it easy to save 
your course calendar, schedules, and even your contacts to a Web page. 
 
HTML Mail: Outlook 2000 fully supports sending and receiving of e-mails in HTML. 
Mails can be anything from simple formatted text to a complete Web page. Outlook 2000 
also includes HTML stationery with different fonts and backgrounds. 
 
9.1.3 Exploring Outlook 2000  
 
In Outlook 2000 you will find folders from which you can create tasks and contacts, 
schedule meetings and appointments, and send and receive messages. You can also switch 
easily between these folders, from the Outlook Bar or the Folders list or can create any new 
Outlook item from within any Outlook folder. On using the Office toolbar, you can even 
create Outlook items from other Office 2000 programs. 
 
 

http://www.studynama.com/?utm_source=pdf&utm_medium=downloaded_file&utm_campaign=studynama_referral


 254

Toolbars: You will find that the Standard and Web toolbar features in Outlook 2000 are 
similar to those in other Office programs. For each Outlook folder, you can also display 
“Advanced toolbar” that gives you ready access to more features specific to Outlook 2000. 
To display toolbars, click View, point to Toolbars, and select those you want to make 
visible.  
 
Outlook Today: The Outlook Today window provides a preview of your day. By using 
Outlook Today, you can see a summary of your appointments, a list of your tasks, and how 
many new e-mail messages you have. You can set this page to be the first page that opens 
when you start Outlook 2000, and you can customize Outlook Today to provide the 
information that you need. 
  

Fig 9.6 MS Outlook 
 

 

Standard Toolbar 
Advanced Toolbar 
 
 
 
 
 
 
Folder list 
 
The number in 
parentheses 
indicates how 
many unread  
e-mail messages 
you have. 
 

Click Send/Receive to send and 
receive e-mail messages if you 
have a dial-up connection. 

 
 
 
 
Web Toolbar 

  
Click this button to 
customize the 
Outlook Today 
settings. 

 

  Displays the scheduled 
tasks for today, whether 
the task has been 
completed, and the 
priority level for each 
task. 

 Indicates how many 
unread e-mail 
messages are in the 
Inbox folder. 
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9.1.4 Exploring Inbox 
Electronic mail, or e-mail, is quickly becoming one of the most widely used forms of 
communication in the world. It is fast, convenient, and doesn't require a stamp. Using e-
mail, you can send a simple text message, like a reminder about an assignment or you can 
send a message that includes other files, such as a grade report spreadsheet or graphic file. 
With a microphone, you can even send voice messages. 
 
Using e-mail can be beneficial for students and enhance instruction in many ways, from 
making it easier to ask questions to providing a forum for out-of-class discussions and 
collaboration. It can provide meaningful contact outside the classroom with instructors and 
peers. E-mail is easy to use and is becoming more and more accessible to students through 
their home computers or an information appliance like Microsoft Web TV. A few minutes 
of instruction can get most students (and instructors) up and running with e-mail. 
 
  
 
  
 
  
  
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Inbox symbols: 

 
High importance 
message 
 

 
Low importance 
message 
 

 
Read message 
 

 
Unread message 
 

 
Forwarded message 
 

 
Replied to message 
 

 
Saved or unsent 
message 
 

 
Sealed message 
 

 
Digitally signed 
message 

More Inbox symbols: 

 
Accepted meeting request 
 

 
Tentatively accepted meeting 
request 
 

 
Declined meeting request 
 

 
Canceled meeting 
 

 
Task request 
 

 
Accepted task 
 

 
Declined task 
 

 
Message is flagged for follow 
up 
 

 
Message is flagged as 
complete 
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The following illustration shows the Inbox window in Outlook 2000. In this window you 
can receive, compose, send, and organize e-mail messages. 

 
 
Creating and sending e-mail messages 
There are two ways to send e-mail messages using Outlook 2000: You can either open 
Outlook 2000 and begin a new message there or you can open any Office 2000 program, 
create a document, and send it directly to e-mail from that Office program. 
 
To create and send an e-mail message from Outlook 2000 

• Start Outlook 2000. 
• On the Actions menu, click New Mail Message. Or, on the Standard toolbar, click 

New Mail Message . To send a message on stationery, on the Actions menu, 
point to New Mail Message Using, click More Stationery, and then select a 
background. The New Message window opens. 

 

Preview pane— 
Displays a preview of the 
highlighted message in 
your inbox. 
 

Forwarded— 
This arrow indicates that this 
message has been forwarded.  

 
Bold— 
Messages displayed in bold 
have not been read. 

  
 
 
Web toolbar 

 

Standard 
toolbar 
 
Advanced 
toolbar 
 
 
Folder list— 
Use this list to 
organize your 
messages in  
personal folders. 
 
 
 
 
 
 
 
 
 
 
 
 
Status bar— 
Displays the 
number of 
messages in 
your Inbox and 
the number of 
messages 
unread. 
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• In the To field, type the e-mail address of the person to whom you are sending the 
message. If you are sending to more than one person, type a semicolon (;) between 
the e-mail addresses. 

 
Or – 

 
• Click “To” to open your address books. Select an address book and double-click a 

name. The address moves to the To Message Recipients field. 
• Repeat the above step to add more e-mail addresses to the “To” field. 
• To send a carbon copy (CC) to someone, click the CC field. Type the e-mail 

address in the field, or click CC, choose an address from one of your address books, 
and click OK. Repeat to CC other people. 

• To send a blind carbon copy (BCC) to someone (to CC someone without the other 
message recipients knowing the person received the message), on the View menu 
select Bcc Field. Type the e-mail address in the field, or click BCC, choose an 
address from one of your address books, and click OK. Repeat to Blind CC other 
people. 

• To add a subject line to the message, click in the Subject field and then type a brief 
line regarding the subject of the message. 

• Click in the blank field below the Subject field (the message field) and type your 
message. 

• When you are satisfied with your message, click Send. The message automatically 
moves to your Outbox folder and you return to the main Inbox window. 

• If you are always connected to the network and Internet connection, your message 
is automatically sent.  

Or - 
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• If you are not already connected to the Internet, click  Send/ Receive to connect to 
the Internet and send the message. 

• When the message has been sent, it moves to the Sent Items folder. If the message 
cannot be delivered to someone, you usually, but not always, receive an automatic 
reply letting you know who could not be reached and why. 

 
To attach a file to a message from Outlook 2000 
In Outlook 2000, address and compose a text message as described in the “To create and 
send an e-mail message” section of this chapter.  
 

• To attach a file to the message, position the cursor in the message field where you 
want to insert the file. This can be at the beginning, at the end, or anywhere in 
between. 

• On the Insert menu, click File. Or, click the Insert File button on the Standard 
toolbar. The Insert File dialog box opens. 

• Locate the file you want to attach. Click the file and then click OK. An icon 
representing the file labeled with the file name appears in the message field. 
 

-Or- 
• Click on a file and drag it to the message field. 

 
To create and send an e-mail message from another Office 2000 program 
All Office 2000 programs integrate e-mail into their core functionality. You can send any 
document as a message or an attached file from directly within an Office 2000 program.  
 

• Open the Office 2000 program of your choice. 
• Open an existing document or create a new one and save the document. 
• On the File menu, point to Send to. A submenu appears. 
• On the submenu, you have two choices for sending the document. Select one: 

 To send a copy of this document as the text of the e-mail message, click 
Mail Recipient. The document becomes the body text of a new e-mail 
message. 

 To send a copy of the document as an attachment to the e-mail message, 
click Mail Recipient (as Attachment). The document becomes an attachment 
to a new e-mail message. 

• If you select Mail Recipient, click Send Copy to send the message. 
-Or- 

• If you select Mail Recipient (as Attachment), click Send to send the message. 
 
Receiving and replying to e-mail messages 
 

• When Outlook 2000 receives messages, it stores them in the Inbox folder. The 
number next to the word “Inbox” in the Folder list tells you how many messages are 
waiting for you. If there is no number, you have no new messages. 

• When you click the Inbox folder in the Folder list, the contents of the folder are 
displayed on the upper, right portion of the window, which is called the Message 
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List pane. The Message header shows the subject and author of the messages in the 
Inbox. If a message header is bold, that message has not yet been read. If the 
message header is not bold, the message has been opened. 

 
To receive and read messages 

• Open Outlook 2000. 
• If you are always connected to the network and the Internet, any messages sent to 

you are automatically received to the Inbox folder. If you have new messages, an 
envelope icon appears in the taskbar. 

 
Or – 

 
• Click Send and Receive. Your computer connects to the Internet and tries to 

retrieve your messages to the Inbox folder. (It also sends any messages in the 
Outbox folder.) 

• In the Folder list, click the Inbox folder. (If it has a number next to it, you have new 
or unread messages.) New and unread messages appear in bold in the Message List 
pane. 

• To read a new message, click it in the Message List pane. The contents of the 
message are displayed in the Message Contents pane. 

 
-Or – 

 
• Double-click the message in the Message List pane to open the message in its own 

window. 
• To open an attachment, double-click its file icon. The attachment opens in the 

appropriate program. 
• When you are finished, you can close the message and it remains in the Inbox 

folder.  
 
Using the Organize button 
 
Outlook 2000 can automatically organize certain messages for you. Outlook 2000 can save 
you time sorting through unwanted “junk” messages, highlight messages from certain 
people, and even move specified messages into certain folders upon delivery.  
 
To organize messages using the Organize button  

 Open the Inbox folder. (For some options you will need to have messages in the 
Inbox.)  

 Click Organize on the Standard toolbar, or, on the Tools menu, click Organize. The 
Ways to Organize Inbox dialog box opens at the top of the message pane. 

 Four options are available on the left side of the dialog box: Using Folders, Using 
Colors, Using Views, and Junk E-mail. You can do any of the following: 

 Click Using Folders to create new folders, open the Rules Wizard, and move 
messages to other folders. You can easily create a rule to move messages 
from a certain sender into another folder upon delivery. 
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  Click Using Colors to color code messages by sender.  
 Click Using Views to select how you see messages in your Inbox. 
 Click Junk E-mail to color code junk and adult content messages, or have 

them sent directly to Deleted Items or another folder. You can also add 
senders to the junk or adult content filters. 

 When you are finished, click Organize to close the dialog box.  
 
You can also organize messages that have already been moved to other folders by opening 
that folder and then clicking Organize. 
 
Using the Rules Wizard 

• A rule is a set of conditions and actions for processing and organizing your e-mail 
messages. Conditions identify messages for processing, and actions determine what 
kind of processing is performed. For example, you can define a rule that tells 
Outlook 2000 to forward all messages sent to you from students in Biology 101 
section 3 to your lab assistants, or create a rule that tells Outlook 2000 to put all 
message with “Homework” in the subject field into a certain folder in your Personal 
Folders list. 

• If you receive a large volume of mail from several different groups (personal mail, 
mail from students, mail from colleagues, even junk mail) you can use the Outlook 
Rules Wizard to create your own rules to manage your messages automatically. 
Here are some examples of rules you can create: 

 
 Assign categories to messages based on their contents. 
 Set up a notification, such as a message or a sound, when important 

messages arrive. 
 Move messages to a particular folder based on who sent them. 
 Delete messages in a conversation. 
 Flag messages from a particular person. 
 Assign categories to your sent messages based on their contents. 
 Delay delivery of messages by a specified amount of time. 
 Redirect an e-mail message to a person or distribution list. 
 Automatically reply to a certain type of message with a specific message 

you create. 
 
To create a rule 

• Open Outlook 2000 and click the Inbox folder to display its contents.  
• On the Tools menu, click Rules Wizard. The Rules Wizard dialog box opens. 
• Click New. The Rules Wizard displays a list of the different types of rules you 

can create along with a description of the rule in the Rule description box.  
• Select the type of rule you want to create and click Next. 
•  Select the conditions for the rule as directed by the Rules Wizard and then click 

Next. 
• Specify the action for the rule as directed by the Rules Wizard and then click 

Next. 
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• Specify any exceptions to the rule as directed by the Rules Wizard and then click 
Next. 

• Specify a name for the rule and then select the Turn on this rule check box to 
activate it.  

• Click Finish. The rule is added to the Rules Wizard list. 
 

There are three ways to control how rules are applied in the Rules Wizard:  
• When you create a rule, you specify whether the rule is applied when the message 

arrives in the Inbox or when you send a message. You set these options for each 
rule. 

• After you create multiple rules, you can move the rules up or down in the list in the 
Rules Wizard to change the order in which they are applied. Rules are applied in the 
order they appear in the list. Rules that are marked “client only” are applied after all 
other rules. 

•  You can specify whether the rule runs automatically or manually. This is useful 
when you want to apply rules manually to messages already delivered to the Inbox.  

 
Creating an address book 

• Use the Address Book dialog box to look up e-mail and fax information when you 
address messages. Use the Contacts folder to store and retrieve all types of 
information about others such as street addresses, telephone numbers, e-mail 
addresses, fax phone numbers, and Web page addresses. To open the Address Book 
dialog box, click Address Book on the Standard toolbar, or click Address Book 
on the Tools menu. 

• There can be several types of address books in the Address Book dialog box 
including the Global Address List, the Personal Address Book, and the Outlook 
Address Book. Select these address books in the Show names from box. Contacts in 
the Contacts folder that include an entry in the e-mail field or one of the fax phone 
number fields automatically appear in the Outlook Address Book.  

 
To add information to the address book 
 

 Click Address Book  on the Standard toolbar. The Address Book dialog box 
opens. 

 In the Show Names from the drop-down box, select Personal Address Book. 
 Click New Entry  on the dialog box's toolbar. 
 In the Put this entry in the drop-down list, click Personal Address Book. 
 Select the type of entry you want to create (Microsoft Mail Address, Internet 

Address, Other Address, and so forth) and then click OK. 
 Enter the person's name and e-mail address in the appropriate fields.  
 If you want, click the Business, Phone Numbers, or Notes tabs and enter additional 

information. 
 Click OK to save the information.  
 Repeat steps 3 through 7 to add more addresses. 
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Exploring Contacts 
 
Outlook 2000 serves as much more than just an e-mail program: you can use it to maintain 
an electronic address book of your students, colleagues, and anyone else you need to 
contact. Storing contacts electronically in Outlook 2000 allows you to find information 
about someone quickly and easily. In the Contacts folder, you can store a wide range of 
information about people, from their work and home phone numbers and physical 
addresses to e-mail addresses and Web addresses, if they have them. You can link any 
Outlook item or Office document to a contact to help you track activities associated with 
that person or group. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
When you enter a name or address for a contact, Outlook 2000 separates the name or 
address into parts and puts each part in a separate field. You can sort, group, or filter 
contacts by any part of the name or any part of the address you want. 
 
From a contact in your contact list, you can click a button or menu command to have 
Outlook 2000 address a meeting request, e-mail message, or task request to the contact. If 
you have a modem, you can also have Outlook 2000 dial the contact's phone number. You 
can have Outlook 2000 time the call and keep a record in Journal complete with the notes 
you take during the conversation. 
 
 
 
 
 
 

Contacts symbols: 

 Activities have 
been 
automatically 
recorded in 
Journal for this 
contact 
 

 Contact 
 

 Contact has an 
attachment 
 

 Contact is flagged 
for follow up 
 

 Contact is flagged 
as complete 
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You can file contact information under a last name, first name, company name, nickname, 
or any word that helps you find the contact quickly, for example, “Section 004” for 
students in a particular class. Outlook 2000 gives you several naming choices to file the 
contact under or you can enter your own choice. You can enter up to three addresses for 
each contact. Designate one address as the mailing address and use it for mailing labels, 
envelopes, or creating mail-merge letters. 
 
Creating contacts 
A contact is a person or organization you correspond with. You can store  information 
about contacts such as job titles, phone numbers, addresses, e-mail  addresses, Internet e-
mail addresses, and notes. When you create a contact, you can start by entering all new 
information or you can start with information from an existing contact. 

Standard 
Toolbar 
Advanced 
Toolbar 
 
 
 
 
 
 
Outlook Bar 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Status bar— 
Displays the 
total number 
of contacts. 
 
 
 
 

Click the flag icon to mark the selected 
contact so you can follow up with him or 
her. Click the mail icon to send a new  
e-mail message to selected contact. 

Click the telephone icon to have Outlook 
automatically dial the selected contact's 

phone number. 

  
 
 

Change the way Outlook 
displays contacts by 
selecting a new view 

from this list. 

Lett
Click a sy
button to

contacts b
that sym
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To create a new contact 

 
 On the File menu, point to New and then click Contact. The Contact dialog box 

opens. 
 In the Full Name box, type a name for the contact. 
 Enter the information you want to include for the contact. There are several tabs 

on which you can enter information.  
 If you wish, assign the contact to a category. Click Categories and then select a 

category from the list.  
 Click Save and Close.  

 

Exploring Calendar 
Outlook 2000's Calendar offers an easy way to keep track of appointments and schedule 
your time. You can look at appointments and tasks for a given day or look at appointments 
in relation to other appointments in the month. You can also post your calendar to a Web 
page or print it out and make handouts so that students, parents, or others can know when 
you are available. 
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Standard 
Toolbar 
Advanced 
Toolbar 
 
 
 
 
 
 
Folder List 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Status bar— 
Displays the 
total number of 
calendar items. 
 

Click to view calendar 
entries for today or a 
specific day, work week, 
calendar week, or month. 

The current date is marked 
with a red box.  
The date shown in the daily 
planner panel is shaded. 

   
 
 
 
 
Changes how Outlook 
displays your calendar. 

   
Web 
Toolbar 

 
Click the ar
show other

 

Customize how 
Outlook displays the 
hours of the day. 

Color coding shows 
further information about 
the appointment, such as 
if you will be out of the 
office or if the 
appointment is tentative. 

 Displays tasks scheduled for the 
selected date and allows you to 
add a new task to Outlook without
filling out the Task dialog box. 

  To change appointment information 
quickly, click the appropriate appointment 
and type the new information. 
To change appointment information using 
the Appointment dialog box, double-click 
the appointment.  
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To set calendar preferences 
With the Calendar folder open, on the Tools menu, click Options. The Options dialog box 
opens. 
 

• Click the Preferences tab.  
• Under Calendar, select Default reminder to have Outlook 2000 remind you 

automatically of all appointments. Then, in the drop-down box, select the amount of 
time before appointments you want to receive the reminder. (You can change this 
time for individual appointments when you create them.) 

• Click Calendar Options. The Calendar Options dialog box opens. 
 

 

Calendar symbols: 

 
Appointment 
 

 Click to see calendar 
items that do not fit in 
the current view 
 

 
Meeting 
 

 
Meeting request 
 

 
Recurring 
appointment 
 

 
Recurring meeting 
 

 
Recurring meeting or 
appointment 
 

 
Reminder for the 
appointment or 
meeting 
 

 
Private meeting or 
appointment 
 

 

Start and end times 
of the appointment or 
meeting 
 

 
Calendar item has an 
attachment 
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• Select the days of the week you want to show on your calendar. 
• Select other options as necessary. To select a time zone, or show more than one 

time zone at a time, click Time Zone. 
• To have Outlook 2000 automatically display holidays for different countries or 

religions, click Add Holidays. 
• If you are responsible for coordinating resources, such as conference rooms, or 

classrooms, click Resource Scheduling. 
• To publish your free/busy information on a Web or other server, click Free/Busy 

Options. 
• When you are finished, click OK. 
 

-------------------------------------------------------------------------------------------------------------- 
9.2 DIFFERENCE BETWEEN OUTLOOK EXPRESS AND 
MICROSOFT OUTLOOK 
-------------------------------------------------------------------------------------------------------------- 
 

  Outlook Express  Microsoft Outlook 
Definition Outlook Express is the e-mail client that 

is included with Microsoft Internet 
Explorer 4.x, Microsoft Internet Explorer 
5.x, the Microsoft Windows 98 operating 
system, the Microsoft Windows 
Millennium Edition (Me) operating 

Outlook is Microsoft's premier 
messaging and collaboration client. 
It is a stand-alone application that is 
integrated into Microsoft Office 
and Exchange Server. Outlook also 
provides performance and 
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system, the Microsoft Windows 2000 
operating systems, and Microsoft Office 
98 for the Macintosh. Outlook Express is 
designed for home users who gain access 
to their e-mail messages by dialing in to 
an Internet service provider (ISP). 

integration with Internet Explorer 
5.5. Complete integration of e-mail, 
calendaring, and contact 
management, makes Outlook the 
perfect client for many business 
users 

Technology Built on open Internet standards, Outlook 
Express is designed for use with any 
Internet standard system, for example, 
Simple Mail Transfer Protocol (SMTP), 
Post Office Protocol 3 (POP3), and 
Internet Mail Access Protocol (IMAP). It 
provides full support for today's most 
important e-mail, news, and directory 
standards such as Lightweight Directory 
Access Protocol (LDAP), Multipurpose 
Internet Mail Extension Hypertext 
Markup Language (MHTML), Hypertext 
Markup Language (HTML), 
Secure/Multipurpose Internet Mail 
Extensions (S/MIME), and Network 
News Transfer Protocol (NNTP). Full 
support ensures that you can take 
advantage of new technologies as well as 
seamlessly send and receive e-mail 

Outlook is designed for use with 
the Internet (SMTP, POP3, and 
IMAP4), Exchange Server, or any 
other standards-based 
communication system that 
supports Messaging Application 
Programming Interface (MAPI), 
including voice mail. Outlook is 
based on Internet standards and 
supports today's most important e-
mail, news, and directory standards, 
including LDAP, MHTML, NNTP, 
MIME, and S/MIME, vCalendar, 
vCard, iCalendar, and full support 
for HTML mail. Outlook also 
offers the same import tools that are 
offered with Outlook Express. This 
enables easy migration from other 
e-mail clients, and offers further 
migration from Microsoft Mail, 
Microsoft Schedule+ 1.0, Microsoft 
Schedule+ 7.0, Lotus Organizer, 
NetManage ECCO, Starfish 
SideKick, Symantec ACT, as well 
as synchronization with leading 
Personal Digital Assistants (PDAs), 
such as the 3Com Palm Pilot. 

Platforms 
Supported 

Versions of Windows later than 
Microsoft Windows 95, versions of 
Windows earlier than Microsoft 
Windows 95, Macintosh, and UNIX 
platforms 

Versions of Windows later than 
Microsoft Windows 95, versions of 
Windows earlier than Microsoft 
Windows 95, and Macintosh 
platforms 

Calendars, 
group 
scheduling, task, 
and contact 
management 

Not Supported Supported By Outlook and is 
widely used across organizations 
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Integration with 
Other 
Applications 

Outlook Express handles not only 
Internet mail but also Internet news, a 
feature that Outlook does not natively 
possess. But Outlook has a host of 
features that Outlook Express does not 
have, such as a calendar, a task list, a 
journal, and automatic backup into 
archive files. The address book in 
Outlook is a very sophisticated contact 
management system unlike the simple 
address book used by Outlook Express. 
Outlook can be programmed using Visual 
Basic for Applications (VBA) but 
Outlook Express cannot. Outlook is 
highly interoperable and so can be used 
in combination with Word, for example, 
to perform mail-merge in e-mail or to 
automate outgoing mail messages. 
Outlook Express does not interact with 
other programs in this way except for 
creating a new mail message when a 
program requests it. 

Outlook also has a very powerful 
Junk Mail feature which has 
received high praise and is envied 
just as highly by many Outlook 
Express users. In a similar vein, 
Outlook has message rules for both 
incoming and outgoing mail, while 
Outlook Express can only filter 
incoming. Outlook rules also offer 
a much wider range of actions than 
do rules in Outlook Express. 

Network System Outlook Express was designed for use on 
a single computer and so its message 
store and settings cannot be stored on a 
server. 

Outlook however was tailor-made 
for networks, and so its message 
store can be on a central server that 
many machines can access. If you 
need to access your e-mail from 
more than one machine on your 
network 

 
-------------------------------------------------------------------------------------------------------------- 
9.3 COMPUTER IN OFFICE AUTOMATION 
-------------------------------------------------------------------------------------------------------------- 
Office automation is defined as using computer and communications technology to help 
people better use and manage information. Office automation technology includes all types 
of computers, telephones, electronic mail, and office machines that use microprocessors or 
other high-technology components.  
 
People who use office automation are often called knowledge workers-senior executives, 
managers, supervisors, analysts, engineers, and other white-collar office workers. In most 
offices, information (often in paper form) is the end product and is essential for 'conducting 
the company's business. Office automation systems keep track of the information 
originating in various operations throughout the company, such as order processing, 
accounting, inventory, and manufacturing. Office automation provides knowledge workers 
with information-producing systems to collect, analyze, plan, and control information about 
the many facets of the business, using text, voice, graphics and video display technology. 
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People 
Although it takes people to complete work, it is the way people work that accounts for 
productivity. In recent years, the trend has been towards people working together to 
accomplish more. This is called work-group computing, which means a number of 
knowledge workers, each with different tasks, jobs or duties, work together towards a 
common goal. In large companies, there may be dozens or hundreds of workgroups. In 
smaller companies, everyone is part of the workgroup.  
 
Ergonomics 
Business learned that "office could not be automated in the same way the factory was 
automated, and the field of ergonomic began to emerge. Office tasks involve a great deal of 
thinking and decision-making. As a result office systems must be flexible and versatile. 
Moreover, they must be deigned so any knowledge worker, regardless of background can 
easily use them. This is called ergonomics, the study of how to create safety, comfort and 
ease of use for people who use machines. It is not a new field of study; in fact it has existed 
for over 100 years.    
 
With the advent of computers, ergonomics engineers became particularly interested in 
office automation systems, furniture "and. environments for the knowledge worker 
intensive studies determined the best ,designs for Keyboard, set. Eyes fatigue- levels for 
monitors, and specified desks and seating designs that alleviate physical stress. Office 
furniture companies soon introduced ergonomically designed chairs and "equipment. 
Ergonomics has- played a significant role in -helping people use technology more 
effectively 
 
There are five primary technologies used in managing information in office automation: 
 

• Text or written words  
• Data, as in umbers or other non-text forms. 
• Graphics, including drawings, charts and photographs  
• Audio, as in telephone, voice mail, or voice recognition  systems 
• Video, such as captured images, videotapes or teleconferencing.  

 
In the past these forms of information- was created using different technologies. Text was 
created using conventional typewriters' or more" recently, word processing. 
 
9.3.1 Office Automation Technologies 
Data, such as sales reports, was provided by the central computer. Charts and grabs were,-
either l1and-drawn or created using 35mm slide photography and videotapes were user” or 
training. Audio was limited t9 the" phone or tape recording. It was not possible to combine 
these various forms of information. 
 
What made it Possible to combine them was the computer. What computer produces is 
called an electronic document, which is a self-contained work, conveying information that 
has been created by a knowledge worker and stored in a computer system. An electronic 
document may be a simple main that may be printed on paper or transmitted via electronic 
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mail. Or it may be a more complex document, with graphics or even Video. Most computer 
'systems can incorporate sound, so that an onscreen document can be annotated with 
comments spoken by the document creator. 
 
Today, the computer integrates others different media and others' as well Data, sound and 
images can all -be 'entered info' a computer-, stored- and translated into the kind of output 
we need. It is now common to seek knowledge worker’s in workgroups using a special type 
of, software designed' specifically for them and their work. This application software’s 
called groupware, lets networked PCs and workstations share information and electronic 
documents from both corporate and on-line sources. At the center of this integration are 
networking and communications systems... 
 
Office Automation Systems 
Office automation uses computer based systems to provide" information to help knowledge 
workers make decisions that benefit the business. Office automation systems are" 
comprised of many distinct subsystems: text management systems, business analysis 
systems, document management systems" and Network and communications C systems. 
 
Text Management Systems 
A text management system is a completer system -c1esigned to work with the written or 
typewritten word. It includes all kinds of typewriters, word processing systems, PCs with 
word processing, desktop publishing and text editing systems, and even computerized 
typesetting equipment. Text management systems are used for test like writing memos, 
notes, letters and other short documents, - printing envelopes" and labels preparing pre-
printed forms such as invoices, composing complex documents such as proposals and 
reports, retrieving and editing documents such as contracts, Creating display documents 
like newsletters, etc. 
 
Business Analysis Systems  
Managers need solid data from which to extract the information necessary to make good 
decisions for the business. In the past, these knowledge workers had to rely on their 
experience and other personal factors to make decisions. A business analysis system 
provides data that, when used with the proper software, helps its users - better understand 
the business environment and make more effective decisions. Corporate users routinely use 
spreadsheets for analyzing cost and benefits and for creating budgets. 
 
Other software tools for performing analysis that and"-.commonly used in large companies 
are decision support systems (DSS), expert systems and executive support \ systems (ESS). 
A decision support system helps the knowledge worker to extract information from the 
various MIS database and reporting systems, analyze it, and then formulate a decision or a 
strategy for business planning. An expert system is a computer system that can. store and 
retrieve data with special problem solving expertise. An executive support system is an 
information system that consolidates and summarizes ongoing transactions within the 
organization. It provides the management with all the information it requires at all times 
from internal as well as external sources. 
 

http://www.studynama.com/?utm_source=pdf&utm_medium=downloaded_file&utm_campaign=studynama_referral


 272

Document Management Systems 
Document management systems aid in filing, tracking and managing documents, whether 
they are paper, computer based, micrographic, or purely electronic. Office automation 
demands that data be immediately accessible and instantaneously retrievable. For that 
reason, we are slowly moving away from paper and toward. Document forms that can be 
stored on the computer. 
 
Network and Communication Management Systems 
Today, knowledge workers have many ways to communicate with one another, primarily 
by voice, fax, and e-mail. They can communicate in real-time, via phone or computer. They 
can also communicate using computer controlled PBX telephone systems to record a digital 
message and leave it in the recipient's electronic mailbox. These systems are called network 
and communication management systems. The network and communication management 
systems include telephone, electronic mail, voice messaging systems, and teleconferencing 
and fax machines. 
 
-------------------------------------------------------------------------------------------------------------- 
9.4 COMPUTERS IN ENGINEERING 
-------------------------------------------------------------------------------------------------------------- 
Introduction   
In the global economy, it is absolutely necessary for an organization to keep costs as low as 
possible in order to remain competitive. Since design, production, and manufacturing 
consumes so -much of a manufacturing company's budget, great savings are being made by 
automating these procedures as much as possible. 
 
Electronic Data Interchange (EDI) 
EDI is the computer-to-computer exchange of business documents in a standard format. 
These formats look much like standard forms and are highly structured. One widely used 
format is for purchase orders and consists of an outer digital 'envelope' with the addresses 
of both the sender and receiver. Inside the digital envelope a series of structured codes 
define the part number, cost, tax information, shipment methods, bill-to location, ship-to 
location, and contacts to call. This EDI purchase order can be automatically generated by 
the buyer when inventory fall below a certain point and send via networks to the supplier. 
At that end it is automatically processed and creates a list of the products to be shipped 
even before the normal workday begins. 
 
Computer Aided Design/Computer Aided Manufacturing (CAD/CAM) 
An increasingly, popular tool for product design is Computer-aided-Design (CAD). CAD 
systems are computer programs or integrated packages for workstation hardware and 
software that allow the user to draw and easily modify product designs on a computer 
screen. Advanced CAD systems provide designers with at least 3 major benefits. 
 
Graphics capabilities - CAD systems allow the designer to view a product from different 
perspectives, including three-dimensional rotations, and various cross-sections. The 
designer can also make proportional changes in scale, or change the angle of an arc with 
the click of a computer mouse rather than having to redraw the entire product.  
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Design, storage and retrieval - Some CAD systems can store the design characteristics of 
existing products and components. Then, for example, if a company needs a gear for a new 
product, the designer can enter the relevant information about the gear, such as its diameter, 
tooth pattern, and required hardness, into the CAD system. The CAD system determines 
whether the company is already using an identical of sufficiently similar gear, in which 
case a new one is unnecessary. If not, a gear that has similar properties may exist. The 
designer can then use the design of this similar gear as a starting point for the new gear: 
This capability not only promotes the use of common components but also reduces design 
time.  
 
Automatic evaluation of specifications - One of the most time-consuming aspects of 
design for highly technical products is calculating whether or not product specifications, 
such as strength, heat resistance or aerodynamic drag, are satisfied. These calculations can 
be programmed into some CAD systems so that whenever the designer changes the design 
(by altering the shape or material to be used), these performance characteristics are 
recalculated automatically and compared to the product requirements. This is sometimes 
called Computerized. -Engineering (CAE). 
 
The overall benefits of CAD systems can be substantial. The features described above 
reduce development time and cost, and they improve product quality because more design 
options can be evaluated in greater detail more quickly. For example, Motorola used three-
dimensional CAD to produce its award-winning MicroTac pocket sized cellular phone two 
years ahead of the competition. It is not uncommon for CAD systems to reduce product 
cycle times by 10-50 %. 
 
Even greater time and cost reductions have resulted from recent advances whereby CAD-
engineered designs are converted automatically into software programs for computerized 
production machines. These are called Computer-aided Design/Computer-assisted-
Manufacturing (CAD/CAM) systems. This automatic conversion eliminates the costly and 
time consuming steps of having a person convert design drawings into a computer program 
for computer-controlled production equipment; such as robots or machine tools. CAD and 
CAD / CAM systems are not used by large automotive or electronics companies alone. 
Future Enterprises, the largest maker of wedding jewelry in the United States, reported that 
its CAD / CAM system reduced the time required to design and make jewelry from five 
months to one week.  
 
Product Data Management (PDM) 
One of the major manufacturing challenges is to maximize the time-to-market benefits of 
concurrent engineering while maintaining control -of your data and distributing it 
automatically to the people who need it, when they need it. The way PDM systems cope 
with this challenge is that master data is held only once in a secure 'vault' where its 
integrity can be assured and all changes to it monitored, controlled and recorded. 
 
Duplicate reference copies of the master data, on the other hand, can be distributed freely, 
to users in various departments for design, analysis and approval. The new data is then 
released back into the vault. When a 'change' is made to data, what actually happens is that 
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a modified copy of the data, signed and dated, is stored in the vault alongside the old data, 
which remains in its original form .as permanent record. 
 
The following are some of the benefits of the PDM system: 
 

• Reduced time-to-market 
• Improved design productivity 
• Better use of creative team skills 
• Data integrity safeguarded 
• Better management of engineering change 

 
Feature Prototyping 
One of the problems with product design is getting an intimate feel for the appearance and 
behavior potential of a product. Now there are software packages, which can generate 
computer prototypes, which' can be distributed and tested by actual customers. Usage data 
from these tests is collected automatically and used to refine product specifications until 
they precisely meets customers' needs. This process helps in ensuring the market success of 
the new product before costly and time-consuming investments in engineering and 
manufacturing are made. 
 
Better than communicating with customers using written specifications, static drawings, 
flip charts, or multimedia authoring tools, feature prototyping 'using fully functional 
prototypes provide accurate and valuable feedback to the company based on customers' 
experience that can make the difference -between a resounding market winner -and an 
embarrassing product failure. 
 
Project Management 
When projects from marketing campaigns to construction projects are undertaken, keeping 
track of all the tasks is a big job and that. is what project management programs have been 
developed to do. One concept they use is the critical path; the series of tasks that must 
follow one another in order and cannot be overlapped or begun until the previous one is 
completed. For example, a roof cannot be put on a house until the walls are up, and the 
walls cannot be built until the foundation is completed. When these dependent tasks are 
laid out end-to-end, they form the project's critical path. Any delays in the tasks on this 
path delay the entire project. Tasks not on the critical path like paving the driveway do not 
affect the project's completion date. Speeding up the project, called trashing the schedule 
can be done only by changing the dates on the critical path, but changing some dates on the 
critical path may result in another path becoming critical. Since this process is so 
interactive, it lets itself to computerization. Graphics are often used to show the 
complicated relationships in the timing and sequence of a project. 
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-------------------------------------------------------------------------------------------------------------- 
9.5 REVIEW QUESTIONS 
-------------------------------------------------------------------------------------------------------------- 

1. Explain salient features of MS-Outlook. 
2. Compare Outlook Express and Ms Outlook. 
3. Explain the Calendar views available in MS outlook. 
4. What is the utilities available in MS outlook for E-mails? Comment on it. 
5. What is the role of computers in Engineering? 
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